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Welcome to Costpoint 8.0 
Welcome to Costpoint 8! This document details all of the enhancements contained in this release, 
organized by domain. 

Helpful Resources 
As you work in Costpoint, the following items may prove helpful: 

Name Description Link 

Getting Help for Costpoint 
Video 

Video explaining the best resources for 
getting help with Costpoint 

Getting Help Video 

Costpoint Information 
Center 

Stand-alone hub containing all Costpoint 
documentation for on-premises users 

CIC 

Costpoint Cloud Information 
Center  

Stand-alone hub containing all Costpoint 
documentation for cloud users 

CIC Cloud 

Learning Aids Online Help 
Topic 

Online help topic with links to all Costpoint 
videos, quick steps, and clickguides 

Learning Aids 

CP 8 Learning Portal Deltek University free training site Training Portal 

Online Help Stand-alone online help system available 
outside of Costpoint. See more information in 
the next section. 

Help 

Transition to a New Format 
As part of Deltek’s continuing effort to improve the usability of the Costpoint online help, it is being 
rewritten using the latest DITA-based documentation tools. 

Because of the massive amount of work to rewrite the entire online help system, portions of the rewritten 
help will be released as they are completed. All existing help information is still available during this 
transition phase to DITA, but the look of some help topics may vary. 

Display Issues 
If you use Internet Explorer and the online help does not display correctly, you need to turn off the 
Compatibility View for the browser. Click Tools » Compatibility View settings, and clear the Display 
intranet sites in Compatibility View check box. And then, refresh the browser. Make sure you remove 
deltek.com (if listed) from the websites you have added to the Compatibility View list. 
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Accounting 
This section describes Costpoint 8.0 enhancements for the Accounting domain. 

Add GSA’s Unique Entity Identifier (UEI) to Vendor Master 
The Dun & Bradstreet (D&B) Data Universal Numbering System (DUNS) that is formerly used as a unique 
identifier for vendors doing business with the government has been replaced by the General Services 
Administration’s new Unique Entity Identifier (UEI) generated in the System for Award Management. 

The following applications have been updated to have a UEI Number field. The DUNS Number field is 
retained on these screens for historical purposes and commercial needs only. 

 Manage Vendors (APMVEND) 

 Manage Contract Management Vendor Info (CTMVEND) 

 Manage Subcontracts (CTMSBCNTR) 

The UEI Number column has been added to the Vendor Input File that is used when importing vendors 
using the Import Vendors (AOPUTLVU) screen. 

Enhancement to AP 1099 SSN Suppression 
Multiple screens have been updated to enable the suppression of a vendor’s Tax ID when a user opens 
certain screens or prints reports where the Tax ID usually displays. 

This update affects the following screens: 

 Manage Users (SYMUSR) 

 Import Vendors (AOPUTLVU) 

 Edit 1099 Information (APM1099) 

 Manage Vendors (APMVEND) 

 Print 1099 Edit Report (APR1099E) 

The Suppress AP Tax ID field has been added to Manage Users (SYMUSR) screen in the Admin 
domain. 

You can control SSN and Tax ID suppression by selecting or clearing the Suppress SSN and Suppress 
AP Tax ID check boxes on the Manage Users screen. The table below describes how the suppression 
settings are applied when you open or print reports on the affected screens mentioned above. 

Suppress SSN Suppress AP Tax ID Result 

Cleared Cleared The Tax ID displays whether you select non-employee 
vendors or vendors that are company employees. 

Cleared Selected The Tax ID displays only when you select vendors that 
are company employees. 

Selected  Cleared The Tax ID displays only when you select non-employee 
vendors. 

Selected Selected The Tax ID is hidden whether you select non-employee 
vendors or vendors that are company employees. 
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Add Message to Identify/Prevent Vouchers Being Reversed Multiple 
Times 
The Reverse Posted Vouchers (APPREVVR) screen has been updated to display an error message in 
the Reverse Posted Vouchers report when you reverse an already reversed voucher. To check if a 
voucher has been reversed, Costpoint will compare the voucher number on the screen to the stored 
original voucher number. If the current voucher number does not match the original, then the voucher is 
already reversed. 

The Reverse Voucher Even if Already Reversed check box is added to the Reverse to Options group 
box. If this check box is selected when you reverse an already reversed voucher, no error message will 
display in the Reverse Posted Vouchers report. 

A new Voucher Type: Reversed Voucher, and the Original Voucher field are added to the Manage 
Accounts Payable Vouchers (APMVCHR) screen to store the original voucher number that will be used 
when checking if vouchers have been reversed. The Post Vouchers (APPPOSTV) screen has also been 
updated to store the original voucher number in its history tables. 

The Original Voucher field is also added to the Manage Purchase Order Vouchers (POMPOVCH) and 
Approve Vouchers (APMVCHRA) screens, and will be included in the report headers when you print a 
report for accounts payable or purchase order vouchers on the Print Voucher Edit Report (APRVCHR) 
screen. 

 

Add Receipt Qty to PO Line Lookup in Manage Purchase Order 
Vouchers 
This enhancement adds the Received Qty in the lookup of the purchase order (PO) line field of the 
voucher line. This will help you save time and improve efficiency when entering vouchers using received 
quantity for matching instead of using accepted quantity. 

You can now view the Received Qty column in the lookup of the PO Line field on the following screens: 

 Manage Purchase Order Vouchers 

 Approve Subcontractor Invoices 

 Manage Subcontractor Invoices 

Note: Vouchers reversed prior to this update do not have their original voucher number stored. 
Original voucher numbers will only be stored for vouchers that you will reverse after this update. 
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Contracts 
This section describes Costpoint 8.0 enhancements for the Contracts domain. 

Contact and Lead Tracking 
You can now track new contacts and leads in Costpoint with key information on status, qualification, 
source, and rating. A new application lets you enter or search for contacts, run queries on lead/contact 
statuses, and track lead/contact activities. You can view opportunities and contracts associated with the 
leads/contacts, and also link a lead/contact to various related leads/contacts. 

Several new screens are also created so you can manage lead/contact source types, rating types, and 
relationship types. Other existing applications in the Contracts and Accounting domains are updated as 
well to support this enhancement. 

 

Manage Leads and Contacts (CTMLEAD) 
Use this screen to enter and maintain information on leads and contacts and track key details on status, 
qualified stage, source, and rating.  

Leads and contacts are classified as New Lead, Qualified, and Disqualified. Based on the qualified 
stage and the customer ID/address code/contact ID affiliated with the lead/contact, you can use this 
screen to view the opportunities and contracts linked to the lead/contact record you are creating or 
accessing. In addition, you can link a lead/contact record to multiple related leads/contacts. 

You can also use this screen to add an affiliation for a new contact for an existing customer or vendor. 
You can add the new contact directly on the Business Affiliations subtask of this screen as long as a valid 
customer/vendor ID and a valid address code are selected on the same subtask. When you save the 
record, Costpoint saves the contact information to the customer/vendor master record and establishes the 
affiliation to the lead/contact. 

Before using this screen, Deltek recommends that you accomplish the other related applications. Some 
fields/lookup selections in Manage Leads and Contacts require entries to be set up in these applications 
before they can be used for new records on this screen. Refer to the “Set Up and Track Lead/Contact 
Information” topic in the online help for more information. 

To access the Manage Leads and Contacts screen, click Contracts » Resources » Leads and 
Contacts » Manage Leads and Contacts. 

Manage Lead Source Types (CTMSRCTP) 
Use this new application to enter and maintain lead source types. These lead source types are used on 
the Manage Leads and Contacts screen to identify the source of a lead/contact. 

There are 10 system-defined lead source types on this screen, and you can also enter new lead source 
types. You cannot delete system-defined codes, but you can control if codes display in the lookup in the 
Manage Leads and Contacts application. For user-defined codes, you will not be able to delete a code 
that has been used in a record on the Manage Leads and Contacts screen, but you can control if the 
code displays in the lookup in Manage Leads and Contacts. 

Attention: For more information on setting up leads/contacts and tracking them, refer to the 
procedures detailed in the “Set Up and Track Lead/Contact Information” section of the online help. 
You can also see the Contact and Lead Tracking Clickguide for step-by-step procedures on using the 
new screens and establishing lead/contact information.  
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Access this application through Contracts » Contract Management Controls » Contract Management 
Controls » Manage Lead Source Types. 

Manage Lead Rating Types (CTMRTTYPE) 
This new application lets you create and manage lead rating types. These lead rating types are used on 
the Manage Leads and Contacts screen to identify the general rating of a lead/contact. 

The three system-defined lead rating codes are Cold, Hot, and Warm, and additional lead rating codes 
can be entered. You cannot delete system-defined codes, but you can control if codes display in the 
lookup in the Manage Leads and Contacts application. User-entered lead rating codes that are used in a 
record in Manage Leads and Contacts cannot be deleted, but you can control if the code displays in the 
lookup in Manage Leads and Contacts. 

Click the following to open this new application: Contracts » Contract Management Controls » 
Contract Management Controls » Manage Lead Rating Types. 

Manage Lead/Contact Relationship Types (CTMRELTP) 
Use this new screen to enter and manage lead/contact relationship types. These relationship types are 
used on the Manage Leads and Contacts screen to identify the lead or contact’s relationship type.  

Seven system-defined relationship type codes are available on this screen. These cannot be deleted, but 
you can control if codes display in the lookup in the Manage Leads and Contacts application. You can 
enter new codes. Once you have used these new codes in a record on the Manage Leads and Contacts 
screen, you will not be able to delete these codes, but you can control if the code displays in the lookup in 
Manage Leads and Contacts. 

To access this new application, click Contracts » Contract Management Controls » Contract 
Management Controls » Manage Lead/Contact Relationship Types. 

Manage Leads and Contacts User-Defined Labels (CTMLDLAB) 
Use this new application to customize labels for the user-defined fields for leads and contacts. These 
labels are optional, but if there is additional information that you want to capture about a lead/contact, you 
can set up labels on this screen. 

Open this screen by clicking Contracts » Contract Management Controls » Resources Controls » 
Manage Leads and Contacts User-Defined Labels. 

Configure Contract Management Settings (CTMSETNG) 
New fields added to this screen allow you to have Costpoint automatically generate lead/contact IDs 
whenever you add new records in the Manage Leads and Contacts application. Available on the 
Corporate Settings subtask, these fields are: 

 Auto-Assign Lead/Contact IDs: Select this check box to have Costpoint automatically assign an 
ID to any new lead/contact record. 

 Last Lead/Contact ID: Enter the last lead/contact ID used. You must enter a value in this field if 
you select the Auto-Assign Lead/Contact IDs check box. This field defines the starting point for 
Costpoint-generated lead/contact IDs.  

Manage Opportunities (CTMOPP) 
The following fields have been added to the General tab of this screen: 
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 Lead Customer: Enter or select the lead customer that you want to associate with the 
opportunity. Both regular and prospective customers are allowed in this field. 

 Lead Contact: Enter or select the contact for the lead customer. 

For lead/contact records affiliated with the customer and/or contact you entered in these fields, the 
opportunity is displayed on the Opportunities subtask of the Manage Leads and Contacts screen. The 
same logic applies to the Primary Customer, Primary Contact, Acquisition Customer, and 
Acquisition Contact fields in Manage Opportunities.  

Manage Contract Management Customer Info (CTMCUST) 
This application has been updated to prohibit you from deleting a prospective customer address or 
prospective customer address contact that is affiliated with a lead or contact record on the Manage Leads 
and Contacts screen. 

Manage Contract Management Vendor Info (CTMVEND) 
This application has been updated to prohibit you from deleting a prospective vendor address or 
prospective vendor address contact that is affiliated with a lead or contact record on the Manage Leads 
and Contacts screen. 

Manage Customers (ARMCUST) 
This screen has been updated to prohibit you from deleting a customer address or customer address 
contact that is affiliated with a lead or contact record on the Manage Leads and Contacts screen. 

Manage Vendors (APMVEND) 
This screen has been updated to prohibit you from deleting a vendor address or vendor address contact 
that is affiliated with a lead or contact record on the Manage Leads and Contacts screen. 

GovWin IQ to Costpoint Vendor Integration 
GovWin IQ compiles vendor information from various sources, including vendor profile information such 
as classification codes as well as information from the System for Award Management (SAM.gov). 
SAM.gov information includes whether or not the vendor is on the government exclusion list. This 
exclusion list identifies those parties excluded from receiving federal contracts, certain subcontracts, and 
certain types of federal financial and non-financial assistance and benefits. 

It is important to have accurate data on the vendors included on this list as it could impact your ability to 
win an opportunity or receive payment on a contract. 

To this end, Costpoint releases a new API integration screen (Import GovWin IQ Vendor Data) that 
transfers vendor information from GovWin IQ into Costpoint. This eliminates the need for duplicate data 
entry and will ensure that the data is updated with no data entry errors. Both vendor and prospective 
vendor information can be imported and updated.  

Other existing screens have been enhanced to alert you if the vendor/subcontractor you selected is on 
the exclusion list. You still have an option to override the warning and save the vendor/subcontractor in 
the record if needed. A banner is displayed on select screens to provide additional details on the 
exclusion for the vendor/subcontractor. 

Details for the new screen and all updated applications are listed below. 
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Import GovWin IQ Vendor Data (APPIQVEN) 
The new Import GovWin IQ Vendor Data screen has been added to Costpoint Accounting. This screen 
allows you to import vendor information from GovWin IQ into Costpoint. Imported data includes SAM.gov 
exclusion information, North American Industry Classification System (NAICS) codes, various vendor 
classification information, and the latest date when the information was updated in GovWin IQ. 

This screen updates existing Costpoint vendors that have a valid GovWin IQ Company ID and do not 
have the Do Not Refresh check box selected on the Manage Vendors screen. 

If you are licensed for Contract Management, importing vendor data updates prospective vendor 
information. If vendor data from GovWin IQ does not match any GovWin IQ Company ID of a regular or 
prospective vendor, Costpoint creates a new prospective vendor.  

Configure Vendor Settings (APMSETVN) 
The GovWin IQ Vendor Integration group box has been added to this screen. It contains the following 
check box and field:  

 Allow any GovWin IQ Login Account to run Import GovWin IQ Vendor Data for all login 
Accounts/Companies: Select this check box to allow any GovWin IQ login account to run the 
Import GovWin IQ Vendor Data process for all Costpoint accounts or companies. When you 
select this check box, the Current Account and All Accounts options on the Import GovWin IQ 
Vendor Data screen are available for selection. Otherwise, only Current Account is enabled and 
selected by default. 

 GovWin IQ Login Account (Tenant ID): Use this field to enter the tenant ID that contains the 
login information that you will use for importing vendor data from GovWin IQ. 

Manage Vendor Employees (APMVEMPL) 
A new check box, Active SAM.gov Exclusion, has been added to this application. This displays only in 
Table view. If the check box displays as selected, it indicates that the vendor is on the exclusion list in 
SAM.gov. 

Another new field, Exclusion Banner, also displays in Table view. If the Active SAM.gov 
Exclusion check box displays as selected, this field displays information about the exclusion for the 
vendor, including the exclusion type and active and termination dates. In Form view, a read-only banner 
displays on the screen when a vendor is on the exclusion list. The message also includes the type of the 
exclusion as well as the active and termination dates of the exclusion. 

 

Approve Vendor Employees (APMAPRVE) 
A new check box, Active SAM.gov Exclusion, has been added to the Approve Vendor Employees 
screen. If displayed as selected, this check box indicates that the vendor is on the exclusion list in 
SAM.gov. 

 

Note: The exclusion applies to the vendor and not to the individual vendor employee. 

Note: The exclusion applies to the vendor and not to the individual vendor employee. 
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Manage Vendors (APMVEND) 
This screen has been configured to display updated vendor information imported from GovWin IQ into 
Costpoint through the Import GovWin IQ Vendor Data screen. Information for GovWin IQ vendor records 
is updated whenever the integration screen is run. For a single vendor record, information can be updated 
on the Manage Vendors screen by clicking the new Refresh from IQ button in the GovWin IQ Company 
Information group box. 

Imported data includes various vendor classification information, NAICS codes, and SAM.gov exclusion 
information.  

Vendor information is updated based on the GovWin IQ company ID. You specify the GovWin IQ 
company ID in the new GovWin IQ Company Information group box added to the Header tab. This 
group box has the following fields: 

Field Description 

GovWin IQ Company ID This is the vendor’s company ID in GovWin IQ.  

This ID will be stored in the Costpoint database and will be used to 
determine whether to import new prospective vendors or update 
existing vendors or prospective vendors when the integration is 
run.  

You can modify this field for the vendor. Note, however, that if the 
vendor record is already refreshed from GovWin IQ, changing or 
deleting the value in this field will prevent any future refresh from 
GovWin IQ for the vendor record. Any exclusion information 
related to the vendor will also be deleted. 

Last GovWin IQ Synch This field displays the date that this record was last updated by the 
GovWin IQ to Costpoint Vendor integration process. 

Last GovWin IQ Analyst Update This field displays the date that an update was made to the 
company profile in GovWin IQ. 

Do Not Refresh This check box is enabled only if a value exists in GovWin IQ 
Company ID. Select this check box to exclude the vendor record 
from being updated from the GovWin IQ company profile when the 
GovWin IQ to Costpoint Vendor integration process is run. 

Refresh from IQ Click this button to update the vendor data from the GovWin IQ 
company profile. This button is enabled only when the Do Not 
Refresh check box is not selected. 

Approve Vendors (APMVENDA) 
The Approve Vendors screen has been updated to display a warning message when you attempt to 
approve a vendor that has an exclusion record on SAM.gov. You can either cancel or continue the 
approval after the warning message displays. 

Manage Contract Management Vendor Info (CTMVEND) 
This screen has been configured to display prospective vendors imported from GovWin IQ into Costpoint 
through the Import GovWin IQ Vendor Data screen. Information for GovWin IQ prospective vendor 
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records is updated whenever this integration screen is run. For a single vendor record, information can be 
updated on the Manage Contract Management Vendor Info screen by clicking the new Refresh from IQ 
button on the General tab. 

Imported data includes basic vendor details, various classifications, and SAM.gov exclusion information. 
This information can be helpful when you are working on proposals and budgets and searching for 
vendors that meet specific criteria. 

The integration creates a new prospective vendor record in Costpoint when the GovWin IQ company ID 
does not exist for a regular or prospective vendor. You specify the GovWin IQ company ID in the new 
GovWin IQ Company Information group box added to the General tab. This group box has the following 
fields. 

Field Description 

GovWin IQ Company ID This field displays the vendor’s company ID in GovWin IQ.  

This ID will be stored in the Costpoint database and will be used to 
determine whether to import new records or update existing ones 
when the integration is run.  

You can modify this field for the prospective vendor. Note, 
however, that if the vendor record is already refreshed from 
GovWin IQ, changing or deleting the value in this field will prevent 
any future refresh from GovWin IQ for the vendor record. Any 
exclusion information related to the prospective vendor will also be 
deleted. 

Last GovWin IQ Synch This field displays the date that this record was last updated by the 
GovWin IQ to Costpoint Vendor integration process. 

Last GovWin IQ Analyst Update This field displays the date that an update was made to the 
company profile in GovWin IQ. 

Do Not Refresh This check box is enabled only if a value exists in GovWin IQ 
Company ID. Select this check box to exclude the prospective 
vendor record from being updated from the GovWin IQ company 
profile when the GovWin IQ to Costpoint Vendor integration 
process is run. 

Refresh from IQ Click this button to update the prospective vendor data from the 
GovWin IQ company profile. This button is enabled only when the 
Do Not Refresh check box is not selected. 

 

Approve Prospective Vendors (CTMVENDA) 
With the addition of new fields to Manage Contract Management Vendor Info, the Approve Prospective 
Vendors application is updated to transfer the values of those fields from the CT_VEND table to the 
VEND table when approving prospective vendors. It also transfers exclusion information from the 
CT_VEND_EXCLS table to the VEND_EXCLS table during approval. 

Note: If you are viewing information for a GovWin IQ regular vendor on this screen, all fields in the 
GovWin IQ Company Information group box are disabled and read-only. 
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Manage Opportunities (CTMOPP) 
On the Potential Resource Details subtask of the Team tab, the lookup of the following fields now 
includes the Active SAM.gov Exclusion check box:  

 Vendor ID 

 Vendor Employee ID 

 Prospective Vendor 

 Prospective Vendor Employee  

If the Active SAM.gov Exclusion check box is displayed as selected, it indicates that the vendor or 
prospective vendor has an active exclusion. For vendor employees and prospective vendor employees, 
the exclusion applies to the employee’s parent vendor and not to the employee. 

If you select a vendor (regular or prospective) with this check box selected and save the record, Costpoint 
displays a message informing you that the vendor has an active exclusion. You can either replace the 
initially selected vendor, or continue saving the record. 

Manage Contracts (CTMCNTR) 
Similar changes to those made in Manage Opportunities have been applied to Manage Contracts. On the 
Potential Resource Details subtask on the Team tab, the lookup of the following fields includes the Active 
SAM.gov Exclusion check box:  

 Vendor ID 

 Vendor Employee ID 

If displayed as selected, the Active SAM.gov Exclusion check box indicates that the vendor has an 
active exclusion in SAM.gov. If you attempt to add a vendor with this check box selected, Costpoint gives 
out a warning, but you will still be able to save the record. 

Note that only regular vendors and vendor employees are allowed to be added on this subtask in Manage 
Contracts. An error is displayed when you attempt to add a prospective vendor or vendor employee. 

Manage Subcontracts (CTMSBCNTR) 
You can now check if the vendor (regular or prospective) that you will associate with the subcontract has 
an exclusion record from SAM.gov. The lookup of the Subcontractor/Vendor ID field on the General tab 
includes the Active SAM.gov Exclusion check box. If displayed as selected, this check box indicates 
that the vendor is on the exclusion list. 

If you select a vendor that is on the exclusion list, upon save, Costpoint gives out a warning message. 
You can either proceed with saving, or cancel it and select a different vendor.  

On the Subcontract Info tab of this screen, the following check boxes have been added to the Business 
Classification Requirements group box: 

 8(a) Certified: Select this check box if the subcontract requires 8(a)-certified vendors. An 8(a) 
company is a business that is owned and controlled by socially and economically disadvantaged 
individuals (usually at least 51% ownership).  

 AbilityOne Non-Profit Agency: Select this check box if the subcontract requires vendors that 
are classified as an AbilityOne non-profit agency. An AbilityOne non-profit agency has at least 
75% of its total direct labor hours performed by persons who are blind or have significant 
disabilities. 
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Other Application Updates 
Other updates made to the Manage Opportunities screen include the following: 

 You can now import Federal Business Opportunities (FBO) from GovWin IQ into Costpoint. 
These opportunities have a prefix of FBO in their GovWin IQ ID. Previously, OPP (opportunity), 
BID (bid), and TNS (toons) were the only opportunity types allowed for import into Costpoint. 

 Costpoint now allows you to delete an opportunity record that was imported from GovWin IQ. This 
is helpful particularly for records that were incorrectly imported. In GovWin IQ, make sure to 
unmark the deleted opportunity record for import into Costpoint; otherwise, this record will be 
recreated in Costpoint with the next import. 

On the GovWin IQ Key Dates subtask (under the GovWin IQ subtask), a new Line No column has been 
added so you can keep track of the order of the opportunity milestone dates that were imported from 
GovWin IQ into Costpoint. 

Initiate Purchase Orders and Purchase Requisitions from Manage 
Subcontracts 
Costpoint now allows you to initiate purchase orders (POs) and purchase requisitions (PRs) from the 
Manage Subcontracts screen. Through the buttons added to Manage Subcontracts, you can directly 
access the Manage Purchase Orders and Manage Purchase Requisitions applications in the Materials 
domain and enter PO and PR information. You can link the PO and PR records to a subcontract record 
using the Subcontract ID field on the Subcontract Information tab of these screens. Costpoint then 
updates the subcontract record in Manage Subcontracts with the PO and PR details from Manage 
Purchase Orders and Manage Purchase Requisitions. 

More details on the changes in Manage Subcontracts are as follows: 

 Purchase Orders tab: The following have been added to this tab: 

 Initiate Purchase Orders: Click this button to open the Manage Purchase Orders screen. 

 PO Type: This new column displays the type of the purchase order linked to the subcontract 
ID. 

 PO Balance Remaining: This new column displays the remaining PO balance for the 
purchase order linked to the subcontract ID.  

 Instructions: This subtask contains instructions for initiating purchase orders from the 
Manage Subcontracts screen. It informs you that the subcontract ID needs to be manually 
entered in Manage Purchase Orders for the subcontract information to populate. 

 Requisitions tab: This is now a display-only tab. Previously, you were able to add requisitions 
and link them to the subcontract record on this tab. Now, you can link requisitions to a 
subcontract record via the Subcontract ID field on the Subcontract Information tab of the 
Manage Purchase Requisitions screen.  

 

Other changes on this tab include: 

 Initiate Purchase Requisitions: Click this new button to open the Manage Purchase 
Requisitions screen.  

Note: The SUBCNTR_RQ table previously updated by this tab has been removed. If you 
used this table before and you upgraded to Costpoint 8.0, the system will insert the 
subcontract IDs from SUBCNTR_RQ into the RQ_HDR table in order to maintain the link 
between the subcontract IDs and purchase requisitions. 
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 Instructions subtask: This new subtask contains instructions for initiating purchase 
requisitions from the Manage Subcontracts screen. It informs you that the subcontract ID 
needs to be manually entered in Manage Purchase Requisitions for the subcontract 
information to populate. 

 New error and warning messages: The following messages have been added to the 
Subcontractor/Vendor ID field on the General tab to prevent possible issues when linking POs 
and PRs with subcontracts: 

Condition Type of Message Message 

Vendor is inactive Error This vendor cannot be used. It has a status of 
Inactive in the Manage Vendors screen. 

Vendor is for Payroll Error This vendor cannot be used as it is a Payroll 
Vendor. 

Vendor is not 
Approved 

Error Vendor is not approved. 

Vendor on Warning 
Status 

Warning This Vendor is on warning status in the Manage 
Vendors Screen. 

Vendor is Pending 
Approval 

Warning Vendor is pending approval. 

Labor Category Enhancements and Integration with Planning 
Manage Opportunities now provides the ability to create labor categories and establish labor criteria 
requirements specific to a single opportunity, enabling you to make assignments based on labor 
requirements without the need to immediately assign an individual resource, such as a specific employee 
or vendor.  

Because the labor categories are created from within Manage Opportunities, they can be tailored to the 
specific needs of the opportunity without adding to the existing store of project labor categories (PLCs) 
until such time as the opportunity is won.  

After the labor category requirements are established, you can add resources leveraging those 
requirements, and to facilitate this process, all potential resources (employee, vendor, generic staff, and 
so forth) are now combined in a single subtask table.  

To further increase the usability of this feature, if you use Costpoint Planning, you can now link the two 
applications so that labor category-related information is shared between them. For example, when a new 
business budget is created and linked to an opportunity, the labor categories created in Manage 
Opportunities are available for selection in Planning. You can use the labor category in the Advanced 
Search feature in Planning to search for actual resources who meet the required criteria. Any resources 
added to the new business budget are added to the opportunity as potential resources.  

Similarly, labor category information created in Manage Opportunities can be shared with Manage 
Contracts, as you now have the ability to load labor categories from an opportunity to an associated 
contract. Note also that Manage Contracts includes the same labor category-related subtasks that exist in 
Manage Opportunities. 

Manage Contracts also has the ability to link to Costpoint Planning. When a project budget is linked via a 
project to a contract, the contract can be opened from within the project budget, and resources added to 
the project budget can be viewed in Manage Contracts as project budget resources. 
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Below is a summary of how information flows between the Contracts and Planning domains for this 
enhancement. 

 

 

Manage Opportunities (CTMOPP) 
You can now define labor categories and required criteria in Manage Opportunities to help you match 
work force requirements against resources at the planning stage. New fields and subtasks have been 
added to the screen to capture this information and to enable integration with the Planning domain if you 
are licensed for Costpoint Planning.  

On the main screen, the following items are now available: 

 Use Planning: Select this check box if you want to leverage resource information from the new 
business budget in the Planning domain in setting up team information for the opportunity. Once 
Use Planning is enabled, opportunity data in the Contracts domain will be shared with the 
Planning domain, and some Planning data will also flow through the Contracts domain. Note that 
this check box displays only if you are licensed for Costpoint Planning. 

 New Business Budget ID: This field displays only if you selected Use Planning. It displays the 
ID of the new business budget linked to the opportunity through the New Business Budgets 
screen in Planning. 

Major updates on the Team tab include the addition of these new subtasks: 

 Labor Categories: Use this subtask to define labor categories that can help you identify 
resources that meet specific criteria needed for the opportunity. You can manually assign multiple 
resources to a labor category, or you can have them loaded from Costpoint Planning. Once 

Attention: For more details on leveraging the Planning domain in setting up teams for opportunities 
and contracts, refer to the “Opportunity and Contract Teams and Integration with Planning” topic in 
the online help. 

For additional information on the respective updates in Planning, see “Integration with Costpoint 
Contracts.” 
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resources have been assigned, changes to the labor category depend on the settings selected in 
the new Labor Category Options group box on the Configure Contract Management Settings 
screen. 

 Required Criteria: This subtask is available under Labor Categories. Use this subtask to define 
the criteria required for resources needed for the opportunity for a specific labor category. Criteria 
include skills, training, courses, and other work force requirements. If Use Planning is selected, 
these criteria (together with the opportunity ID and labor category) will be available in Planning. 
The Advanced Search subtask of the New Business Budgets and Budget By Resource screens 
pulls in resources that match the criteria for the selected labor category, and you can choose to 
add these resources to the new business budget. Once the budget is committed, these resources 
are loaded to the Potential Resource Details subtask in Manage Opportunities. 

 Potential Resource Details: This subtask replaces the Potential Work Force Employees 
subtask. Various types of resources can be set up on the new subtask, while the previous version 
included just employees.  

Use this subtask to add or view resources that may be included in the bid and proposal process 
for the opportunity and those that could potentially work on the future contract. Resources 
include: 

 Employee 

 Generic Staff 

 Vendor 

 Vendor Employee 

 Prospective Vendor 

 Prospective Vendor Employee 

If Use Planning is selected, you will not be able to manually add records to this subtask as all 
resources will be loaded from Planning. You also cannot delete records that were added through 
Planning; however, you can add and edit additional information to the records, including the PLC 
code, default PLC indicator, Include in Work Force check box, and other fields. 

Another change to the Team tab is on the Opportunity Teammates/Competitors subtask. This has been 
renamed to Opportunity Primes/Competitors. Fields no longer include options for subcontractors, and the 
Vendor Employees subtask has been removed as adding subcontractors has been moved to the 
Potential Resource Details subtask. The Teammate/Competitor field has been renamed to 
Prime/Competitor, while the following have been removed: 

 Include in Work Force check box 

 PLC field 

 Default PLC check box 

On the Status tab, validations have been added to the opportunity Date Opened and Date Closed fields. 
When modifying these dates, Costpoint alerts you if the labor category period of performance (POP) start 
date is earlier than the updated opportunity start date, or if the labor category POP end date is later than 
the updated opportunity end date.  

The Project Initialization subtask has been updated so that the resources on the Team tab are correctly 
added to the work force when you initialize projects in the Contracts domain. Note, however, that 
prospective vendors and customers are not included in the mass add/update process. 

New database tables added for this enhancement are: 

 CTM_LAB_CAT 
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 CTM_LC_CRITERIA 

 CTM_LC_RESOURCE 

The OPP_WORKFORCE_EMPL table, on the other hand, has been removed. 

Manage Contracts (CTMCNTR) 
To ensure seamless flow of information from opportunities to contracts, similar enhancements to those 
made in Manage Opportunities have been made to the Manage Contracts screen.  

On the main screen, the same Use Planning check box is added to allow you to leverage the Planning 
domain functionality in setting up team information for the contract. If you select this check box and the 
contract is linked via a project to a project budget in Planning, resources added to the project budget will 
be viewable on the Project Budget Resources subtask. 

Unlike in Manage Opportunities, regardless of how Use Planning is set, you will be able to manually 
enter records on the Potential Resource Details subtask in Manage Contracts.  

On the Team tab, the new subtasks added are the following: 

 Labor Categories: Use this subtask to define labor categories that can help you identify 
resources that meet specific criteria needed for the contract. You can manually add labor 
categories or load them from the opportunity associated with the contract. You can also manually 
assign potential resources to a labor category or load them from the opportunity. Once resources 
have been assigned, changes to the labor category depend on the settings selected in the new 
Labor Category Options group box on the Configure Contract Management Settings screen. 

 Required Criteria: This subtask is available under Labor Categories. Use this subtask to define 
the criteria required for resources needed for the contract for a specific labor category. Criteria 
include skills, training, courses, and other work force requirements.  

 Potential Resource Details: This new subtask replaces the Potential Work Force Employees 
subtask. Various types of resources can be set up on the new subtask, while the previous version 
included just employees.  

You can manually enter records on this subtask or load potential resources from the opportunity 
linked to the contract. Resources that could potentially be added to the project associated with 
the contract include: 

 Employee 

 Generic Staff 

 Vendor 

 Vendor Employee 

 

 Project Budget Resources: Use this subtask to view project budget resources that were added 
to the related project budget in Costpoint Planning. This subtask is visible on the Team tab only if 
you have selected the Use Planning check box on the main screen. Resources display on the 
subtask if any Planning project budget (with resources) is linked to the contract. 

Other changes on the Team tab are on the following subtasks: 

 Labor Rates: The PLC field is now required on this subtask. Only PLCs defined on this subtask 
will be available for entry/selection on the Labor Categories subtask of Manage Contracts. 

Note: Prospective Vendor and Prospective Vendor Employee are available in the 
Resource Type drop-down list but are not allowed to be added as potential resources for the 
contract. 
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 Contract Primes: Previously named as Contract Teammates, this subtask now only allows 
addition of prime contractors as subcontractors/vendors can be added through the Potential 
Resource Details subtask. Some fields have been renamed, while the following subtask and 
fields have been removed: 

 Vendor Employees subtask 

 Prime/Subcontractor field 

 Include in Workforce check box 

 PLC field 

 Default PLC check box 

On the Dates tab, validations have been added to the contract Period of Performance date fields. When 
modifying these dates, Costpoint alerts you if the labor category POP start date is earlier than the 
updated contract start date, or if the labor category POP end date is later than the updated contract end 
date.  

The Project Initialization subtask has been updated so that the resources on the Team tab are correctly 
added to the work force when you initialize projects in the Contracts domain.  

Similar with Manage Opportunities, the Manage Contracts screen now updates the following new tables: 

 CTM_LAB_CAT 

 CTM_LC_CRITERIA 

 CTM_LC_RESOURCE 

The CNTR_WORKFORCE_EMPL table, on the other hand, has been removed. 

Configure Contract Management Settings (CTMSETNG) 
On the Corporate Settings subtask of this application, the Labor Category Options group box has been 
added so you can specify how Costpoint should handle labor categories once resources have been 
assigned to them on the Manage Opportunities or Manage Contracts screen. This group box has the 
following options: 

 Do not allow changes once resources are assigned: If you select this option, no changes to 
the opportunity or contract labor categories will be allowed. Costpoint displays an error message 
if the user attempts to make changes to a labor category. 

 Allow changes once resources are assigned: If you select this option, any changes to the 
labor category will be allowed. No message is displayed, unless you select the Provide Warning 
check box. 

 Provide Warning: This is enabled only if you selected Allow changes once resources are 
assigned. If you select this check box, Costpoint displays a warning message when the user 
makes changes to the labor category, but the user will still be able to save the record. 

Approve Prospective Vendors (CTMVENDA) 
If a prospective vendor or its related employee is assigned to a new business budget in Planning, upon 
approval of the prospective vendor, Costpoint automatically updates the resource type from prospective 
vendor (or prospective vendor employee) to regular vendor (or vendor employee) on the New Business 
Budgets screen in Planning. The related vendor or vendor employee ID is updated as well. 
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Print Vendor Employee Detail Report (APRVEMPL) 
The Vendor Name column has been added in the lookup of the Vendor Employee field to help you 
easily identify the vendor employee record you want to select. 

Configure Vendor Settings (APMSETVN) 
The Vendor Name column has been added in the lookup of the Last Vendor Employee ID field to help 
you easily identify the vendor employee record you want to select. 

Migrate GovWin Capture Management Data (AOPCPDAT) 
The Migrate GovWin Capture Management Data screen has been updated to support the transfer of 
vendor information from the Primes subtask (previously labeled as Teammates subtask) to the Potential 
Resource Details subtask on the Team tab of the following screens: 

 Manage Opportunities 

 Manage Contracts 

The application will use updated mapping and criteria for migrating vendor information from GovWin 
Capture Management to Costpoint Contracts. 

New Opportunities Quick View Application 
The new Opportunities Quick View (CTMOPPM) application added to the Contracts domain enables you 
to quickly access information on your opportunities and related activities. This is a condensed form of the 
Manage Opportunities screen, consisting of select fields that display information you access most often. 
Data that displays includes, but is not limited to, the following: 

 Opportunity ID, name, and description 

 Opportunity status and key dates 

 GovWin IQ information 

 Employee team, prime contractors, and competitors 

 Activities and user-defined information 

Except for the Activities subtask (where you can enter new activities for the opportunity), all fields and 
subtasks on this screen are read-only, but you can do a query to search for opportunity data.  

You can access this screen both in Costpoint web and in Costpoint Mobile. Costpoint can be deployed on 
mobile devices (such as Android devices, iPhone, and iPad) as well as on desktops. On mobile devices, 
this screen’s UI is configured such that you have the best view when accessing your opportunity data in 
portrait and landscape forms. In a few clicks or swipes, you can navigate through the screen and search 
for the information you are looking for. 

Supplier/Vendor Rating Added to Manage Contract Management 
Vendor Info 
Previously, supplier/vendor rating information was available only on the Manage Contracts and Manage 
Subcontracts screens, with the rating linked to a specific contract or subcontract record. You had to go 
through each record to see the supplier/vendor ratings. 

Now, the new Supplier/Vendor Rating tab added to the Manage Contract Management Vendor Info 
screen allows you to view consolidated supplier/vendor ratings for a specific supplier/vendor in just one 
location. This tab is a read-only presentation of the ratings on the Manage Contracts and Manage 
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Subcontracts screens (that is, you still need to enter ratings in Manage Contracts and Manage 
Subcontracts). It contains the Supplier/Vendor Rating subtask, where you can view the scores of the 
supplier on the following evaluation areas: 

 Responsiveness/Innovation 

 Customer Service, Quality and Delivery 

 Financial 

 Relationship 

A new field, Average Rating, has also been added to this screen. This field displays the average rating of 
a specific supplier/vendor. Costpoint derives this value by averaging the supplier/vendor ratings entered 
in Manage Contracts and Manage Subcontracts. 

 

The VEND database table is updated to include a new column (AVG_RATING_PERCENT) that will store 
the average rating of regular vendors. The functionality of the Manage Contracts and Manage 
Subcontracts applications has also been updated to ensure that the new column in VEND is updated 
whenever a rating is added or changed on these screens. 

 

Note: The new tab and the new field are visible only for regular vendors and are hidden for 
prospective vendors. 
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Projects 
This section describes Costpoint 8.0 enhancements for the Projects domain. 

Hold Status Added to Standard Bills 
A new Hold status for standard bills has been added to allow users to keep these bills in a static state 
after manual adjustments are made after bill calculation.  

 

The following screens have been updated:  

 Manage Standard Bills (BLMGBILL): The Status drop-down list on the Standard Billing Info tab 
now includes HOLD. If you select this option for the bill, Costpoint will not calculate/recalculate 
values for the bill when you run Calculate Standard Bills. The system will also not post the bill.  

 Select Bills for Posting (BLPSELCT): The Set Billing Status drop-down list now includes 
Hold. If you select this option, Costpoint mass updates the status of the selected range of bills to 
Hold. 

 

 Calculate Standard Bills (BLPGBILL): This screen has been updated to not overwrite values for 
standard bills on hold. When you try to calculate bills in a Hold status and there are no bills in an 
Unselected status, a validation message displays. 

 Post Standard Bills (BLPGEN): This screen has been updated to not post standard bills on 
hold. When you try to post bills in a Hold status and there are no bills in a Selected status, a 
validation message displays. 

Task Order Number Added to Standard and Milestone Bills 
You can now print task order numbers in standard and milestone bills. This lets you avoid manual 
manipulation of invoices to indicate the task order number.  

The following applications have been updated for this enhancement: 

 Calculate Standard Bills (BLPGBILL): This is updated to bring the task order number value 
from the PROJ table into the BILL_EDIT_INVC_HDR table. 

 Manage Generic Billing Formats (BLMBFRM): The Show Task Order Number and Show 
Customer PO check boxes are now available on the Header tab of this screen. Select these 
options to print the customer purchase order (PO) number and task order number on the header 
of the bill. 

 Print Standard Bills (BLRMBIL): This now prints the task order number and customer PO 
number on the header of the bill, if the options to display these values are selected on the 
Manage Generic Billing Formats screen. 

 Post Standard Bills (BLPGEN): When posting bills, this application brings in the task order 
number from the BILL_EDIT_INVC_HDR table to the BILL_INVC_HDR_HS and 
BILL_EDIT_HDR_CUM tables. 

Note: This enhancement is applicable only to standard bills and not to other bill types. 

Note: Mass updating to Hold is allowed only for standard bills. If you select Progress 
Payment Bills in Select Bill Type and run the screen, Costpoint throws an error message. 
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 Reverse Previous Bills (BLPREVB): When reversing previous bills, this application updates the 
task order number in the BILL_EDIT_INVC_HDR table using the value from the 
BILL_INVC_HDR_HS table. 

 Print ACRN Billing Edit Report (BLRACRN): This now prints the task order number and 
customer PO number on the header of the bill, if the options to display these values are selected 
on the Manage Generic Billing Formats screen. 

 Manage Milestone Percent Complete Bills (BLMMPCB): The Task Order and Subcontract 
check boxes have been added to the Report Options tab of this screen. Select these options to 
print these values on the header of milestone bills.  

The task order number and subcontract number come from the Details tab of the Manage Project 
User Flow screen, but you can modify these values in the new Task Order and Subcontract 
fields on the Bill Details tab of Manage Milestone Percent Complete Bills. 

 Print Milestone Percent Complete Bills (BLRMPCB): This now prints the task order number 
and subcontract number on the header of the bill, if the options to display these values are 
selected on the Manage Milestone Percent Complete Bills screen. 

 Post Milestone Percent Complete Bills (BLPMPCB): When posting milestone bills, this 
application now brings in the task order number and the subcontract number from the 
MILESTONE_INVC_HDR table to the MILESTONE_HDR_HS table.  

For standard bills, the TASK_ORDER_NO column has been added to the following tables to store the 
value for the task order number: 

 BILL_EDIT_INVC_HDR 

 BILL_INVC_HDR_HS 

 BILL_EDIT_HDR_CUM 

For milestone bills, columns TASK_ORDER_NO and SUBCTR_ID are added to the following tables to 
store the task order and subcontract numbers: 

 MILESTONE_INVC_HDR 

 MILESTONE_HDR_HS 

The DELTEK.BILL_FRMT table is also updated with two new columns (HD_CUST_PO_ID and 
HD_TO_NO_ID) to store the value of the Task Order and Subcontract check boxes in Manage 
Milestone Percent Complete Bills. 
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Planning 
This section describes version 8.0 enhancements for Costpoint Planning. 

Direct Integration with Costpoint and Menu Updates 

Application Codes Removed from Planning Menu Items 
Previously, the application codes from the Budgeting and Planning 6.1 menu items were added to the 
menu items in Planning 7.0 so users can easily find the applications in the new version. 

For Costpoint Planning 8.0, all of the application codes were removed to be consistent with the rest of the 
Costpoint menu items. 

Imported Table Data Replaced by Link Views 
Backend integration between Costpoint and Costpoint Planning was enhanced to reduce the number 
tables requiring update through the refresh process. A majority of tables are now updated through a more 
direct integration, and although the refresh process is still required, the runtime is shorter.  

New Mass Processing Utility for Updating Org Budgets/Outlooks  
Organization Budgeting now includes a new utility that, depending on selected query options, enables 
you to apply three budget processes to all or a range of organizations, rather than to just a single 
organization. Using this mass processing application, you can: 

 Generate new outlooks from approved budgets/outlooks. 

 Commit Working status budgets. 

 Update and recommit Complete/Incomplete budgets or outlooks with global changes, such as 
those made to costpools or default labor rates. (This ability depends on Org Budgeting 
configuration as described below.) 

To access the application, click Planning » Organization Budgeting » Controls and Utilities » Mass 
Create/Recommit Budgets/Outlooks. 

 

After selecting query criteria, such as choosing the fiscal year, the organizations (all or a range), and the 
type of budget (Outlook or Budget) and budget statuses, click Preview to confirm the results, and then 
click from the toolbar to process your selections. Following processing, and depending on your selections, 
the utility will: 

 Create Working status outlooks from approved budgets/outlooks if Approved was selected. 

 Commit Working status budgets/outlooks and update the statuses to Incomplete if Working was 
selected. 
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 Update Incomplete/Complete budgets/outlooks with any global changes (for example, 
modifications to PTO setup) made in Organization Budget Cycle Initialization if: 

 Incomplete or Complete was selected. 

 The current fiscal year is selected. 

 The Org Budget Revenue Calculation setting on the Organization tab of Configuration 
Settings is selected as Org Revenue Calculation. 

 

To check the result, click Organization Budgeting » Budget Outlook Processing » Organization 

Budgets/Outlooks, and click from the toolbar. This will refresh the Organization Budget Status grid. 

Similar to other Costpoint processing applications, you can save query parameters for later reuse or for 
running the process as a scheduled job. 

Please see the Mass Create/Recommit Budgets/Outlooks online help topic for detailed screen information 
and instructions on how to run the utility. 

Integration with Costpoint Contracts 
Costpoint Planning and Costpoint Contracts were integrated in key areas to allow direct, one-to-one 
linking of new business budgets to opportunities and of project budgets to project contracts. 

The connection is enabled through a new Use Planning setting that was added to both Manage 
Opportunities and Manage Contracts in Costpoint Contracts. The setting, when selected, makes an 
opportunity or contract accessible to Costpoint Planning.  

 

When Use Planning is selected in Manage Opportunities, the opportunity ID and information from the 
Team Management tab, such as labor categories and skills criteria, are accessible in New Business 
Budgets and Budget by Resource, as well as in Advanced Search when used from either application.  

 

In Project Budgets/EACs, a new hyperlinked field provides access to the linked project contract, which is 
either read-only or editable depending on user rights.   

Continue reading below to learn about using the integration within Costpoint Planning. 

Integration Updates to New Business Budgets 
The New Business Budgeting » Actions/Processing » New Business Budgets application includes 
new options that allow you to access an opportunity where Use Planning is selected and which has not 
already been linked to another new business budget.  

Note: During processing, Incomplete and Complete budgets are temporarily updated to 
Working to enable budget recalculations, but the original statuses are reset upon 
completion. 

The utility will not process budgets where the setup process is incomplete. 

Note: See “Labor Category Enhancements and Integration with Planning” to learn how to enable the 
integration in Costpoint Contracts, as well as to learn about other labor and team-related updates. 

Note: See “Advanced Search Enhancement” for details on using the integration when searching for 
resources and to learn about using the new Multi-Select and % Match features for targeted searching. 
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Updates to the New Business Budget Status Table 

The New Business Budgets Status table includes a new Opportunity ID column. This column is 
integrated with Manage Opportunities in Costpoint Contracts and allows you to establish a direct link 
between the new business budget and an active opportunity, if Use Planning is selected on the 
opportunity record.  

If the budget is not yet linked to an opportunity, this field displays a value of None.  

You can only link to an opportunity at the top level of the budget, and the Opportunity ID saved at that 
level is automatically applied to the lower levels.  

Click  to display the opportunities that are available for linking. Choose the opportunity to which you 
want to link and click Select. 

After you save the record, the Opportunity ID is applied to all existing levels and displays as a hyperlink, 
which opens the opportunity record in Manage Opportunities. The record is read-only or editable 
depending on user rights. 

After the link is established, note the following: 

 The ID can only be changed if no completed budgets exist. 

 You receive a system message if the status of the opportunity changes from active to inactive. 

Updates to the Hours Subtask 

This section describes changes made to the Hours subtask related to vendor information and opportunity 
labor categories. 

If the new business budget is linked to an opportunity, vendor information from Contract Management 
populates the ID Type lookup with values for the following: 

 Prospective Vendor 

 Prospective Vendor Employee  

The above values are available only when you are budgeting subcontractor or consultant hours. If the 
status of a vendor or vendor employee is later upgraded to Approved, the ID number is automatically 
updated. When the budget is opened, the old Prospective ID and the new approved ID is displayed for 
any changes. 

A new Opportunity Labor Category field was also added to the Hours Subtask. This field displays if the 
budget is linked to an opportunity in Costpoint Contracts. This field is disabled if ID Type is selected as 
Key Entry, PLC, or GLC.  

Click  to assign an opportunity labor category for the selected resource.  

The lookup values populate from the Labor Categories table on the Manage Opportunities screen, and 
because the integration is bidirectional, the resource information is applied to the Potential Resources 
Details table in Manage Opportunities after the budget is committed.  

Integration Updates to Budget By Resource  
The Add/Edit/Delete Assignments subtask in Resource Planning » Resource Planning » Budget By 
Resource includes a new Opportunity Labor Category lookup that is enabled if you are budgeting 
hours for a new business budget that is also linked to an opportunity in Manage Opportunities.  

Click  to assign an opportunity labor category for the selected resource.  
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The lookup values populate from the Labor Categories table on the Manage Opportunities screen, and 
because the integration is bidirectional, the resource information is applied to the Potential Resources 
Details table in Manage Opportunities after the budget is committed. 

In addition, a new Opportunity ID field displays the Opportunity ID associated with the new business 
budget if the selected resource is assigned to a new business budget that is linked to an opportunity, and 
you have saved the resource record. 

 

Integration Updates to Project Budgets/EACs 
The Project Budgeting » Budget/EAC Processing » Project Budgets/EACs application includes two 
new fields that display if the budget is linked to a contract. These fields, which display in form view only, 
are: 

 CTM Contract ID: If the project is linked to a contract in Contract Management, this field displays 
the contract ID. Depending on your user rights, you can click the hyperlinked ID number to either 
edit the contract or view the contract (read-only). 

 CTM Contract Name: This field displays the name of the contract from Contract Management. 

Advanced Search Enhancement 
The Advanced Search functionality was updated to include new resource types and search categories, as 
well as new fields related to the integration of Planning with Costpoint Contract Management.  

Although the Advanced Search subtask is available from three applications (Budget by Resource, New 
Business Budgets, and Project Budgets/EACs), not every update described in this section affects all three 
applications in exactly the same way. These differences are noted throughout.  

Due to the integration of Planning with Costpoint Contract Management, Advanced Search in New 
Business Budgets and Budget by Resource includes two new fields (Opportunity ID and Opportunity 
Labor Category) that allow you to search for the labor categories already established on the Team tab in 
Manage Opportunities.  

Note that in Advanced Search for New Business Budgets, Opportunity ID is a default value already 
established when the budget was created. 

For more information, see the Integration with Costpoint Contract Management feature. 

New Resource Types and Search Categories 
In addition to the existing Resource Types of Employee and Vendor Employee, the Resource Type 
group box now includes two new check boxes: 

 Contract Employee 

 Vendor 

Different Resource Types are available depending on where you access Advanced Search: 

Note: See “Advanced Search Enhancement” below to learn more about searching for resources 
according to opportunity labor category and skill requirements.  
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Screen Available Resource Type 

Budget By Resource Employee 

Contract Employee 

Vendor 

Vendor Employee 

New Business Budgets » Hours subtask Employee 

Contract Employee 

Vendor 

Vendor Employee 

Project Budgets/EACs » Staff Hours subtask Employee 

Project Budgets/EACs » Subcontractor Hours 
subtask 

Contract Employee 

Vendor 

Vendor Employee 

Project Budgets/EACs » Consultant Hours 
subtask 

Contract Employee 

Vendor 

Vendor Employee 

New resource search categories have also been added. While the current categories (Manager, Skills, 
Organization, Credentials, and General Labor Category) are still available, the Resource Search Criteria 
group box now includes the following new fields: 

 ITAR Required 

 Socioeconomic Status 

 Location 

 NAICS 

 US Citizenship Required? 

 Clearance 

To streamline the selection of criteria, the search category fields were converted to drop-down lists, and 
depending on the criterion selected (for example, Manager or Skills), you will be able to select multiple list 
items at the same time, enabling you to build your search more quickly. 

For each search category (both new and existing ones), the table below indicates the resource type for 
which it is available and whether the multi-selection feature is enabled. 
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Field Enabled for Resource Type 
Multi-select and Logic 
Operator 

ITAR Required Employee 

Contract Employee 

Vendor Employee 

N 

Manager Employee 

Contract Employee 

Vendor Employee 

Y (or) 

Skills Employee 

Contract Employee 

Vendor Employee 

Y (and) 

Socioeconomic Status Vendor Y (or) 

Location Employee  

Contract Employee 

Vendor Employee 

Y (or) 

Organization Employee 

Contract Employee 

Y (or) 

Credentials Employee 

Contract Employee 

Y (and) 

NAICS Vendor Y (and) 

US Citizenship Required? Employee 

Contract Employee 

Vendor Employee 

N 

General Labor Code Employee 

Contract Employee 

Vendor Employee 

Y (or) 

Clearance Employee  

Contract Employee 

N 
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Resource Table % Match and Multi-Select Functionalities 
The Resource table, which displays the resources that matched your search criteria, now has the multi-
select functionality. You can select multiple resources by holding the CTRL key while selecting records or 
select a range of records by holding SHIFT and clicking the beginning and end of the range. 

The Resource table also includes the new % Match column that indicates how closely each result 
matches the selected criteria.  

Costpoint calculates the % Match for a resource type depending on the search criteria you select and if 
the criteria have the multi-select function.  

For criteria that do not have multi-select or have multi-select with an OR logic operator, 100% is divided 
by the number of search criteria you select. If the resource matches a criterion, that criterion gets the 
whole portion from the divided percentage. 

For example, you select the resource type Employee. In the Resource Search Criteria group box, you 
select an option on the ITAR Required (no multi-select) drop-down list and select multiple options on the 
Manager (multi-select, OR) drop-down list. 50% is allotted for each criterion.  

If the resource matches the ITAR authorization you selected, it gets the whole 50% allotted for the ITAR 
Required criterion. If the resource matches at least one option you selected on the Manager drop-down 
list, it also gets the whole 50% allotted for the Manager criterion, making the resource a 100% match. 

For search criteria that have the multi-select function with an AND logic operator, each option you select 
is added to the divisor by which 100% is divided. The criterion itself is not included in the divisor. 

For example, you select the resource type Employee. In the Resource Search Criteria group box, you 
select an option on the ITAR Required (no multi-select) drop-down list and select three skill codes on the 
Skills (multi-select, AND) drop-down list. 100% must be divided between one criterion without multi-select 
and the three skill codes, making the divisor ‘4’. 25% is allotted for the ITAR Required criterion, and each 
skill code you selected also gets 25%. If the resource matches the ITAR authorization and only one of the 
skill codes, it becomes a 50% match. 

Budget Versioning and the Ability to Do “What-If” Scenarios 
Budget versioning was added to Project Budgets / EACs and New Business Budgeting, enabling you to 
create and apply versioning codes and descriptions. (for example, “aggressive” or “conservative”) to 
multiple versions of the same budget and, after designating one version as final, run reports according to 
version, or in some reports, compare versions using a new What If option. 

Final versions will be applied to project budget rollups and, depending on configuration, to Org Budgeting 
as well. 

Manage Budget Version Codes 
The Manage Budget Version Codes screen has been added in Planning » Administration » 
Administration Controls. Use this screen to create budget version codes and descriptions that you can 
use to label different versions of a project budget/EAC or new business budget.  
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It contains the following columns: 

Column Description Format (Length) 

Version Code This is a 3-letter abbreviation of the label you want to use 
for a budget version. 

Alphanumeric (3) 

Version Code 
Description 

This is the definition of the label you want to use for a 
budget version. 

Alphanumeric (25) 

Ability to Create Multiple Versions with Descriptions 

The New Business Budgets screen has been updated to allow you to create multiple versions of a new 
business budget and assign a code to each version you create. 

The following columns have been added to the screen: 

Column Description 

Version Code Enter, or click  to select, a code you want to assign to the current version. The 
lookup displays version codes entered on the Manage Budget Version Codes 
screen. 

If the budget is imported from Excel, the version code defaults to N/A. 

Final Version Select this check box to mark the version as final. For each budgeted level, you 
must mark one version with a Status of Complete as final. If no version is marked 
as final, an error message displays and the record cannot be saved. 

Versions marked as final are included in reports. (Those with a Work Type of 
Proposal that are marked as final are not included in project budget and some 
organization budget reports.)  

They are also integrated with an organization budget if your company uses the 
integrated method to calculate Org revenue. 

Updates to New Business Budgeting Reporting (Display Budget Version Codes) 

Screens in the Reports/Inquiries application group have been updated to include different versions of a 
new business budget in the reports. 

This affects the following screens:  

 New Business Budget Summary (Revenue/Cost) 

 Multi-New Business Budget Consolidation (Revenue/Cost) 

 Structured New Business Budget Summary (Revenue/Cost) 

Note: The integrated method is in effect when Org Budget Revenue 
Calculation in Configuration Settings is not selected as Org Revenue 
Calculation. Contact your System Administrator for questions regarding this 
setting, which is configured during initial system setup and should not be 
changed. 
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The Version Code column is added to all three screens to identify which version of a budget is included 
in the report. 

When you view budget summaries on the New Business Budget Summary (Revenue/Cost) and 
Structured New Business Budget Summary (Revenue/Cost) screens, only versions marked as final will be 
included. 

While on the Multi-New Business Budget Consolidation screen, all versions that have a Status of 
Complete, including those which have the Final Version check box cleared, will be included. In addition, 
since the Version Code column is now available on this screen, you can now group budgets according to 
their version codes. 

Manage User-Defined Information for New Business Budgets 

The Manage User-Defined Information screen has been added in New Business Budgeting » Controls 
and Utilities. Use this screen to enter data in the user-defined fields for a new business budget.  

 

The labels that display for each type of user-defined field are first set up in Projects » Project Setup » 
Project Setup Controls » Manage User-Defined Labels. 

The information entered on this screen is optional and can be set up at any time. This screen is also 
available as the User-Defined Info subtask on the New Business Budgets screen. 

Add User-defined Info Subtask to New Business Budgets 

The User-Defined Info subtask has been added to the New Business Budgets screen. Use this subtask to 
enter data in the user-defined fields for a new business budget. The labels that display for each type of 
user-defined field are first set up in Projects » Project Setup » Project Setup Controls » Manage User-
Defined Labels. 
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This subtask is also available as a standalone application: New Business Budgeting » Controls and 
Utilities » Manage User-Defined Information. 

Project Budgeting Updates  
Screens in the Project Budgeting module have been updated to allow you to create multiple versions of a 
budget/EAC.  

The Revenue Integration screen and screens under the Top Level (All Projects) Reports, Level Down 
Reports, and Supplemental Reports application groups have also been updated to use the final version of 
a project budget/EAC in the reports.  

Screens under Active Level Reports allow comparison between cost and a budget/EAC version or a 
budget/EAC version and another version if you select the new What If report type. 

Add Columns for Version Codes and Final Version Check Box on Project Budgets/EACs 

The Project Budgets / EACs screen has been updated to allow you to create multiple versions of a project 
budget/EAC and assign a code to each version you create. 

The following columns have been added to the screen: 

Column Description 

Version Code Enter, or click  to select, a version code you want to assign to the current version. 
The lookup displays version codes entered on the Manage Budget Version Codes 
screen. 

If the budget is imported from Excel, the version code defaults to N/A. 

Final Version Select this check box to mark the version as final. You must select one committed 
budget and EAC as final. If no version is marked as final, an error message displays 
and the record cannot be saved. 

Versions marked as final are included in reports. They are also integrated with an 
organization budget if your company uses the integrated method to calculate Org 
revenue. 

Note: The integrated method is in effect when Org Budget Revenue 
Calculation in Configuration Settings is not selected as Org Revenue 
Calculation. Contact your System Administrator for questions regarding this 
setting, which is configured during initial system setup and should not be 
changed. 
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Unlock Approved Project Budgets 

The Project Budgets / EACs screen has been updated to allow you to unlock and modify an approved 
budget without deleting versions created after that version. You can modify an approved budget/EAC by 
clearing the Approved check box and saving the record. The record you modified will have a Status of 
Complete, and a new version of that budget/EAC with a status of Working will be created. 

This update also allows you to create a new version of an approved budget based on a version created 
prior to the latest one. In contrast to the functionality before this enhancement where you can only create 
a new version based on the latest version of a budget/EAC, you can now select any version and click 
Create Bud or Create EAC to create a new version of that budget/EAC. 

Revenue Integration to Use Final Budget/EAC Versions 

The Revenue Integration screen has been updated to use the final version of a budget/EAC when you 
view, calculate, and approve, by project, the latest Estimate to Complete (ETC), Estimate at Completion 
(EAC), and the % Complete amounts. End Date is now a required field. 

The Version column has been added to the Projects and History subtasks. 

On the Projects subtask, when you click the Calculate button, the version number and version code of 
the budgets/EACs display in the Version column.  

When you click Approve and Upload on the Projects subtask, the History subtask is populated, and the 
version number and version code of the budgets/EACs display in the Version column on the History 
subtask as well. 

Updates to Project Budgeting Reporting 

Multiple updates have been applied to different reporting screens in the Project Budgeting module.  

Screens in the Top Level (All Projects) Reports, Level Down Reports, and Supplemental Reports 
application groups have been updated to use the final version of a project budget/EAC when you select 
Budget or Variance as the Report Type and you select Budget or EAC as the Budget Type. 

If you select Variance as the Report Type, the Source column, which contains the budget type, version 
number, and version code of the budget/EAC, displays on the subtasks of the report screens.  

Note, however, that not all updates were applied to all screens. Refer to the Notes column for information 
on which specific updates were applied to a screen. 

Screens affected in Project Budgeting » Top Level (All Projects) Reports: 

Screen Notes 

Direct Project Cost Categories  All updates were applied. 

Direct Project Cost All updates were applied. 

Labor Hours Analysis  All updates were applied. 

Labor Cost Analysis  All updates were applied. 

Budget/EAC Status  

 

Instead of the Source column, the Version column displays the 
version number and version code of a budget. 

Screens affected in Project Budgeting » Level Down Reports: 
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Screen Notes 

Project Cost Categories  All updates were applied. 

Project Cost All updates were applied. 

Level Down Projects Future 
Revenue  

Instead of the Source column, the Version column displays the 
version number and version code of a budget. 

Screens affected in Project Budgeting » Supplemental Reports: 

Screen Notes 

Project Budgets/EACs Status  This screen was updated to use only the final version of a budget / 
EAC. 

No other UI changes were applied. 

Project Status  No updates mentioned above were applied to this screen. 

Three new fields, Budget Type, Version Number, and Version 
Code, have been added to the Header subtask on this screen to 
display the type, version number, and version code of a project 
budget/EAC. 

The Budget ITD column on the Summary Detail subtask has been 
changed to Budget/EAC ITD. 

Screens in the Active Level Reports application group have also been updated to use the final version of 
a project budget/EAC when you select Budget or Variance as the Report Type and you select Budget 
or EAC as the Budget Type. 

In some screens, the What If option is now included in the Report Type group box, and the 
Comparisons group box that contains the Compare and with fields has been added. For example: 

 

Select the What If option if you want to compare the actual cost of a project to a budget/EAC version, or 
to compare one budget/EAC version to another version. If you select What If, the fields under 
Comparisons are enabled, and the versions you want to compare display on the subtasks. 

In the Compare and with fields, enter, or click  to select, the actual cost or the budget/EAC of a 
project that you want to compare. 
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The Source column displays on the subtasks of a report screen and displays the version number and 
version code of a budget/EAC if: 

 The Report Type is Variance. 

 The Report Type is Budget and you select the Combined check box for a result set. 

 The Report Type is What If. 

Note, however, that not all updates were applied to all screens. Refer to the Notes column for information 
on which specific updates were applied to a screen. 

Screens affected in Project Budgeting » Active Level Reports: 

Screen Notes 

Hours Breakdown  All updates were applied. 

Raw Cost Breakdown  All updates were applied. 

Burdened Cost Breakdown  All updates were applied. 

All Cost Breakdown  All updates were applied. 

T&M Billable Revenue 
Breakdown  

This screen was updated to use only the final version of a budget / 
EAC. 

No other UI changes were applied. 

T&M Labor Analysis  All updates were applied, but instead of the Source column, the 
Description column displays the version number and version code 
of a budget. 

T&M Budget Review This screen was updated to use only the final version of a budget / 
EAC. 

No other UI changes were applied. 

Revenue Breakdown This screen was updated to use only the final version of a budget / 
EAC. 

No other UI changes were applied. 

Current Forecast This screen was updated to use only the final version of a budget / 
EAC. 

No other UI changes were applied. 

Revenue Analysis  This screen was updated to use only the final version of a budget / 
EAC. 

No other UI changes were applied. 
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Related Updates in Costpoint Projects 
Since the Manage User-Defined Information screen and the User-Defined Info subtask that have been 
added in Costpoint Planning are based on the same screens in the Projects domain, you can enter user-
defined information in Projects » Project Setup » Project Master » Manage User-Defined Information 
or on the User-Defined Info subtask in Projects » Project Setup » Project Master » Manage Project 
User Flow. These records will then become available for use in New Business Budgeting » Controls 
and Utilities » Manage User-Defined Information and on the User-Defined Info subtask in New 
Business Budgeting » Actions/Processing » New Business Budgets. 

However, if you enter new user-defined information in Manage User-Defined Information and on the User-
Defined Info subtask in New Business Budgets in Costpoint Planning and the new business has the same 
ID as a project in the Projects domain, the user-defined information you entered for the new business will 
not be displayed and will not be usable in the Projects domain.  

This update is done to ensure that no existing project will be modified when you enter new user-defined 
information in Costpoint Planning. 

Resource Planning Task Reassignment and Rescheduling  
The Budget By Resource application was enhanced to enable you to: 

 Reschedule the start and end dates of an assignment for a selected resource.  

 Reassign budgeted hours from one resource to another resource for an entire period or specific 
date range. 

This functionality was implemented through the addition of a new Assignment Actions dialog box, which is 
accessible after you: 

1. Open the resource record in the Budget Resource Planning application. 

2. Select the record in the Selected Resources table, and select the resource. 

3. Click Add/Edit/Delete Assignments. 

4. Select the row that contains the hours you want to reschedule or reassign. 

5. Click Action in the Reassign Reschedule column. 

In the Assignment Actions dialog box, use the Reschedule tab to change the assignment dates for the 
selected resource, and use the Reassign tab to assign the hours to a different resource.  

In the Reschedule tab, you can only enter the new dates in the Reschedule Start Date. The Reschedule 
End Date is calculated using the same period of time in the original assignment dates. If you move the 
reschedule start date a year forward, the reschedule end date will also move a year forward.  
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After entering the new dates, click Reschedule to change the assignment dates. 

 

Click the Reassign tab to assign the budgeted hours to a different resource. You can only select the same 
Resource Type as the current selection. If the current assignment is to an Employee, then only 
Employees can be selected in the Resource Type. 

 

To view the existing assignment of the selected resource, click the Current Assignments subtask. 

 

For more information on the Reschedule/Reassign functionality, see the online help for this application. 
Click Planning » Resource Planning » Budget Resource Planning. 
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Update to Excel Uploads 
Previously, the Excel upload option found in the Import Budget/EACs from Excel and Import New 
Business Budgets from Excel applications used an Upload File button which cannot be used with Web 
Services. 

For this release, the Upload File action button and the Error Report & Upload Report subtasks were 
removed to adhere to web services requirement and further improve the Excel upload process. 

A Parameter ID was added to the form so you can set the criteria and use it to retrieve a previously 
saved parameter ID which represents a set of screen selection parameters. You can use the retrieved 
parameters to produce reports and run processes more efficiently and with greater consistency. 

You need to click the Validate Input File option from the Process/Gear toolbar to review the budget 
before uploading it. An error report will be generated which you can use as a guide to correct your original 
entries in the Excel template, 

For more details, see the Costpoint Planning help topic on Import Budget/EACs from Excel Process 
Overview and Import New Business Budgets from Excel Process Overview. 

Other Updates to New Business Budgeting  

Employee Schedule Subtask 
New Business Budgeting was updated to include the Employee Schedule subtask, which Project Budget 
Analysts can use to view all the projects to which an employee is currently budgeted, including total 
scheduled hours and total remaining hours. To display the employee schedule subtask, click Planning » 
New Business Budgeting » Actions/Processing » New Business Budgets, and then click the Hours 
subtask. 

 

Multi-New Business Budget Consolidation (Revenue/Cost) 
Multi-Proposal Consolidation (Rev/Cost) was renamed to Multi-New Business Budget Consolidation 
(Revenue/Cost), and it was also updated with additional functionality. 

Use this application to specify individual new business budgets to be reported as part of a consolidation 
project revenue and/or cost report. The report runs a consolidated single report based on the new 
business budgets that you have selected. 

Grouping Description 

You can now name the group of New Business Budgets that you have selected and save it for future use. 

Enter the group description in the Grouping Description field and click Save Group to save the group 
description for future lookup to review the same grouping.   

When you return to this application, you can search the group name and select the group. Use the lookup 
in the Grouping Description field to find the group and click Select Group to populate the result set. The 
result set will display all New Business Budgets, but those in the group will be highlighted by row. You 
can select additional New Business Budgets and add them to the Group by clicking Save Group. 

Click Delete Group to remove the group from the Grouping Description selection. 

Note: The Employee Schedule subtask only displays if the New Business Budget has a Working 
status. For subcontractor hours and consulting hours, only total available hours by period are 
displayed without the deduction of scheduled hours. 
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All Cost Breakdown Subtask 

After you have selected your budgets, click the All Cost Breakdown subtask to review the summarized 
cost categories. You can drill down to find the GL accounts and which New Business Budget the data is 
coming from. All periods in the budgeted start and end dates are also displayed. 

To access the Multi-New Business Budget Consolidation (Revenue/Cost) application, click Planning » 
New Business Budgeting » Reports/Inquiries » Multi-New Business Budget Consolidation 
(Revenue/Cost). 

Structured New Business Budget Summary (Revenue/Cost) 
Structured Proposal Summary (Rev/Cost) was renamed to Structured New Business Budget Summary 
(Revenue/Cost), and it was also updated with additional functionality. 

Use this application to run a report that displays cost or revenue amounts on individual New Business 
Budgets within a selected period of performance. All completed budgets regardless of work type, whether 
Proposal, Work Type, or Add On, are displayed. Hours and Amounts in the New Business Budgets 
display in the Structured New Business Budget Summary as amounts. 

All Cost Breakdown Subtask 

Use the All Cost Breakdown subtask to view summary rows by cost category, description, and total 
budget with the ability to drill down to the G/L Account and resource. 

To access the Structured New Business Budget Summary (Revenue/Cost) application, click Planning » 
New Business Budgeting » Reports/Inquiries » Structured New Business Budget Summary 
(Revenue/Cost). 

Project Budgeting Usability Improvements 
This section describes multiple enhancements made to areas within Project Budgeting. These 
enhancements were implemented to improve general usability. 

Delete Historical EACs 
The Delete Historic Project EACs screen has been added in Planning » Administration » 
Administration Utilities. Use this screen to simultaneously delete multiple versions of project EACs.  

This screen only deletes approved, complete, and incomplete EAC versions that are not marked as final. 

You can choose between two methods of deleting historic EAC versions: 

 Delete by Version: Select this option to delete the earlier versions of project EACs. If you select 
this option, historic EAC versions under all organizations and projects will be deleted, and you 
must enter the number of most recent EAC versions you want to keep in the Keep the latest __ 
EAC versions, delete prior versions field. For example, if you enter 2, Costpoint will keep the 
two most recent versions of the EACs and will delete any prior version. 

 Delete by Date On or Before: Select this option to delete versions of project EACs by date. You 
must specify if you want to delete project EAC versions based on their creation date or closed 
period date. If you select this option, you can select all, one, or a range of organizations or 
projects where you want historic EAC versions to be deleted. 

Once you enter the criteria for deletion, you can view the EACs to be deleted on the Preview subtask. 

You can run this screen any time or enter parameters for it to run on a scheduled time using the Costpoint 
Job Management applications. 
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Hide Historic Project Budgets/EACs 
The Configuration Settings and Project Budgets / EACs screens have been updated to allow you to hide 
historic versions of project budgets/EACs. 

Configuration Settings 

The Enable Project “Hide Bud/EAC” check box has been added to the Project tab on the Configuration 
Settings screen. Select this check box to enable the hiding of historic project budget or EAC versions on 
the Project Budgets / EACs screen.  

Project Budgets / EACs 

The following have been added to the Project Budgets / EACs screen:  

 Hide Bud/EAC column 

 Hide button 

 Unhide button  

These only display if the Enable Project “Hide Bud/EAC” check box is selected on the Configuration 
Settings screen. 

To hide a budget or EAC version, select the Hide Bud/EAC check box for that record and click Hide to 
hide the record immediately. Otherwise, if you don’t click Hide, those records that have their Hide 

Bud/EAC check box selected will be hidden when you click . 

Note that you can only hide approved project budget/EAC versions that are not marked as final.  

To view hidden records, click Unhide. When hidden records display, their Hide Bud/EAC check box will 
still be selected. You can then clear the Hide Bud/EAC check box if you want that record to remain 
unhidden when you reopen the Project Budgets / EACs screen. 

Only Show Projects with Budgets/EACs  
The Configuration Settings and Project Budgets / EACs screens have been updated to allow you to only 
display projects that have existing budgets/EACs. 

Configuration Settings  

The Show Budget/EAC Only Default check box has been added to the Project tab on the Configuration 
Settings screen. Select this check box to display, by default, only the projects that have an existing 
budget/EAC when you open the Project Budgets / EACs screen. Otherwise, clear this check box to 
display all projects. 

Project Budgets / EACs  

The Show Budget/EAC Only check box has been added to the Project Budgets / EACs screen. Use this 
to override the default setting in Configuration Settings. If Show Budget/EAC Only Default is selected in 
Configuration Settings, the Show Budget/EAC Only check box is also selected by default, and only 
projects with an existing budget/EAC display on the screen. You can clear the check box to display all 
projects.  

In contrast, if Show Budget/EAC Only Default is cleared in Configuration Settings, the Show 
Budget/EAC Only check box is cleared by default as well, and all projects display. Select the check box 
to display projects that have an existing budget/EAC. 
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Hide Budget Data Entry Rows 
The Configuration Settings and Project Budgets / EACs screens have been updated to allow you to hide 
budget/EAC rows on data entry subtasks on the Project Budgets / EACs screen. 

Configuration Settings 

The Check the Project Budget "Enable Subtask Row Hide" option by default check box has been 
added to the Project tab on the Configuration Settings screen. Select this check box to enable, by default, 
the ability to hide project budget or EAC rows on data entry subtasks on the Project Budgets / EACs 
screen. Otherwise, clear this check box to display all budget/EAC rows. 

Project Budgets / EACs 

The Enable Subtask Row Hide check box has been added to the Project Budgets / EACs screen. 

Use this to override the default setting in Configuration Settings. If Project Budget "Enable Subtask 
Row Hide" option by default is selected in Configuration Settings, the Enable Subtask Row Hide 
check box is also selected by default. You can clear it to display all project budget/EAC resources. 

In contrast, if Project Budget "Enable Subtask Row Hide" option by default is cleared in Configuration 
Settings, the Enable Subtask Row Hide check box is cleared by default as well. Select it to hide the 
resources assigned to a budget or EAC. 

Note that you can only hide rows assigned to project budget/EAC versions that have a Working status.  

A new column, Hide Row, and the Hide and Unhide buttons have been added to the following subtasks 
on the Project Budgets / EACs screen: 

 Staff Hours 

 Staff Escalation 

 Materials 

 Subcontractor 

 Material Handling 

 Travel 

 Consultant 

 Other Direct Costs 

 Subcontractor Hours 

 Consultant Hours 

The Hide Row column and the Hide and Unhide buttons only display if you select the Enable Subtask 
Row Hide check box. 

To hide a budget or EAC resource, select the Hide Row check box for that record and click Hide to hide 
the record immediately. Otherwise, if you don’t click Hide, those records that have their Hide Row check 

box selected will be hidden when you click . 

To view hidden records, click Unhide. When hidden records display, their Hide Row check box will still 
be selected. You can then clear the Hide Row check box if you want that record to remain unhidden 
when you reopen the Project Budgets / EACs screen. 
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New Percent Complete Revenue Calculation  
Project Budgeting now includes a new percent complete revenue calculation that can determine 
forecasted revenue for projects with revenue formulas of EAC, ETC, or % complete.  

 

Calculation Method 

For the formula to work, you will need to enter all project costs across a period of performance. It can be 
used for budgets or EACs, and can be based off either the Contract Value or Funded Value. 

For budgets without EACs, the revenue calculation is: 

1. Budgeted Costs including Burden for each Budgeted period CTD / Total Budgeted Costs with 
Burden [Estimate At Completion] = % complete for each FY/Pds. 

2. The % complete x Total Contract Value* = Revenue Budget to Date. 

3. Revenue Budget to Date less previous period Revenue Budget to Date = Current Period 
Revenue. 

*Substitute Funded Value as appropriate. 

For budgets with EACs, the revenue calculation is: 

1. (Total Planning EAC [actual] Costs CTD + Budgeted Costs including Burden for each 
Budgeted period CTD) / (Total Budget EAC costs [actuals] + future period Budgeted Costs 
including Burden [ETC]) = % complete for each future FY/Pds. 

2. The % complete x Total Contract Value = Revenue Budget to Date. 

3. Revenue Budget to Date less previous period Revenue Budget to Date = Current Period 
Revenue. 

*Substitute Funded Value as appropriate. 

For example, in reports and report subtasks that show the Burdened Cost and All Periods, the calculation 
would be as follows by period: 

 

Affected Reports 

The results of the revenue formula can be viewed in the following reports: 

 Project Budgeting » Level Down Reports » Level Down Projects Future Revenue » 
Revenue Breakdown 

 Project Budgeting » Active Level Reports: 

Note: See “Glossary of Terms” below for definitions of all acronyms used in these release notes. 
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 Current Forecast  

 Revenue Breakdown  

 Revenue Analysis  

Glossary of Terms 

The table below defines each of the acronyms used in the formula descriptions above.  

Acronym Definition 

CTD This stands for Costs Contract to Date. 

ETC This stands for Costs Estimate to Completion. It is the total of budgeted costs in 
future periods. 

EAC This stands for Costs Estimate at Completion.  

An EAC is a planning forecast.  

It is the total of all budget costs or combination of past actual costs plus future 
budget period costs when using the Planning EACs 

Employee Labor Rates 
Employee Labor Rates are now displayed in Project Budgeting, New Business Budgets, and Resource 
Planning. You can now view the Hr Rate or the hourly labor rate of the employee based on the current 
period of the budget. The Hr Rate column can be found under the Staff Escalation subtask, Staff Hours 
subtask, and Add/Edit/Delete Assignment subtask. 
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A new field was added to the Project tab of Configuration Settings so you have the option to set the Hr 
Rate to display or not. 

Field Description Notes/Choices Decision/Admin 
Instructions 

If Labor Suppression 
is off, do you want to 
show Employee Labor 
Rate Planning? 

This field controls 
whether the Hr Rate of 
the employee will be 
displayed or not when 
Labor suppression is 
set to OFF.  

Note: By default, the Hr 
Rate is displayed when 
Labor Suppression in 
Manage Users is set to 
OFF. When Labor 
Suppression is set to 
ON the Hr Rate is not 
displayed. 

Select Yes to display 
the Hr Rate even if 
Labor Suppression is 
set to OFF, or select 
No to hide the Hr Rate 
when Labor 
Suppression is set to 
OFF. 

Yes or No 

To change this setting, 
click Planning » 
Administration » 
System Security » 
Manage Users. 

Ability to Upload from Excel Removed 
As part of the Project Budgeting usability enhancement, the ability to Import from Microsoft Excel was 
removed from the Import Budget/EAC from Scheduling App. 

All options and references related to uploading from MS Excel were excluded from the screen. 

You can now directly upload from MS Excel using the Import Budget/EACs from Excel screen and no 
longer need to go to the Import Budget/EAC from Scheduling App. 
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People/Regulatory 
This section describes Costpoint 8.0 enhancements for the People domain and Regulatory updates. 

Support for Life/Supplemental Life Guaranteed Issue and Evidence 
of Insurability  
Life, accidental death and dismemberment (AD&D), disability and supplemental insurance plans often 
cover individuals only up to a specific amount (guaranteed issue amount) unless the covered individual 
provides Evidence of Insurability (EOI). An EOI is normally a health questionnaire that insurance 
companies use to verify if a person meets the definition of good health. 

This Costpoint enhancement provides you with the following: 

 Tracking of coverage options that need EOI based on user-defined criteria  

 Tracking of the status of the employee’s EOI approval 

 Ability to view all EOIs for an employee or an employee’s spouse 

The Manage Benefit Plans screen now has a flag to indicate if an EOI is required. If it is required, the 
application enables a separate EOI tab with EOI criteria and supporting fields. The benefit election will 
have an EOI status field that will show either:   

 Not Required 

 Required 

 Denied 

 Approved 

On the Activate Pending Benefit Elections screen, if a missing election benefit plan requires an EOI or the 
new election EOI status is Required, Denied or Approved, the application will insert that coverage 
option into a new application, Manage Employee Evidence of Insurability (EOI).  

 

If the employee’s new election EOI Status is Denied, Required or Approved, the application implements 
the substitution rule selected on the Manage Benefit Plans screen. The rule will be one of the following: 

 Extend the employee’s original election. 

 Assign no coverage. 

 Assign a coverage option with the highest coverage amount not requiring an EOI.  

 

The intention of extending the original election is to ensure that the employee or their spouse is covered 
with their previous insurance until such time as the EOI is approved and their new insurance can take 
effect. The new coverage will start when the EOI is approved, and this will not be retroactive. 

Note: New elections that have an EOI status of Not Required are also transferred to the Manage 
Employee Evidence of Insurability (EOI) screen to keep track of all EOI transactions. 

Note: For elections with Approved EOI statuses, the rule is applied only from the coverage start date 
until the EOI approval date. 

For a new election with an Approved EOI Status, the substitution will be applied only when EOI 
Received Date is after the coverage start date. This only applies to elections with Life Event as the 
Enrollment Method. 
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Costpoint also provides you with a new process, Process Employee EOI Benefit Elections, which will end 
the original coverage option and activate the employee’s initially selected coverage option with a start 
date of the EOI approval. This new process also applies the substitution rules from the Manage Benefit 
Plans screen on elections with EOI that has not been approved.  

Other additional Costpoint changes for this enhancement include the following 

 The Life Events/New Hires screen and Benefits Enrollment screen in Costpoint Employee Self 
Service (ESS) display the EOI Status and EOI Form URL/Location for the following Benefit 
Types:  

 Life Insurance 

 AD&D Insurance 

 Long Term Disability 

 Short Term Disability 

 Supplemental Life Insurance 

 Supplemental AD&D Insurance 

 Spouse Life Insurance 

 Spouse AD&D Insurance 

 Coverage Amounts will be added to the Employee ESS Elections and Employee Life Event 
Elections tables and saved during those processes in ESS for those same applications listed 
above. 

 Coverage Amounts will be added on the Manage Employee Evidence of Insurability (EOI) screen 
in order to be able to easily compare the coverage amounts from year to year. It will only be 
visible in Manage Employee Evidence of Insurability (EOI). 

 

Manage Benefit Plans (HBMBPSET) 
The Coverage Options subtask provides the following new fields: 

Field Description 

Coverage Limit 

 

Enter the coverage limit for the plan. If this field is enabled, the application 
automatically sets the value in this field to 999,999,999,999,999.00. 

This field is enabled if the Coverage Calculation Method is Factor or 
Coverage Table; Coverage Table is Salary; and the System Benefit Type is 
one of the following: 

 Life Insurance 

 AD&D Insurance 

 Long Term Disability 

 Short Term Disability 

 Supplemental Life Insurance 

Attention: For more information on the EOI functionality in Costpoint, please refer to the Costpoint 
Evidence of Insurability Quick Steps.  
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Field Description 

 Supplemental AD&D Insurance 

 Dependent Life Insurance 

 Spouse Life Insurance 

 Spouse AD&D Insurance 

 Other  

You can update the Coverage Limit if needed. 

This field is disabled if the Coverage Calculation Method is Amount or 
Coverage Table and the Coverage Table is Age. When this is disabled, the 
value is set to 999,999,999,999,999.00. 

The Enrollment/Coverage Rules tab provides the following new/updated fields: 

Field Description 

Require HR 
Approval in ESS 

 

This existing field was previously labeled as “Requires Approval.” 

Select this check box if the plan requires approval before it is effective. 

Evidence of 
Insurability 
Required 

Select this check box if Evidence of Insurability is needed for the benefit plan.  

If you select this check box, use the EOI Rules tab to specify the following:  

 Conditions which will require the employee or his/her spouse to provide 
Evidence of Insurability 

 Steps that should occur if the employee or spouse is denied coverage 
or is pending coverage 

If you select this check box for a benefit plan, you will not be able to assign the 
plan to an employee on the Manage Employee Benefit Elections table. Instead, 
you will have to enter a record into the Manage Employee Evidence of 
Insurability (EOI) screen, which determines if the employee’s calculated 
coverage amount requires evidence of insurability (EOI) and, if so, you will be 
able to approve or deny the coverage amount.  

 

In cases of denial or pending coverage, the Substitution Rules you specify on 
the EOI Rules tab of the Manage Benefit Plans screen will be used to determine 
the coverage amount, if any, for which the employee is eligible. 

This check box is only available if the System Benefit Type is one of the 
following:  

 Life Insurance 

Note: If this check box is selected but the coverage option is NO CVG (no 
coverage), it should be assigned to the employee on the Manage 
Employee Benefit Elections screen. The NO CVG coverage option cannot 
be assigned on the Manage Employee Evidence of Insurability (EOI) 
screen. 
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Field Description 

 AD&D Insurance 

 Long Term Disability 

 Short Term Disability 

 Supplemental Life Insurance 

 Supplemental AD&D Insurance 

 Spouse Life Insurance 

 Spouse AD&D Insurance 

The EOI Rules tab provides the following new fields: 

Field Description 

New 
Employee/New 
Benefit Plan group 
box 

The rules in this group box apply to new employees that elect the benefit plan. If 
the elected coverage amount exceeds the specified threshold amount, EOI will 
be required for the employee, or spouse for spousal coverage. 

An employee is considered “new” if both the following are true: 

 The start date of the new coverage is before or the same as the 
employee’s new hire period. The new hire period is based on the 
employee’s Current Hire Date from the Manage Employee Information 
screen and the Number of days that employees are classified as 
new employees value on the Configure Benefit Settings screen. 

 The employee does not have a record on the Employee Benefits 
Elections table where: 

 The end date is after or the same as the employee’s Current Hire 
Date on the Manage Employee Information screen. 

 The coverage option code is not NO CVG. 

This group box contains the following fields: 

 Over the guarantee issue limit of: Select this check box to require 
EOI if a new or rehired employee elects the benefit plan for the first time 
and the coverage amount is over the guarantee issue limit you specify. 

 Guarantee Issue Limit Amount: Enter the guarantee issue limit to be 
used as a threshold for requiring EOI for new employees electing a new 
benefit plan. If the coverage amount is less than or equal to the 
guarantee issue limit, the EOI will not be required. If the coverage 
amount is greater than the guarantee issue limit, EOI will be required. 

Existing 
Employee/New 
Benefit Plan group 
box 

The rules in this group box apply to existing employees that elect the benefit 
plan for the first time or re-elect the benefit plan after a break in coverage. If the 
elected coverage amount exceeds any of the selected threshold amounts, EOI 
will be required for the employee (or spouse for spousal coverage). 

An employee is considered as “existing” if either of the following are true: 

 The start date of the new coverage is after the employee’s new hire 
period. The new hire period is based on the employee’s Current Hire 
Date from the Manage Employee Information screen and the Number 
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Field Description 

of days that employees are classified as new employees value on 
the Configure Benefit Settings screen.  

 The employee does have a record on the Employee Benefit Elections 
table where: 

 The end date is after or the same as the employee’s Current Hire 
Date on the Manage Employee Information screen. 

 The coverage option code is not NO CVG. 

This group box contains the following fields: 

 Any amount: Select this check box to require EOI when: 

 An existing employee elects the benefit plan for the first time. 

 An existing employee elects the benefit plan after a break in 
coverage. 

EOI will be required regardless of the coverage amount elected. 

If you select this check box, the other Existing Employee/New Benefit 
Plan check box options become cleared and disabled. 

 Over the guarantee issue limit of: Select this check box to require 
EOI when an existing employee elects the benefit plan for the first time 
or after a break in coverage and the coverage amount is greater than 
the guarantee issue limit.  

 Guarantee Issue Limit Amount: Enter the guarantee issue limit to be 
used as a threshold for requiring EOI for existing employees electing 
this benefit plan for the first time or after a break in coverage. If the 
coverage amount is less than or equal to the guarantee issue limit, EOI 
will not be required. If the coverage amount is greater than the 
guarantee issue limit, EOI will be required. 

 Greater than the employee’s salary multiplied by a factor of: Select 
this check box to require EOI when an existing employee elects the 
benefit plan for the first time or after a break in coverage and the 
coverage amount is greater than the product of the employee’s annual 
salary multiplied by a factor.  

 Factor: Enter the factor by which the employee’s annual salary is 
multiplied to determine the amount which will trigger the need for EOI. 

Note: Even if EOI is not required based on the Salary multiple, it 
may be required based on the other Existing Employee/New 
Benefit Plan EOI requirement rules. 

Note: Even if EOI is not required based on the guarantee issue limit, 
it may be required based on the other Existing Employee/New 
Benefit Plan EOI requirement rules. 
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Field Description 

Existing 
Employee/Same 
Benefit Plan group 
box 

The rules in this group box apply to existing employees that are currently 
covered by the benefit plan but opt to change their coverage amount.  

An employee is considered as “existing” if either of the following are true: 

 The start date of the new coverage is after the employee’s new hire 
period. The new hire period is based on the employee’s Current Hire 
Date from the Manage Employee Information screen and the Number 
of days that employees are classified as new employees value on 
the Configure Benefit Settings screen.  

 The employee does have a record on the Employee Benefit Elections 
table where: 

 The end date is after or the same as the employee’s Current Hire 
Date on the Manage Employee Information screen. 

 The coverage option code is not NO CVG. 

This group box contains the following fields:  

 Increased by any amount: Select this check box to require EOI for the 
employee, or spouse for spousal coverage, when an existing employee 
is already covered by the benefit plan but increases the coverage 
amount. EOI will not be required if the employee re-elects the same 
benefit plan and coverage amount. 

If this check box is selected, the other options in the Existing 
Employee/Same Benefit Plan group box becomes cleared and 
disabled. 

 Increased by the following amount: Select this check box to require 
EOI when an existing employee elects the same benefit plan and the 
coverage amount increase is greater than the increase limit you specify. 

For example, you have the following setup: 

 You specify an increase amount threshold of 10,000. 

 The employee currently has Supplemental Life Insurance coverage 
of $200,000. 

 The employee elects a coverage amount of $215,000 during open 
enrollment. 

In this scenario, the EOI would be required because the increase in 
coverage (15,000) exceeds the 10,000 threshold. 

Note: Even if EOI is not required based on the coverage increase limit, 
it may be required based on the other Existing Employee/Same 
Benefit Plan EOI requirement rules. 

 Increased by Amount: Enter the coverage amount increment that will 
require the need for EOI. EOI will be required if an existing employee 
elects to increase the coverage amount and the increase amount is 
greater than the amount you specify. 
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Field Description 

 Over the guarantee issue limit of: Select this check box to require 
EOI when an existing employee elects the same benefit plan and the 
coverage amount is greater than the guarantee issue limit.  

Note: Even if EOI is not required based on the guarantee issue limit, it 
may be required based on the other Existing Employee/Same Benefit 
Plan EOI requirement rules. 

When you select this check box, the employee requires an EOI if the 
employee currently has this coverage and the coverage amount is over 
the specified limit. 

 Guarantee Issue Limit Amount: Enter the guarantee issue limit to be 
used as a threshold for requiring EOI for existing employees that re-
elect this benefit plan and increase the coverage to an amount that is 
over the guarantee issue limit. If the new coverage amount is less than 
or equal to the guarantee issue limit, EOI will not be required. If the 
coverage amount is greater than the guarantee issue limit, EOI will be 
required. 

 Greater than the employee’s salary multiplied by a factor of: Select 
this check box to require EOI when an existing employee elects the 
same Benefit Plan but increases the coverage to an amount that is 
greater than the product of the employee’s annual salary multiplied by a 
factor.  

Note: Even if EOI is not required based on the Salary multiple, it may 
be required based on the other Existing Employee/Same Benefit Plan 
EOI requirement rules. 

 Factor: Enter the factor by which the employee’s salary is multiplied to 
determine the amount which will trigger the need for EOI. 

Substitution Rules 
group box 

Select the substitution rule you would like to apply if the employee elects a new 
or same benefit plan with a coverage amount requires EOI, but the EOI is still 
pending or was denied. 

If EOI Status is Required, Denied Or Approved, substitute coverage as 
follows: 

 New Benefit Plan: Select the substitution rule if you elected a new 
benefit plan. The options are: 

 Highest coverage amount without requiring an EOI: Select this 
option to assign an employee the highest coverage amount which 
does not require EOI when you run the Activate Pending Benefit 
Elections or Process Employee EOI Benefit Elections application. 
Any existing coverage for that period will be deleted/ended. 

 No coverage: If you select this option and a coverage option of NO 
CVG exists for the Benefit Plan, the application assigns a NO CVG 
coverage option to the employee. Otherwise, if NO CVG coverage 
option does not exist for the benefit plan, the employee will have no 
election row generated in Manage Employee Benefit Elections for 
the coverage period. Any existing coverage for that period will be 
deleted/ended. 
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Field Description 

 Same Benefit Plan: Select the substitution rule for if you elected the 
same benefit plans. The options are: 

 Highest coverage amount without requiring an EOI: Select this 
option to assign an employee the highest coverage amount which 
does not require EOI when you run the Activate Pending Benefit 
Elections or Process Employee EOI Benefit Elections application. 
Any existing coverage for that period will be deleted/ended.  

 Extend the current coverage option: Select this option to extend 
the employee’s existing coverage option to the end of the coverage 
period. 

 No coverage: If you select this option and a coverage option of NO 
CVG exists for the Benefit Plan, the application assigns a NO CVG 
coverage option to the employee. Otherwise, if NO CVG does not 
exist for the benefit plan, the employee will have no election row 
generated in Manage Employee Benefit Elections for the coverage 
period. Any existing coverage for that period will be deleted/ended. 

EOI Form 
URL/Location 
(data field) 

Enter the URL or network file location for the EOI form that the user must fill out. 
This field is only available if the Evidence of Insurability Required check box 
is selected on the Enrollment/Coverage Rules tab of this screen. 

Manage Employee Evidence of Insurability (EOI) (EMMEEOI) 
Use the Manage Employee Evidence of Insurability (EOI) screen to view or change the EOI status of 
employees’ coverage options. 

This application will be updated through Activate Pending Benefit Elections (AOPESSUE).  

You can add records in this application for benefit plans that may require an EOI. You can also change 
the EOI status and add an EOI date and EOI document location. 

 

When the EOI is approved for employee/spousal coverage, use the Process Employee EOI Benefit 
Elections screen to add the benefit elections to their respective tables: Employee benefit election will be 
added to the Manage Employee Benefit Elections screen, and the spousal benefit elections will be added 
to the Assign Dependents to Benefit Plans screen. 

To access this new screen, click People » Employee » Employee Benefit Information » Manage 
Employee Evidence of Insurability (EOI). 

The screen provides the following fields. 

Field Description 

Employee Enter, or click  to select, the ID of the employee that elected coverage. 

Employee Name This field displays the employee’s last and first names. 

Note: When you add records for spousal coverage, you can enter one record for the employee with 
the spousal coverage option and the dependent ID. Costpoint will automatically add the DEP CVG 
option for the employee after you run the Process Employee EOI Benefit Elections (EOI) application. 
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Field Description 

Taxable Entity This field displays the taxable entity for the employee. 

Record Source This field displays the screen where the record was created and can be either 
of the following: 

 Activate Pending Benefit Elections 

 Manage Employee Evidence of Insurability (EOI) 

Benefit Package Enter, or click  to select, the employee’s benefit package. The benefit plan 
and coverage option elected by the employee must be assigned to the benefit 
package. 

Benefit Plan Enter, or click  to select, the benefit plan elected by the employee. The 
System Benefit Type of the benefit plan must be one of the following:  

 Life Insurance 

 AD&D Insurance 

 Long Term Disability 

 Short Term Disability 

 Supplemental Life Insurance 

 Supplemental AD&D Insurance 

 Spouse Life Insurance 

 Spouse AD&D Insurance 

Coverage Option Enter, or click  to select, the coverage option for which the EOI is required. 

Spouse If applicable, enter, or click  to select, the spouse for which the coverage 
was elected. You must set up this person on the Manage Employee 
Dependents/Beneficiaries screen with a Relationship to Employee value of 
Husband or Wife. 

Start Date This field displays the start date for the coverage option. 

End Date This field displays the end date for the coverage option. 

Coverage Amount This field displays the coverage amount for the coverage option. 

Coverage Limit This field displays the monetary coverage limit of the EOI, if applicable. 

Enrollment Method From the drop-down list, select the enrollment for the coverage option. Valid 
values are: 

 Open Enrollment 

 Life Event 
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Field Description 

Life Event Enter, or click  to select, the life event used for the enrollment method for 
the benefit election. 

EOI Status From the drop-down field, select Approved or Denied as the employee’s 
Evidence of Insurability (EOI) status. 

Valid values in this field are:  

 Not Required: This status indicates that the employee or spouse 
does not need to provide EOI before coverage can begin. If this status 
is assigned to the coverage, Costpoint’s Process Employee EOI 
Benefit Elections application will assign the coverage to the employee 
and/or spouse. 

 Required: This status indicates that the employee or spouse still 
needs to provide EOI before coverage can begin. If this status is 
assigned to the coverage, the Process Employee EOI Benefit 
Elections application will apply the following: 

 The elected coverage will not be assigned to the employee and/or 
spouse. 

 If the benefit plan setup has a Substitution Rule of Highest 
coverage amount without requiring an EOI, the coverage 
option with the highest coverage amount that does not require EOI 
will be assigned to the employee or spouse 

 If the benefit plan has a Substitution Rule of Extend the current 
coverage, the employee’s and/or spouse’s existing coverage 
dates will not be altered. 

 If the benefit plan has a Substitution Rule of No coverage, the 
employee’s and/or spouse’s existing coverage will be assigned an 
end date that is one day before the screen coverage start date. 

 Approved: This status indicates that the employee or spouse 
provided the required EOI and is eligible for the specified coverage. If 
this status is assigned to the coverage, the Process Employee EOI 
Benefit Elections application will assign the coverage to the employee 
and/or spouse. 

 Denied: This status indicates that the employee or spouse was 
deemed ineligible for the specified coverage. If this status is assigned 
to the coverage, the Process Employee EOI Benefit Elections 
application will not assign the coverage to the employee and/or 
spouse, and Costpoint will use the benefit plan’s Substitution Rule to 
determine whether: 

 The employee/spouse will be assigned the highest coverage that 
does not require EOI. 

 The employee/spouse will have their coverage extended. 

 The employee/spouse will have their existing coverage 
discontinued. 

 No action will be taken. 
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Field Description 

EOI Received Date Enter, or click  to select, the date the EOI document was received by the 
Human Resources department. 

EOI Document If applicable, enter the network location and document name of for the 
employee’s EOI.  

Coverage Option 
Substituted 
because of EOI 
Status = Denied or 
Required 

This display-only check box indicates whether or not the record has been 
processed through the Process Employee EOI Benefit Elections screen or 
Activate Pending Benefit Elections screen. 

Benefit Election 
Uploaded 

This display-only check box indicates whether or not the employee’s elected 
coverage option was processed through the Process Employee EOI Benefit 
Elections screen or the Activate Pending Benefit Elections screen and the 
election was assigned to the employee and/or spouse. 

If this check box is selected, it indicates one of the following: 

 The coverage amount elected by the employee required EOI. It was 
then approved and the election was uploaded to the Manage 
Employee Benefit Elections table. 

 The spousal coverage amount elected by the employee required EOI. 
It was then approved and the election was uploaded to the Assign 
Dependents to Benefit Plans table 

 The coverage amount elected by the employee did not require EOI 
based on the benefit plan’s EOI rules. As a result, the election was 
uploaded to the Manage Employee Benefit Elections table. 

 The spousal coverage amount elected by the employee did not require 
EOI based on the benefit plan’s EOI rules. As a result, the election 
was uploaded to the Assign Dependents to Benefit Plans table. 

Process Employee EOI Benefit Elections (EMPEEOI) 
Use the Process Employee EOI Benefit Elections screen to add any benefit elections that were pending 
approval of the EOI to the Manage Employee Benefit Election screen and Assign Dependents to Benefit 
Plans screen. 

To access this new screen, click People » Employee » Employee Benefit Information » Process 
Employee EOI Benefit Elections. 

The following fields are available on this screen. 

Field Description 

Parameter ID Enter the ID code for saved parameter. The description of the parameter ID 
displays in the adjacent field. 

Through Effective 
Date 

Use the following fields to select the effective date range: 
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Field Description 

 Option: This field displays One since you can only select one effective 
date. 

 Start: Enter, or click  to select, the benefit plan start date. 

Taxable Entity Use the following fields to select the taxable entity range: 

 Option: From the drop-down list, select One or All. 

 Start: Enter, or click  to select, the taxable entity for processing. 

Employee Use the following fields to select the employee range: 

 Option: From the drop-down list, select the range option. Valid options 
are: 

 One 

 Range 

 From Beginning 

 To End. 

 Start: Enter, or click  to select, the starting employee for processing. 

 End: Enter, or click  to select, the ending employee for processing 

 Non-Contiguous Ranges: Select this check box to enter non-
contiguous range of employees in the subtask. 

Benefit Plan Use the following fields to select the benefit plan range: 

 Option: From the drop-down list, select the range option. Valid options 
are: 

 One 

 Range 

 From Beginning 

 To End. 

 Start: Enter, or click  to select, the benefit plan for processing. 

 End: Enter, or click  to select, the ending benefit plan for 
processing. 

Pay Cycle Use the following fields to select the pay cycle range: 

 Option: From the drop-down list, select One or All. 

 Start: Enter, or click  to select, the pay cycle for processing. 

Employee Non-
Contiguous 
Ranges subtask 

If you selected the Non-Contiguous Ranges check box for the employee 
range, use this subtask to enter the ranges. Click New to add a range. 

The following fields are available on this subtask: 
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Field Description 

 Range Type: From the drop-down list, select the range option. Valid 
options are: 

 One 

 Range 

 From Beginning 

 To End. 

 Start: Enter, or click  to select, the starting employee for processing. 

 End: Enter, or click  to select, the ending employee for processing. 

Manage Employee Benefit Elections (HBMEBELC) 
The application provides the following new fields: 

Field Description 

EOI Status If applicable, this field displays the employee’s Evidence of Insurability (EOI) 
status. Valid values are:  

 Not Required 

 Approved  

EOI Received Date This field displays the date that the EOI document was received by the Human 
Resources department. 

EOI Document This field displays the location where a copy of the EOI is saved. 

The Manage Employee Benefit Elections screen provides a new validation that prevents you from 
entering any benefit elections for plans that require an EOI since you must enter those elections on the 
Manage Employee Evidence of Insurability (EOI) screen. 

Costpoint will move only the benefit elections with Approved and Not Required EOI statuses from the 
Manage Employee Evidence of Insurability (EOI) screen to this screen. Benefit elections with Required 
and Denied EOI statuses will remain on the Manage Employee Evidence of Insurability (EOI) screen. 

In form view, the Benefit Elections Details is presented in the following three tabs:  

 Benefit Election Details 

 EOI Details 

 Physician Info 

Assign Dependents to Benefit Plans (HBMADEP) 
The application provides the following new fields: 
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Field Description 

EOI Status If applicable, this field displays the dependent’s Evidence of Insurability (EOI) 
status. Valid values are:  

 Not Required 

 Approved  

EOI Received Date This field displays the date that the EOI document was received by the Human 
Resources department. 

EOI Document This field displays the location where a copy of the EOI is saved. 

The Assign Dependents to Benefit Plans screen provides a new validation that prevents you from 
entering any benefit elections for plans that require an EOI since you must enter those elections on the 
Manage Employee Evidence of Insurability (EOI) screen. 

Costpoint will move only the benefit elections with Approved and Not Required EOI statuses from the 
Manage Employee Evidence of Insurability (EOI) screen to this screen. Benefit elections with Required 
and Denied EOI statuses will remain on the Manage Employee Evidence of Insurability (EOI) screen. 

Update Employee Package Deductions (HBPAPDED) 
If applicable, the application now uses the benefit plan’s Coverage Limit field for any coverage/premium 
calculations. 

Update Benefit Option/Election Tables (AOPESSDB) 
The Update Benefit Option/Election Tables screen features the following updates: 

 A new EOI Status field was added to the benefit options table and benefit options report. 

 The application now determines if EOI is required for the benefit plan and coverage options 
combination for benefits enrollment. 

Life Events/New Hires (ESMLIFEEVENT) 
The Life Events/New Hires screen provides new EOI fields on the Select New Coverage Level subtasks 
of following tabs:  

 Employee Life Insurance 

 Accidental Death & Dismemberment 

 Long Term Disability 

 Short Term Disability 

 Supplemental Life Insurance 

 Supplemental AD&D Insurance 

 Spouse Life Insurance 

 Spouse AD&D Insurance 

The application now determines if EOI is required for the benefit plan and coverage options combination. 

The new EOI fields are the following: 
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Field Description 

Evidence of 
Insurability 

If applicable, this field displays if the coverage option requires Evidence of 
Insurability (EOI). Valid values are:  

 Not Required 

 Required 

EOI Form Location If applicable, this field displays the location where the employee can download 
or find a copy of the EOI form to fill out. 

Benefits Enrollment (ESMBENENROLL) 
The Benefits Enrollment screen provides new EOI fields on the Select New Coverage Level subtasks of 
following tabs:  

 Employee Life Insurance 

 Accidental Death & Dismemberment 

 Long Term Disability 

 Short Term Disability 

 Supplemental Life Insurance 

 Supplemental AD&D Insurance 

 Spouse Life Insurance 

 Spouse AD&D Insurance 

The application now determines if EOI is required for the benefit plan and coverage options combination. 

The new EOI fields are the following: 

Field Description 

Evidence of 
Insurability 

If applicable, this displays if evidence of insurability is needed for the coverage 
option (Not Required, Required). 

EOI Form Location If applicable, this displays the location where the employee can download or 
find a copy of the EOI form to fill out. 

Manage Life Event Elections (AOMESSBL) 
The Benefit Plan Details table provides the following new/updated fields: 

Field Description 

Approved by HR This check box is available only when the benefit plan requires approval 
(Require HR Approval in ESS check box is selected for the benefit plan on 
the Enrollment Coverage Rules tab of the Manage Benefit Plans screen). 
Otherwise, this check box is disabled. 
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Field Description 

If the benefit plan’s Require HR Approval in ESS check box is selected, and 
your ESS Administrator approved the ESS election, this check box displays as 
selected. However, you can still change this setting. 

When you select this check box for the selected benefit option line and save 
the record, the application will select the Approved by HR check box on the 
Edit Dependent Elections subtask for all dependent election lines. 

EOI Status If applicable, this field displays the employee’s Evidence of Insurability (EOI) 
status. You can change the option in this drop-down field with the following 
EOI statuses:  

 Not Required 

 Approved 

 Required 

 Denied 

EOI Received Date Enter, or click  to select, the date the EOI document was received by the 
Human Resources department. This is only enabled when the selected EOI 
status is either Approved or Denied. 

The Edit Dependent Elections subtask provides the following new/updated fields: 

Field Description 

Approved by HR This check box is available only when the benefit plan requires approval 
(Require HR Approval in ESS check box is selected for the benefit plan on 
the Enrollment Coverage Rules tab of the Manage Benefit Plans screen). 
Otherwise, this check box is disabled. 

If the benefit plan’s Require HR Approval in ESS check box is selected, and 
your ESS Administrator approved the ESS election, this check box displays as 
selected. However, you can still change this setting. 

When you select this check box for the selected benefit option line and save 
the record, the application will select the Approved by HR check box on the 
Edit Dependent Elections subtask for all dependent election lines. 

EOI Status If applicable, this field displays the dependent’s Evidence of Insurability (EOI) 
status. You can change the option in this drop-down field with the following 
EOI statuses:  

 Not Required 

 Approved 

 Required 

 Denied 

EOI Received Date Enter, or click  to select, the date the EOI document was received by the 
Human Resources department. This is only enabled when the selected EOI 
status is either Approved or Denied. 



People/Regulatory 

Release Notes for Version 8.0 59 

 

 

The screen also provides a new query condition which lets you search by EOI Status field.  

Approve Open Enrollment Elections by Plan (AOMESSAP) 
The main screen of the application provides the following new option:  

Field Description 

All EOI Status 
‘Approved’ 
Elections for 
Benefit Plan 

Select this option to mass approve coverage elections that have an EOI 
status of Approved. 

The Approve Employee Elections table provides the following new/updated fields: 

Field Description 

Approved by HR This check box is available only when the benefit plan requires approval 
(Require HR Approval in ESS check box is selected for the benefit plan on 
the Enrollment Coverage Rules tab of the Manage Benefit Plans screen). 
Otherwise, this check box is disabled. 

If the benefit plan’s Require HR Approval in ESS check box is selected, and 
your ESS Administrator approved the ESS election, this check box displays 
as selected. However, you can still change this setting. 

When you select this check box for the selected benefit option line and save 
the record, the application will select the Approved by HR check box on the 
Approve Dependent Elections subtask for all dependent election lines. 

EOI Status If applicable, this field displays the employee’s Evidence of Insurability (EOI) 
status. You can change the option in this drop-down field with the following 
EOI statuses:  

 Not Required 

 Approved 

 Required 

 Denied 

Note: The following applies to the Manage Life Event Elections screen: 

 The EOI Status field and the EOI Received Date field on the Edit Dependent Elections 
subtask are always visible and disabled. They will only be editable or enabled when the 
benefit type is Spouse Life or Spouse AD&D only and the benefit plan’s Evidence of 
Insurability Required check box is selected. 

 In the Benefit Plan Details section, the EOI Status field and EOI Received Date field will not 
be editable. The fields will display the values of the EOI Status field and EOI Received Date 
field from the Edit Dependent Elections subtask when the benefit type is Spouse Life or 
Spouse AD&D only. 
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Field Description 

EOI Received Date Enter, or click  to select, the date the EOI document was received by the 
Human Resources department. This is only enabled when the selected EOI 
status is either Approved or Denied. 

The Approve Dependent Elections subtask provides the following new/updated fields: 

Field Description 

Approved by HR This check box is available only when the benefit plan requires approval 
(Require HR Approval in ESS check box is selected for the benefit plan on 
the Enrollment Coverage Rules tab of the Manage Benefit Plans screen). 
Otherwise, this check box is disabled. 

If the benefit plan’s Require HR Approval in ESS check box is selected, and 
your ESS Administrator approved the ESS election, this check box displays as 
selected. However, you can still change this setting. 

When you select this check box for the selected benefit option line and save 
the record, the application will select the Approved by HR check box on the 
Approve Dependent Elections subtask for all dependent election lines. 

EOI Status If applicable, this field displays the dependent’s Evidence of Insurability (EOI) 
status. You can change the option in this drop-down field with the following 
EOI statuses:  

 Not Required 

 Approved 

 Required 

 Denied 

EOI Received Date Enter, or click  to select, the date the EOI document was received by the 
Human Resources department. This is only enabled when the selected EOI 
status is either Approved or Denied. 

 

The screen also features the following additional updates: 

 The application now displays records where either the Require HR Approval in ESS check box 
is selected and/or the Evidence of Insurability Required check box is selected.  

Note: The following applies to the Approve Open Enrollment Elections by Plan screen: 

 The EOI Status field and the EOI Received Date field on the Approve Dependent Elections 
subtask are always visible and disabled. They will only be editable or enabled when the 
benefit type is Spouse Life or Spouse AD&D only and the benefit plan’s Evidence of 
Insurability Required check box is selected. 

 In the Approve Employee Elections section, the EOI Status field and EOI Received Date 
field will not be editable. The fields will display the values of the EOI Status field and EOI 
Received Date field from the Approve Dependent Elections subtask when the benefit type is 
Spouse Life or Spouse AD&D only. 
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 A new query condition which lets you search by EOI Status field, is now available. 

Manage Open Enrollment Elections (AOMESSBE) 
The Benefit Plan Details table provides the following new/updated fields: 

Field Description 

Approved by HR This check box is available only when the benefit plan requires approval 
(Require HR Approval in ESS check box is selected for the benefit plan on the 
Enrollment Coverage Rules tab of the Manage Benefit Plans screen). 
Otherwise, this check box is disabled. 

If the benefit plan’s Require HR Approval in ESS check box is selected, and 
your ESS Administrator approved the ESS election, this check box displays as 
selected. However, you can still change this setting. 

When you select this check box for the selected benefit option line and save the 
record, the application will select the Approved by HR check box on the Edit 
Dependent Elections subtask for all dependent election lines. 

EOI Status If applicable, this field displays the employee’s Evidence of Insurability (EOI) 
status. You can change the option in this drop-down field with the following EOI 
statuses:  

 Not Required 

 Approved 

 Required 

 Denied 

EOI Received Date Enter, or click  to select, the date the EOI document was received by the 
Human Resources department. This is only enabled when the selected EOI 
status is either Approved or Denied. 

The Edit Dependent Elections subtask provides the following new/updated fields: 

Field Description 

Approved by HR This check box is available only when the benefit plan requires approval 
(Require HR Approval in ESS check box is selected for the benefit plan on the 
Enrollment Coverage Rules tab of the Manage Benefit Plans screen). Otherwise, 
this check box is disabled. 

If the benefit plan’s Require HR Approval in ESS check box is selected, and 
your ESS Administrator approved the ESS election, this check box displays as 
selected. However, you can still change this setting. 

When you select this check box for the selected benefit option line and save the 
record, the application will select the Approved by HR check box on the Edit 
Dependent Elections subtask for r all dependent election lines. 

EOI Status If applicable, this field displays the dependent’s Evidence of Insurability (EOI) 
status. You can change the option in this drop-down field with the following EOI 
statuses:  
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Field Description 

 Not Required 

 Approved 

 Required 

 Denied 

EOI Received 
Date 

Enter, or click  to select, the date the EOI document was received by the 
Human Resources department. This is only enabled when the selected EOI 
status is either Approved or Denied. 

 

The screen also provides a new query condition which lets you search by EOI Status field.  

Activate Pending Benefit Elections (AOPESSUE) 
The Activate Pending Benefit Elections screen features the following changes: 

 The error report now generates EOI status warning messages. These validations prevent the 
update of the benefit election if the EOI status is Required or Denied. 

 The application will update Manage Employee Evidence of Insurability (EOI) screen where the 
benefit plan and coverage option EOI status is either Required, Denied, or Approved. 

 

 When EOI has not been approved, the application implements the selected option in the 
Substitution Rules group box on the Manage Benefit Plans screen.  

Configure Benefit Settings (HBMSET) 
The screen provides the following new field: 

Field Description 

# of Days Employees 
are classified as new 

Enter how many days employees will be classified as new employees for 
benefit election purposes. This number will be used by the Evidence of 
Insurability (EOI) calculation to determine which employees are considered 
new. 

Note: The following applies to the Manage Open Enrollment Elections screen: 

 The EOI Status field and the EOI Received Date field on the Edit Dependent Elections 
subtask are always visible and disabled. They will only be editable or enabled when the 
benefit type is Spouse Life or Spouse AD&D only and the benefit plan’s Evidence of 
Insurability Required check box is selected. 

 In Benefit Plan Details section, the EOI Status field and EOI Received Date field will not be 
editable. The fields will display the values of the EOI Status field and EOI Received Date 
field from the Edit Dependent Elections subtask when the benefit type is Spouse Life or 
Spouse AD&D only. 

Note: New elections that have an EOI status of Not Required are also transferred to the 
Manage Employee Evidence of Insurability (EOI) screen to keep track of all EOI transactions. 
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Configure Self Service Settings (ESMESS) 
The screen provides the following new field: 

Field Description 

Show Evidence of 
Insurability fields in 
Insurance screens 

Select this check box to display the EOI Form URL/Location and EOI 
Status fields in insurance applications. 

Total Comp/Benefits Statement (ESQCOMPBEN) 
If applicable, the application now uses the benefit plan’s Coverage Limit field for any coverage/premium 
calculations. 

Total Compensation (HTMTOTALCOMP) 
If applicable, the application now uses the benefit plan’s Coverage Limit field for any coverage/premium 
calculations. 

Updated VETS-4212 Options on the Manage Employee Information 
Screen 
The Manage Employee Information screen now provides updated veteran statuses to conform to 
standards in the VETS-4212 Report. This enhancement also updates related Costpoint applications that 
handle veteran status information. 

Manage Employee Information (LDMEINFO) 
The VETS-4212 Protected Veteran Status group box provides the following updated/new check 
boxes/fields. This group box was previously named as VETS-4212 Data. 

Field Description 

Recently Separated Veteran This check box indicates if this employee is a 
recently separated veteran. When you select this 
check box, the application enables the 
Discharge/Release Date field, but it is not a 
required field. The VETS-4212 report will use this 
check box to categorize the employee as a 
protected veteran if the date field is not blank and 
the release date is within 3 years of the report 
date. 

Not a Protected Veteran Select this check box if the employee specified 
that he/she is not a protected veteran (as defined 
by the VETS-4212 report). The VETS-4212 report 
will not count this employee as a veteran. 

Declined to provide veteran status Select this check box if the employee if did not 
wish to disclose his/her veteran status. The 
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Field Description 

VETS-4212 report will not count this employee as 
a veteran. 

The following are the updated field names on the screen: 

New Field Name Old Field Name 

Birth City City 

Birth State/Province State/Province 

Birth Country Country 

Last Review Date Last 

Next Review Date Next 

The following are no longer available on the screen: 

 Other Military Statuses group box 

 Special Disabled Veteran check box 

 Vietnam Era Veteran check box 

 Reservist check box 

 Birth Location group box 

 Review Dates group box 

 Miscellaneous Data group box 

View Employee Information (PRQEINFO) 
The VETS-4212 Protected Veteran Status group box provides the following updated/new check 
boxes/fields. This group box was previously named as VETS-4212 Data. 

Field Description 

Recently Separated Veteran This check box indicates if this employee is a 
recently separated veteran. When you select this 
check box, the application enables the 
Discharge/Release Date field, but it is not a 
required field. The VETS-4212 report will use this 
check box to categorize the employee as a 
protected veteran if the date field is not blank and 
the release date is within 3 years of the report 
date. 

Not a Protected Veteran This check box indicates if the employee is not a 
protected veteran as defined by the VETS-4212 
report. The VETS-4212 report will not count this 
employee as a veteran. 
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Field Description 

Declined to provide veteran status This check box indicates if the employee did not 
wish to disclose his/her veteran status. The 
VETS-4212 report will not count this employee as 
a veteran. 

The following are the updated field names on the screen: 

New Field Name Old Field Name 

Birth City City 

Birth State/Province State/Province 

Birth Country Country 

Last Review Date Last 

Next Review Date Next 

The following are no longer available on the screen: 

 Other Military Statuses group box 

 Special Disabled Veteran check box 

 Vietnam Era Veteran check box 

 Reservist check box 

 Birth Location group box 

 Review Dates group box 

 Miscellaneous Data group box 

Transfer Talent Management Data (EMPHRSDAT) 
The Employee data import process now includes Recently Separated Veteran and Not a Protected 
Veteran check boxes from Talent Management. 

The following fields were added to the Employee staging table: 

 VET_STATUS_NP (Not a protected veteran) 

 VET_STATUS_DECLINED (Declined to provide a veteran status) 

 VET_STATUS_RS (Recently separated veteran) 

Employee Personal Info (ESQEMPLPERINFO) 
The Military Status group box provides the following new check boxes: 

Field Description 

Protected Veteran (Declined to Self-Identify) This check box indicates if the employee is a 
protected veteran (as defined by the VETS-4212 
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Field Description 

report) but declined to select a category. The 
VETS-4212 report will count this employee as a 
veteran. 

Not a Protected Veteran This check box indicates if the employee is not a 
protected veteran (as defined by the VETS-4212 
report). The VETS-4212 report will not count this 
employee as a veteran. 

Declined to provide veteran status This check box indicates if the employee did not 
wish to disclose his/her veteran status. The 
VETS-4212 report will not count this employee as 
a veteran. 

The following check boxes are no longer available on the screen: 

 Special Disabled Veteran 

 Vietnam Era Veteran 

 Reservist 

Print VETS-4212 Report (HARV100) 
The report was updated to include employees with a Recently Separated Veteran status as a veteran if 
the Discharge/Release Date is blank. This will allow employees imported from Talent Management to be 
included in the report since they do not send a Discharge/Release Date. 

New Total Compensation Control on the Configure Team 
Management Settings Screen 
Prior to this release, Costpoint used the controls on the Configure Self Service Settings screen in 
Employee Self Service to display the total compensation summary and benefit elections on the Total 
Compensation screen in Team Management. This enhancement adds new separate settings on the 
Configure Team Management Settings screen that allow you to control the total compensation 
information on the Total Compensation screen. 

Configure Team Management Settings (HTMSETTINGS) 
The screen provides the following updated/new fields: 

Field Description 

View Employee Data These existing options were previously labeled as “Team 
Management.” 

The View Employee Data options allow you to specify if 
managers are able to view only the records of their direct 
reports; or both their direct and indirect reports on Costpoint 
Team Management screens. 



People/Regulatory 

Release Notes for Version 8.0 67 

 

Field Description 

Show Total Compensation 
Summary  

Select this check box to display the total compensation 
summary on the Total Compensation screen in Team 
Management.  

You can view a total compensation summary that lists such 
things as your annual salary, leave benefits, and others. 

Show Benefit Elections in Total 
Compensation 

Select this check box to display benefit elections on the Total 
Compensation screen in Team Management. 

You can view benefit elections and their coverage level as well 
as employee/employer costs. 

Total Compensation (HTMTOTALCOMP) 
The database table/field references in the application were updated to reflect the transfer of the Show 
Benefit Elections in Total Compensation flag (SHOW_BEN_ELEC_FL) and Show Total Compensation 
Summary flag (SHOW_TOT_COMP_FL) from the Employee Self Service configuration (ESS_CONFIG) 
table to the Team Management Settings (HT_SETTINGS) table. 

Set Up Company (SYPCOMP) 
The application now includes the new fields on the Configure Team Management Settings screen when 
you add new companies in Costpoint. 

New Supervisor Field on the Manage Employee Salary Information 
Screen 
The Manage Employee Salary Information screen now provides a new Supervisor field that is trackable 
by dates. This new field uses the Employee ID lookup functionality, unlike the existing Supervisor Name 
field on the Manage Employee Information screen which only uses free form data entry. The new 
Supervisor field will not replace the existing Manager field on the Manage Employee Salary Information 
screen. However, both fields with have the same attributes. 

If you are licensed for Costpoint Human Resources (HR), the default value of the Supervisor field on the 
Manage Employee Salary Information screen will come from one of the following screens:  

 Manage Managers/HR Reps by Organization 

 Manage Managers/HR Reps by HR Organization 

 Manage Detail Position Descriptions  

Applications that export Manager field values, such as the Export Data to Deltek Time and Expense 
screen and the Transfer Talent Management Data screen, also support this new enhancement. These 
applications allow you to select whether the manager data or supervisor data from Manage Employee 
Salary Information will be included in the data transfer process. 

This enhancement also updates the lookup functionality and field labels in multiple applications. 
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Manage Employee Salary Information (LDMEHIS) 

 

The screen contains the following new fields: 

Field Description 

Supervisor Enter, or click  to select, the employee ID of the employee’s supervisor. If you are 
not licensed for Costpoint HR, the lookup results will display all employee IDs. 

If you are licensed for Costpoint HR, the lookup results will display the following 
based on the corresponding setup: 

 Supervisors assigned to active HR organization from Login Company 
only: This applies when the Allow HR Org Manager/Rep/Spvsr from Other 
Companies check box is cleared on the Configure System Settings screen, 
and the Manager Defaulting Method is By HR Organization on the 
Configure Personnel Settings screen. 

 Supervisors assigned to active HR organization from all companies: 
This applies if the Allow HR Org Manager/Rep/Spvsr from Other 
Companies check box is selected on the Configure System Settings screen, 
and the Manager Defaulting Method is By HR Organization on the 
Configure Personnel Settings screen. 

 Supervisors assigned to company-wide organization: This applies if the 
Manager Defaulting Method is By Company-Wide Organization on the 
Configure Personnel Settings screen. 

Supervisor 
Name 

This field displays the name of the employee’s supervisor. 

Manager 
Name 

This field displays the name of the employee’s manager. 

If you are licensed for Costpoint HR, the Manage Employee Salary Information screen uses the following 
levels to load the default value in the Supervisor field: 

Default 
Level 

Default Value Costpoint Setup 

1 Supervisor assigned 
to organization on the 
Manage 
Managers/HR Reps 
by Organization 
screen 

 On the Configure Personnel Setting screen, the Manager 
Defaulting Method is By Company-Wide Organization. 

 On the Manage Employee Salary Information screen, a 
home organization is assigned to the employee. 

 On the Managers/HR Reps by Organization screen, a 
supervisor is assigned to the employee’s home organization. 

2 Supervisor assigned 
to HR organization on 
the Managers/HR 

 On the Configure Personnel Setting screen, the Manager 
Defaulting Method is By HR Organization. 

Note: These updates are also available on the Salary Details subtask of the Manage Employee 
Information screen. 
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Default 
Level 

Default Value Costpoint Setup 

Reps by HR 
Organization screen 

 On the Manage Employee Salary Information screen, an HR 
organization is assigned to the employee. 

 On the Managers/HR Reps by HR Organization screen, a 
supervisor is assigned to the employee’s HR organization. 

3 Supervisor assigned 
to Detail Job Title in 
Manage Detail 
Position Descriptions 
screen 

 On the Manage Employee Salary Information screen, the 
Detail Job Title is specified. 

 The Detail Job Title exists on the Manage Detail Position 
Descriptions screen. 

View Salary Information and History (PRQEHIS) 
The screen provides the following new fields: 

Field Description 

Supervisor This field displays the employee ID of the employee’s supervisor from the 
Manage Employee Salary Information screen. 

Supervisor Name This field displays the name of the employee’s supervisor. 

Manager Name This field displays the name of the employee’s manager. 

Configure Personnel Settings (HPMSET) 
The label of the existing Manager Defaulting Method check box changed to “Manager and Supervisor 
Defaulting Method.” 

Transfer Talent Management Data (EMPHRSDAT) 
The screen contains the following new check boxes: 

Field Description 

Import Salary 
Information 
Supervisor Data 
instead of Manager 
Data 

Select this check box to import Deltek Talent Management managers as 
supervisors into the Supervisor field on the Manage Employee Salary 
Information screen. 

Export Salary 
Information 
Supervisor Data 
instead of Manager 
Data 

Select this check box to export the supervisors instead of the managers from 
the Manage Employee Salary Information screen to Deltek Talent Management.
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Export Data to Deltek Time and Expense (LDPDTC) 
The screen contains the following new check box: 

Field Description 

Export Salary 
Information 
Supervisor Data 
instead of Manager 
Data 

Select this check box to export the supervisors instead of the managers from 
the Manage Employee Salary Information screen when you export employee 
data. 

Configure System Settings (SYMSETNG) 
The label of the existing Allow HR Org Manager/Rep from Other Companies check box changed to 
“Allow HR Org Manager/Rep/Spvsr from Other Companies.” 

Manage Managers/HR Reps by Organization (HSMMGMR) 
The screen contains the following new fields: 

Field Description 

Supervisor Enter, or click  to select, the employee ID of the supervisor for the home 
organization, if applicable.  

Supervisor Name This field displays the name of the selected supervisor. 

Manage Managers/HR Reps by HR Organization (HPMHRORG) 
The screen contains the following new fields: 

Field Description 

Supervisor Enter, or click  to select, the employee ID of the supervisor for the HR 
organization, if applicable.  

Supervisor Name This field displays the name of the selected supervisor. 

Manage Detail Position Descriptions (HPMDPOS) 
The lookup functionality in the Supervisor field was updated. 

The lookup results will display supervisors assigned to an active HR organization from the Login 
Company only if you have the following setup: 

 The Allow HR Org Manager/Rep/Spvsr from Other Companies check box is cleared on the 
Configure System Settings screen. 

 The Manager Defaulting Method is By HR Organization on the Configure Personnel Settings 
screen. 
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The lookup results will display supervisors assigned to an active HR organization from all companies if 
you have the following setup: 

 The Allow HR Org Manager/Rep/Spvsr from Other Companies check box is selected on the 
Configure System Settings screen. 

 The Manager Defaulting Method is By HR Organization on the Configure Personnel Settings 
screen. 

The lookup results will display supervisors assigned to a company-wide organization if you have the 
following setup: 

 The Manager Defaulting Method is By Company-Wide Organization on the Configure 
Personnel Settings screen. 

Team Details (HTMDETAIL) 
The screen contains the following new field on the Current Salary Information tab: 

Field Description 

Supervisor This field displays the supervisor from the employee’s salary information. 

Team Information Report (HTRTEAMINFO) 
The employee’s supervisor information is now displayed on the report. This update is available whether 
you select to include All Historical Data or Current Only salary information in the report. 

Print Data Dictionary Report (SYRDD)  
The report now provides information for the new Supervisor columns in the following database tables: 

 EMPL_LAB_INFO 

 EMPL_LAB_INFO_ADT 

 ORG_MGR_DFLT 

 HR_ORG_MGR_DFLT 

Audit File Tracking of Basic Employee Information and Employee 
Salary Information for Non-Payroll Users 
This Costpoint release provides non-payroll users with the ability to track adding, updating, and deleting 
of records on the Manage Employee Information screen and Manage Employee Salary Information 
screen. To support this enhancement, the following controls for audit file tracking were transferred from 
the Configure Payroll Settings screen to the Configure Labor Settings screen: 

 Basic Employee Information 

 Employee Salary Information 

Costpoint Menu Updates 
This release also includes the following updates to the Costpoint menu: 
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 A new menu option, Education, Skills and Training Controls, is listed under the Employee 
module. This menu now provides access to the following applications which were previously 
available in the Employee Controls menu: 

 Manage Areas of Education 

 Manage Courses 

 Manage Degrees 

 Manage Professional Organizations 

 Manage Skill Codes 

 Manage Skill Levels 

 Manage Training Codes 

 Manage Training Locations 

 Manage Training Sources 

 Manage Training Program Schedules 

 Print Training Program Schedules 

 The name of the Employee Reports menu in the Employee module changed to Employee 
Reports/Inquiries. This menu now has the following submenus: 

Submenu Applications 

Reports  Print Employee Awards List 

 Print Employee Basic Report 

 Print Employee Job Title Report 

 Print Employee Medical Surveillance Data Report 

 Print Employee Salary Information Report 

 Print Employee Setup Report 

 Print FLSA Status Report 

 Print New Hire Report 

Inquiries  View Employee Information 

 View Salary Information and History 

 

Configure Payroll Settings (PRMPRSET) 
The following check boxes are no longer available in the Enable Audit File Tracking group box: 

 Basic Employee Information 

 Employee Salary Information 

Note: These applications were previously available in Payroll » 
Payroll Reports » Inquiries. 
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Configure Labor Settings (LDMLABOR) 
A new Enable Audit File Tracking group box provides the following check boxes: 

Field  Description  

Basic 
Employee 
Information  

Select this check box to enable audit tracking for adding new records, updating 
existing records, or deleting existing records on the Manage Employee Information 
screen. These modifications are available for display on the View Employee 
Information screen. If this check box is later cleared, all future record additions, 
updates, and/or deletions are not written to the audit file table. The Basic Employee 
Info Audit table still contains any records written when the check box was selected.  

Employee 
Salary 
Information  

Select this check box to enable audit tracking for adding new records, updating 
existing records, or deleting existing records on the Manage Employee Salary 
Information screen. These modifications are available for display on the View Salary 
Information and History screen. If this check box is later cleared, all future record 
additions, updates, and/or deletions are not written to the audit file table. The Salary 
Info and History Audit table still contains any records written when the check box 
was selected. 

Manage Employee Salary Information (LDMEHIS) 
The audit tracking functionality on this screen is now controlled from the Configure Labor Settings screen 
instead of the Configure Payroll Settings screen. 

Manage Employee Information (LDMEINFO) 
The audit tracking functionality on this screen is now controlled from the Configure Labor Settings screen 
instead of the Configure Payroll Settings screen. 

Multiple Applications 
The database table/field references in multiple Costpoint applications were updated to reflect the transfer 
of the Audit Salary Info Flag (AUDIT_SAL_INFO_FL) and Audit Basic Flag (AUDIT_BASIC_FL) from the 
Payroll Settings (PR_SETTINGS) table to the Labor Settings (LAB_SETTINGS) table. This includes the 
following screens: 

 View Employee Information (PRQEINFO) 

 View Salary Information and History (PRQEHIS) 

 Link Talent Management User IDs to Existing Employees (EMPTMUI) 

 Manage Plants (INMPLANT) 

 Manage Employee Project Manufacturing Status (PCMEEPM) 

 Address/Phone (ESMADDRESSPHONE) 

 Emergency Contacts (ESMEMERCON) 

 Team Management-Emergency Contacts (HTMEMERGENCYCONTACT) 

 Activate Pending Change Requests (HTPCHANGES) 

 Update Employees for Manager Change (HSPMGR) 

 Life Events/New Hires (ESMLIFEEVENT) 
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Set Minimum Amount for HSA and FSA Elections 
Costpoint now gives you the ability to set a minimum amount for Heath Savings Account (HSA) and 
Flexible Spending Account (FSA) elections. To support this new functionality, the following screens each 
provide a new field for setting the minimum election amount for the plan year: 

 Manage HSA Plan Year (HBMHSET) 

 Manage Medical Care FSA Plan Year (HBMMCSET) 

 Manage Dependent Care FSA Plan Year (HBMDCSET) 

If your company does not have a minimum election amount, you can leave the minimum amount at 0.00. 
Employees must elect an amount for the plan year that is equal to or greater than the minimum amount. 
Costpoint applications where you can select FSA and HSA elections provide new validations to ensure 
that the election meets the new requirements. If the employee’s FSA/HSA election is 0.00, it will not be 
subject to the new validation because it is not an actual election. 

Manage Medical Care FSA Plan Year (HBMMCSET) 
The screen contains the following new field: 

Field Description 

Minimum Amount Enter the minimum amount that employees are 
allowed to elect for medical care FSA expenses 
for the plan year. 

Manage Dependent Care FSA Plan Year (HBMDCSET) 
The screen contains the following new field: 

Field Description 

Minimum Amount Enter the minimum amount that employees are 
allowed to elect for dependent care FSA 
expenses for the plan year. 

Manage HSA Plan Year (HBMHSET) 
The screen contains the following new and revised fields: 

Field Description 

Employee Minimum Enter the minimum amount that employees are 
allowed to elect for the HSA plan year. 

Employee Maximum Enter the maximum amount that the employee 
may contribute in a plan year. 

The label of this existing field changed from 
“Employee Limit” to “Employee Maximum.” 
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Field Description 

Employer Maximum Enter the maximum amount that the employee 
may contribute in a plan year. 

The label of this existing field changed from 
“Employer Limit” to “Employer Maximum.” 

Benefits Enrollment (ESMBENENROLL) 
The application contains new validation to ensure that the employee elects the minimum amount for 
FSA/HSA elections. This exists on the following tabs: 

 Medical FSA 

 Dependent FSA 

 Medical HSA 

Life Events/New Hires (ESMLIFEEVENT) 
The application contains new validation to ensure that the employee elects the minimum amount for 
FSA/HSA elections. This exists on the following tabs: 

 Medical FSA 

 Dependent FSA 

 Medical HSA 

Manage Open Enrollment Elections (AOMESSBE) 
The application contains new validation to ensure that the employee elects the minimum amount for 
medical and dependent FSAs and HSAs. 

Manage Life Event Elections (AOMESSBL) 
The application contains new validation to ensure that the employee elects the minimum amount for 
medical and dependent FSAs and HSAs. 

Manage Employee Medical Care FSA Elections (HBMMFSA) 
The application contains new validation to ensure that the employee elects the minimum amount. 

Manage Employee Dependent Care FSA Elections (HBMEFSA) 
The application contains new validation to ensure that the employee elects the minimum amount. 

Manage Employee HSA Elections (EMMEHSA) 
The application contains new validation to ensure that the employee elects the minimum amount. 

Configure Global Settings (AOMESSGS) 
The following field on the screen is now enabled to allow you to set the ESS version that your company is 
using: 
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Field Description 

ESS Version From the drop-down list, select the ESS version 
that your company is using. Valid options are: 

 Deltek ESS 9 

 Deltek ESS 10+ 

New Cache Tables and CSV Export Files Option for Exporting Data 
to Deltek Time and Expense 
To improve the integration between Costpoint and Deltek Time and Expense, this enhancement adds 
new permanent work tables as part of the data download process between the two systems. For co-
deployed installations, this means that you are no longer required to export/import the following links: 

 LINK12: UDT01/UDT02 (Account/Project or Account/MO)  

 LINK19:  UDT01/UDT09 (Account/Org)  

 LINK27: UDT02/UDT07 (Project/PLC or MO/Routing) 

 LINK 29: UDT02/UDT09 (Project/Org) 

When you set up the Export Data to Deltek Time and Expense (LDPDTC) screen to transfer link table 
information (LINK12, LINK19, LINK27, or LINK29), the application will insert records into the permanent 
work tables instead of into an export file. Deltek Time and Expense will also use the work tables to 
validate data.  

 

The Export Data to Deltek Time and Expense screen also provides a new option that allows you to still 
create CSV export files. You can access the following new field on the on the Export Information tab of 
the screen. 

Field Description 

Create CSV Export Files 
for Link Tables 

When you export link tables (LINK12, LINK19, LINK27, or LINK29), select 
this check box to create a CSV export file and insert the data in permanent 
cache tables. 

If you opt not to select this check box, the application will only insert data 
into permanent cache tables. 

 

 

Note: No changes are required to use this enhancement if your systems are co-deployed and if direct 
linking of UDTs is already enabled in Deltek Time and Expense. However, to populate the new Link 
tables the first time, you must run the export from Export Data to Deltek Time and Expense screen. 

Note: If your version of Time & Expense is not co-deployed with Costpoint and you want to create an 
export file, you must select the Create CSV Export Files for Link Tables check box. 
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Materials 
This section describes Costpoint 8.0 enhancements for the Materials domain. 

Supplier Portal-Shipping Notifications 
The Supplier Portal Shipping Notifications feature enables the supplier to enter shipment information for 
specific purchase order (PO) lines and let the buyer know that a shipment has been made against the 
PO. On the part of the buyer, this feature allows them to receive email notifications when items are 
shipped from a supplier. In addition, this feature provides both the buyer and the supplier visibility on PO 
items that have been shipped. 

Manage Shipping Information (SPMSHIP) 
The supplier can use this new screen (Materials » Supplier Portal » Dashboards/Actions » Manage 
Shipping Information) to enter information regarding shipped quantities against purchase order 
lines/delivery schedule lines. Access to this application will be based on rights provided to the 
supplier/user by the system administrator. 

The supplier (user) will be able to view and enter shipping information only for purchase orders with a 
vendor ID that matches the vendor ID on the company to which the supplier is logged in.  This ensures 
that a particular supplier cannot see POs for a different supplier. 

Manage Supplier Actions (SPMSPACT) 
New fields have been added to the Action History subtask to display information related to a shipping 
notification entered/edited by the supplier on the Manage Shipping Information screen. 

Manage Purchase Orders (POMMAIN) 
The application has been changed to prevent the deletion of the PO/Rlse/PO line/Del Sch Line if a 
shipment and shipment line exist for the purchase order. 

Manage Buyers (POMBUY) 
You can now enable email notification to be sent to the buyer for shipment information entered by the 
supplier via the portal using the new Shipment Email Notification check box. If this is selected, email 
notifications will be sent to the buyer for all of the buyer’s purchase orders. 

Archive Purchase Orders (POPARCH) 
This screen now automatically deletes all associated shipment information for the archived PO/Rlse. 

Supplier Portal-Invoice Management 
This feature provides you with a simplified invoice delivery and reconciliation process between the payer 
and supplier. In Subcontractor Management, you will be able to submit invoices to your subcontractors, 
who will then be able to communicate on, view, and approve the invoices generated by the payer in 
Costpoint. The subcontractors and suppliers will also be able to create and submit invoices for parts, 
goods, or services utilizing purchase order (PO) data from Costpoint, including Time & Expense 
information where applicable. 



Materials 

Release Notes for Version 8.0 78 

 

Set Up Company (SYPCOMP) 
Set Up Company (SYPCOMP) has been modified to include the new fields on the Configure Purchase 
Order Voucher Settings (POMAPSET) screen when copying settings from one company to another. The 
new fields are: 

 Invoice Email Notification check box (VCHR_SETTINGS.INVC_EMAIL_FL) 

 Invoice Email (VCHR_SETTINGS.INVC_EMAIL_ID) 

Configure Purchase Order Voucher Settings (POMAPSET) 
The Supplier Portal group box has been added to the Configure Purchase Order Voucher Settings 
screen. It contains the following: 

 Invoice Email Notification check box: Use this check box to enable the sending of email 
notifications to an Accounts Payable (AP) user when a Supplier Portal user approves or rejects 
an invoice. 

 Email field: Enter the email address of the AP user who will receive invoice approval or rejection 
notifications. 

 

Manage Purchase Order Vouchers (POMPOVCH) 
The Manage Purchase Order Vouchers screen has been updated to prohibit you or a Supplier Portal user 
from deleting any voucher created from a digitally signed invoice. Any discrepancy must be fixed through 
a correcting invoice. 

This functionality applies only if the Digital Signature feature is enabled for you and the Supplier Portal 
user. 

Manage Invoices (SPMINVC) 
A new application, Manage Invoices (SPMINVC), has been added to the Supplier Portal module 
(Materials » Supplier Portal » Dashboards/Actions » Manage Invoices) to enable suppliers to do the 
following: 

 Approve/reject invoices created by a payer in Costpoint using the Create Subcontractor Invoices 
and Manage Subcontractor Invoices. This applies to invoices for Subcontractor Agreement or 
Subcontractor Agreement Release PO type.  

 Manually enter a new invoice directly or based on shipments made against the PO/lines. This 
applies to invoices for all PO types, except Subcontract Retainage PO. 

 View the information in the staging tables exported from Time and Expense, and automatically 
generate a new invoice based on the exported data. This applies to invoices for Subcontractor 
Agreement or Subcontractor Agreement Release PO type. 

 Query approved invoices of all PO types with vendor ID that matches the vendor ID on the 
company that the user is logged into. 

 

Note: If you are not licensed for Supplier Portal, the Supplier Portal group box is hidden. 

Note: Access to this application is based on rights provided to the user by the system administrator. 
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This new application ensures data security by matching the PO vendor ID with the vendor ID on the 
company that the user is logged into. For organization security, the new screen will only show data from 
POs with a buyer’s organization ID that the user is authorized for based on the organization security 
profile linked to the organization security group associated with the user ID. Once this organization 
security has been established, Costpoint will display all PO lines/delivery lines regardless of rights to 
projects and organization rights at the account distribution level. 

Email Alerts 

This application sends an email notification to the payer whenever changes are made to the invoice, and 
Invoice Email Notification is selected on the Configure Purchase Order Voucher Settings screen. 

Supplier Portal Dashboard (SPDSP) 
Two new dashparts, Subcontractor Invoices/Vouchers and Purchase Order Invoices/Vouchers, have 
been added to the screen to view/update information regarding the status of invoices/vouchers. 

The Subcontractor Invoices/Vouchers dashpart is automatically populated with bars that indicate the 
status of invoices/vouchers. Click the bar hyperlink to go to the Manage Invoices screen and load the 
corresponding invoice. 

The Purchase Order Invoices/Vouchers dashpart displays a list of invoices that are not fully approved, 
and unposted approved invoices that are pending approval by the payers Accounts Payable (A/P) 
department. Click the PO hyperlink to go to the Manage Invoices screen and load the corresponding 
invoice. 

The organization security setting in Costpoint ensures that the dashparts will only include 
invoices/vouchers for purchase orders with a buyer’s organization ID for which the user is authorized 
based on the organization security profile linked to the organization security group associated with the 
user ID. 

Manage Subcontractor Invoices (SMMMINVC) 
The following updates have been made to Manage Subcontractor Invoices: 

 You can now query invoice records created by the subcontractor/supplier, but all information 
displayed on the screen will be read-only. Note, however, that you will not be able to delete 
invoices or invoice lines created by the subcontractor/supplier. 

 The Subcontractor Approval group box on the Invoice Approvals tab has been renamed to 
Supplier Approval. 

 The Date field on the Internal Approval and Supplier Approval group boxes has been changed 
to Date/Time, and now displays both the date and time of the invoice approval. 

 A new Invoice Approval History subtask lets you view approval action changes made to the 
invoice. This subtask is read-only and provides details on the approval action, the date and time 
the approval action or notes were last updated, and the user ID of the person who updated the 
approval action or notes. 

Manage Subcontractor Invoices updates this subtask and the VCHR_HDR_ACTION table if any 
of the following actions are performed on this screen: 

 A new subcontractor invoice is created and the Submit for Approval check box is selected 
on this screen. 

 An existing invoice line is deleted (without deleting the invoice). 

 An existing invoice is deleted. 
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 This application now supports email alerts. If you are licensed for Supplier Portal and the Invoice 
Email Notification check box is selected on the Configure Purchase Order Voucher Settings 
screen, Costpoint sends an email notification to the subcontractor/supplier when you create a 
subcontractor invoice (that is subject for approval) or delete an existing invoice or invoice line. 
Costpoint sends notifications to the email address indicated in the Contact Email Address field 
on the Other Information tab of the Manage Purchase Orders screen. 

Approve Subcontractor Invoices (SMMAINVC) 
This application now performs validation to ensure that the receipt ID, packing slip, and material handler 
exist for the subcontractor invoice before the invoice can be approved internally. Previously, these 
validations were performed only after the invoice has been approved by both the internal approver and 
the subcontractor. This change is implemented to avoid any system errors that can occur when the 
subcontractor later approves the invoice since the receipt ID, packing slip, and material handler are not 
displayed on the new Manage Invoices screen. 

Invoices created through Manage Invoices now also display on the Approve Subcontractor Invoices 
screen. 

Similar with Manage Subcontractor Invoices, Approve Subcontractor Invoices also has the new Invoice 
Approval History subtask. This subtask is read-only and provides details on the approval action, the date 
and time the approval action or notes were last updated, and the user ID of the person who updated the 
approval action or notes. 

Approve Subcontractor Invoices updates this subtask and the VCHR_HDR_ACTION table if any of the 
following actions are performed on this screen: 

 The internal approver approves the invoice either manually or digitally. 

 The internal approver adds or changes the entry in the Notes field without changing the approval 
status of the existing invoice. 

 The internal approver withdraws the previous approval, either by clearing the Approved check 
box or by selecting Unsign from the Sign drop-down list on the toolbar (the latter if digital 
signature applies to the invoice). 

This application also supports email alerts. If you are licensed for Supplier Portal and the Invoice Email 
Notification check box is selected on the Configure Purchase Order Voucher Settings screen, Costpoint 
sends an email notification to the subcontractor/supplier when the internal approver approves, withdraws, 
or adds/changes notes for the invoice. Costpoint sends notifications to the email address indicated in the 
Contact Email Address field on the Other Information tab of the Manage Purchase Orders screen. 

Other updates made on this screen include the following: 

 The Subcontractor Approval group box has been renamed to Supplier Approval. All fields in 
this group box are now disabled if you are licensed for Supplier Portal since 
suppliers/subcontractors can approve invoices in the portal.  

 The Date field on the Internal Approval and Supplier Approval group boxes has been changed 
to Date/Time, and now displays both the date and time of the invoice approval. 

 A Notes field has been added to the Internal Approval and Supplier Approval group boxes so 
you can enter or view notes regarding the invoice approval. 

Create Subcontractor Invoices (SMPINVC) 
This application has been updated to distinguish if the invoice was created directly from this screen or 
from the Manage Invoices (SPMINVC) application. 
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Supplier Portal-Digital Signature for Invoices 
This feature allows you to utilize digital signature technologies to make your Supplier Portal invoice 
transactions legally binding even without the physical signed copies of the invoices. On the Manage 
Invoices screen, if you and the vendor are set up for a digital signature, the Approved check box in the 
Supplier Approval group box will be disabled and there will be a sign option in the toolbar. Both parties 
will approve the invoice by signing the document with a FIDO (Fast ID Online) device, which will save the 
approved information and user-specific keys in a separate table. This technology provides a high level of 
assurance and accuracy for both parties during the agreement process. 

 

Manage Vendors (APMVEND) 
The Enable Digital Signature check box has been added to the Manage Vendors screen. If you are 
licensed for Supplier Portal, you can use this check box to allow a vendor to use a digital signature to 
approve invoices associated to them.  

If you are not licensed for Supplier Portal, the Enable Digital Signature check box is hidden. 

If you select the Enable Digital Signature check box for a vendor and you and/or the vendor digitally 
signs an invoice, that invoice or a voucher created from that invoice can no longer be deleted. Any 
discrepancy must be fixed through a correcting invoice. Likewise, you will not be able to change the 
digital signature setting while there are existing unposted vouchers or partially approved invoices for that 
vendor.  

If you are licensed for Supplier Portal and you do not select the Enable Digital Signature check box, you 
and the vendor can approve invoices using the Approved check box on the Manage Invoices screen. If 
you and the vendor both approve a voucher without a digital signature, you can still delete the approved 
voucher, but the vendor cannot. 

Manage Purchase Order Vouchers (POMPOVCH) 
The Manage Purchase Order Vouchers screen has been updated to prohibit you or a Supplier Portal user 
from deleting any voucher created from a digitally signed invoice. Any discrepancy must be fixed through 
a correcting invoice. 

This functionality applies only if the Digital Signature feature is enabled for you and the Supplier Portal 
user. 

Manage Subcontractor Invoices (SMMMINVC) 
This application has been updated to prohibit deletion of an invoice or invoice line if you or the 
subcontractor/supplier has digitally signed the invoice. You can delete a digitally signed invoice only after 
both parties have unsigned it.  

Approve Subcontractor Invoices (SMMAINVC) 
If digital signature applies to the invoice, the Approved check box in the Internal Approval group box is 
disabled and the Sign drop-down list becomes available on the application toolbar. All options in this list 
are active if digital signature is on, the invoice is a digital signature document, and you are using a FIDO 
device. You can select from the following options: 

 Sign: Select this option to digitally sign the invoice. Once selected, Costpoint displays a 
disclosure agreement that you need to acknowledge. After you accepted the disclosure 

Note: For more information about this enhancement, see the Digital Signature Admin Updates. 
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agreement, Costpoint asks you to confirm the displayed data. Upon confirmation, the system 
saves the invoice data with the digital signature, and the Approved check box will automatically 
be selected but still disabled.  

 Verify: Select this option to view differences between what was last signed and what is on the 
screen. This option can be used only on invoices that were signed by either the internal approver 
or the supplier but not both. 

 Info: Select this option to view the last information that was digitally signed.  

 Unsign: Select this option to withdraw approval of a previously signed invoiced. The Approved 
check box becomes cleared when you select this option. 

The Notes field in the group box remains editable even after you digitally signed the invoice (but not yet 
signed by the subcontractor/supplier) to allow communication between the two parties.  

Digital document types are set up on the Manage Digital Document Types screen, while digital signature 
links are set up on the Manage Digital Document Links screen. If digital signature is on and you have 
already established the correct document types but the digital signature links have not been set up for the 
Approve Subcontractor Invoices application, Costpoint displays an error message when you try to digitally 
sign an invoice. 

 

Manage Invoices (SPMINVC) 
On the Manage Invoices screen, when an invoice is digitally signed, the Approved check box in the 
Supplier Approval group box cannot be edited, and deletion of the invoice or invoice line is not allowed. 
For supplier-created invoices, digital signature will be required if this is enabled for the associated vendor, 
regardless of the Require Subcontractor Approval setting in Configure Subcontractor Management 
Settings, since approval also submits the invoice for payer approval.  

The Notes field in the group box remains editable even after you digitally signed the invoice to allow 
communication between the two parties. If the digital signature function is on, but the digital signature 
links have not been set up for the Manage Invoices application, Costpoint displays an error message. 

Expanding Notes Fields 
This enhancement allows you to add/view more information in the PO Line Expediting Notes and 
Internal Notes fields (for purchase orders) as well as the Requisition Internal Notes field (for purchase 
requisitions) in Costpoint. It will enable you to input/display more characters and help eliminate the need 
of sending another email just to add the information that you were unable to add to the PR/PO due to 
input field constraints. 

For both MSS and Oracle database users, the data type can now accommodate up to 99999 characters.  

Manage Detailed Part Schedule (MRMDTPT) 
The Expedite Notes field of the Manufacturing Order Supply subtask now displays more than 254 
characters. 

Create MO Subcontractor Requisitions (PCMSCRQ) 
You can now enter more than 254 characters in the Internal Notes field of the requisition Line. 

Note: Digital signature for invoice approvals is allowed only if you are licensed for Supplier Portal. If 
that license is on, the Supplier Approval group box on this screen is disabled since suppliers can 
approve invoices via the portal. 
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Expedite Purchase Orders (POMEXPD) 
You can now enter more than 254 characters in the PO Line Expediting Notes and PO Line Internal 
Notes fields 

Manage Purchase Orders (POMMAIN) 
You can now enter more than 254 characters in the standard PO Notes and PO line Internal Notes 
fields. 

Update Subcontract Retainage PO Status (POMSCST) 
The following notes fields now displays more than 254 characters: 

 Subcontract Line Notes 

 Subcontract Line Internal Notes 

 Subcontract Line Expedite Notes 

Create Blanket Purchase Order Releases (POMRELS) 
From the blanket order, the PO line expediting notes and internal notes with more than 254 characters 
can now be carried over to the release order. 

Apply PO Info to Purchase Requisitions by Line (PPMRQLN)  
You can now enter more than 254 characters in the Internal Notes field of the Apply PO Info to Purchase 
Requisitions by Line and on the following screens: 

 Manage Purchase Requisitions (PPMNTRQ1)  

 Apply PO Info to Purchase Requisitions (PPMNTRQ2)  

 Approve Purchase Requisitions Line (PPMRQAPL) 

 Approve Purchase Requisitions (PPMRQAPX)  

Manage Simple Purchase Requisitions (PPMQREQ) 
This application can now display more than 254 characters for the header notes. 

Manage Work Assignments (SMMWRK) 
This application can now display more than 254 characters for the standard and internal notes. 

View Item Purchasing Information (PPQITEM) 
The expediting notes can now display more than 254 characters of the View Item Purchasing Information 
and on the following screens: 

 View Part Inventory 

 View Item Purchasing Information  

 View Part Inventory 

 View Summary Part Availability 

 View Part Inventory 



Materials 

Release Notes for Version 8.0 84 

 

 View Part Inventory 

 View Item Purchasing Information 

 View Purchase Order Status 

 View Purchase Order Status 

 View Work Assignment Status 

 View Item Purchasing Information 

View Purchase Requisition Status (PPQRQSTS) 
The internal notes can now display more than 254 characters. 

Print Purchase Order Expediting Report (POREXPD) 
The PO line expediting and internal notes in the report output can now display more than 254 characters 
on the Print Purchase Order Expediting Report and on the following screens: 

 Print Purchase Order Expediting Report 

 Print Purchase Requisitions 

Export Project Manufacturing Data (LDPEXPM) 
You can now export more than 254 characters of PO line expediting and internal notes. 

Archive Purchase Orders (POPARCH) 
You can now archive more than 254 characters of PO line expediting and internal notes. 

Create Purchase Orders (PPPGPO) 
The application can now carry over the requisition line internal notes with more than 254 characters to the 
PO line internal notes of the created PO. 

Import Purchase Requisitions (AOPRQPP) 
You can now enter more than 254 characters of internal notes in the requisition line input file for 
Delimited file format. 

Autoload Standard Text Options for Lines 
This enhancement allows you to choose a setting that will automatically add specific item standard text to 
the line level of a purchase order, purchase requisition, sales order, bills of materials, or manufacturing 
order that you have chosen in the Where-Used subtask if the item is included in the purchase order, 
purchase requisition, or other transactions associated with any one of the previously mentioned 
documents. Additional item text or project item text that may have been added after the initial autoload 
can be loaded by using the Autoload button. 

Release Manufacturing Bills of Material (BMMMBOM2) 

On the Component Text subtask, Costpoint now automatically loads the standard text code/revision 
combination associated with the part/part/item/revision on the BOM line for your user’s company when 
the following are set in Manage Parts: 
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 The Text Active check box is selected. 

 The Autoload check box is selected. 

 Where-Used is set to Bills of Material (BOM). 

The Autoload Active check box option has been removed from the screen as it has the same function as 
the Text Active check box. 

You can use the Autoload button to load any item text that may have been added after the initial 
autoload. In addition, when you change the part/item/revision, Costpoint automatically loads, upon save, 
the standard text based on the new part/item/revision. 

 

These changes also apply to the Manage Manufacturing Bills of Material (BMMMBOM1) screen. 

 

Release Engineering Bills of Material (BMMEBOM2) 
On the Component Text subtask, Costpoint now automatically loads the active standard text 
code/revision combination associated with the part/item/revision on the BOM line for your user’s company 
when the following are set on the Assigned Standard Text subtask of the Manage Parts: 

 The Text Active check box is selected. 

 The Autoload check box is selected. 

 Where-Used is set to Bills of Material (BOM). 

The Autoload Active check box option has been removed from the screen as it has the same function as 
the Text Active check box. 

You can use the Autoload button to load any item text that may have been added after the initial 
autoload. In addition, when you change the part/item/revision, Costpoint now automatically loads, upon 
save, the standard text based on the new part/item/revision. 

 

These changes also apply to the Manage Engineering Bills of Material (BMMEBOM1). 

 

Manage Purchase Requisitions (PPMNTRQ1) 
On the Line Text subtask, Costpoint now automatically loads the active standard text code/revision 
combination associated with the part/item/revision on the requisition line for the project used for your 
user’s company when the following are set: 

Note: You don’t have to click the Autoload button nor open the subtask for the automatic loading to 
happen. 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 

Note: You don’t have to click the Autoload button nor open the subtask for the automatic loading to 
happen. 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 
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 The Text Active check box is selected on the Assigned Standard Text subtask of the Manage 
Parts screen and in Manage Standard Text (PJMTEXT). 

 The Autoload check box is selected on the Assigned Standard Text subtask of the Manage Parts 
screen and in Manage Standard Text (PJMTEXT). 

 Where-Used is set to R (Purchase Requisition) or P, or P1–P5 (PO types if the Subcontractor 
Agreement check box is not selected), or P6–P8 (PO types if the Subcontractor Agreement 
check box is selected). 

You can use the Autoload button to load any item text or project item text that may have been added 
after the initial autoload. In addition, when you change the part/item/revision, inventory abbreviation, or 
project, Costpoint now automatically loads, upon save, the item text/project item text based on the new 
part/item/revision, inventory abbreviation or project ID. 

 

These changes also apply to the following screens: 

 Apply PO Info to Purchase Requisitions by Line (PPMRQLN) 

 Approve Purchase Requisitions (PPMRQAPX) 

 Approve Purchase Requisition Lines (PPMRQAPL) 

 Apply PO Info to Purchase Requisitions (PPMNTRQ2) 

 

Manage Request for Quotes by Item (PPMRFQI)  
On the Line Standard Text subtask, Costpoint now automatically loads the active standard text 
code/revision combination associated with the part/item/revision on the RFQ and for the Project(s) for 
your user’s company when the following are set: 

 The Text Active check box is selected on the Assigned Standard Text subtask of the Manage 
Parts screen and in Manage Standard Text (PJMTEXT). 

 The Autoload check box is selected on the Assigned Standard Text subtask of the Manage Parts 
screen and in Manage Standard Text (PJMTEXT). 

 Where-Used = Q (Request for Quotes), and if the requisition has the Subcontractor Agreement 
check box selected, or autoload text/rev only if it also has a Where-Used of P or P6–P8 (in 
addition to a Where-Used of Q). 

You can use the Autoload button to load any item text or project item text that may have been added 
after the initial autoload. In addition, when you change the part/item/revision, inventory abbreviation, or 
project, Costpoint now automatically loads, upon save, the item text/project item text based on the new 
part/item/revision, inventory abbreviation or project ID. 

 

These changes also apply to the Manage Request for Quotes by Vendor (PPMRFQV) screen. 

Note: You don’t have to click the Autoload button nor open the subtask for the automatic loading to 
happen. 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 

Note: You don’t have to click the Autoload button nor open the subtask for the automatic loading to 
happen. 
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Manage Purchase Orders (POMMAIN) 
On the Line Text subtask, Costpoint now automatically loads the active standard text code/revision 
combination associated with the part/item/revision on the RFQ and for the Project(s) for your user’s 
company when the following are set: 

 The Text Active check box is selected on the Assigned Standard Text subtask of the Manage 
Parts screen and in Manage Standard Text (PJMTEXT). 

 The Autoload check box is selected on the Assigned Standard Text subtask of the Manage Parts 
screen and in Manage Standard Text (PJMTEXT). 

 Where-Used is set to PO types P or P1–P8. 

You can use the Autoload button to load any item text or project item text that may have been added 
after the initial autoload. In addition, when you change the part/item/revision, inventory abbreviation, or 
project, Costpoint now automatically loads, upon save, the item text/project item text based on the new 
part/item/revision, inventory abbreviation or project ID. 

 

 

Manage Sales Orders (OEMNTSO1) 
On the Line Standard Text subtask, Costpoint now automatically loads the active standard text 
code/revision combination associated with the part/item/revision on the sales order line and for the 
Project(s) for your user’s company when the following are set: 

 The Text Active check box is selected on the Assigned Standard Text subtask of the Manage 
Parts screen and in Manage Standard Text (PJMTEXT). 

 The Autoload check box is selected on the Assigned Standard Text subtask of the Manage Parts 
screen and in Manage Standard Text (PJMTEXT). 

 Where-Used is set to Sales Order Acknowledgment. 

You can use the Autoload button to load any item text or project item text that may have been added 
after the initial autoload. In addition, when you change the item and/or sales group abbreviation, 
Costpoint now automatically loads, upon save, the item text/project item text based on the new inventory 
abbreviation or project ID. 

 

These changes also apply to the Manage Sales Orders Supervisor Screen (OEMNTSO2). 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 

Note: You don’t have to click the Autoload button nor open the subtask for the automatic loading to 
happen. 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 

Note: You don’t have to click the Autoload button nor open the subtask for the automatic loading to 
happen. 
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Manage Invoices (OEMINVC1) 
On the Line Standard Text subtask, Costpoint now automatically loads the active standard text 
code/revision combination associated with the part/item/revision on the sales order line to the invoice line 
for your user’s company when the following are set: 

 The Text Active check box is selected. 

 Where-Used is set to Sales Order Invoice (I) or DD250 Invoices (D). 

You can use the Autoload SO Line Text/Autoload Line Text buttons to load any item text or project 
item text that may have been added after the initial autoload.  

In addition, when you change the part/item/revision, Costpoint now automatically loads, upon save, the 
item text/project item text based on the new part/item/revision and/or sales group abbreviation projects.  

 

These changes also apply to the Manage Invoices Supervisor Screen (OEMINVC2). 

 

Compute Material Requirements (PCPMRR) 
Costpoint now automatically loads the active item text and/or item project text to the new requisition lines 
based on the text code and revision, and when the following are set: 

 The Text Active check box is selected on the Assigned Standard Text subtask of the Manage 
Parts screen and in Manage Standard Text (PJMTEXT). 

 The Autoload check box is selected on the Assigned Standard Text subtask of the Manage Parts 
screen and in Manage Standard Text (PJMTEXT). 

 Where-Used is set to PO-All PO Types (P), Purchase Requisition (R), or PO-Purchase Order 
(Standard) (P1), PO-Blanket Order (P2), PO-Blanket Release Order (P3), PO-GFM/GFE Order 
(P4), and PO-Subcontract Retainage PO (P5). 

 

If the text code/rev is inactive upon the creation of the requisition, then Costpoint will not copy it over to 
the requisition. 

Create Invoices (OEPINVC) 
Costpoint now automatically loads the active sales order line’s text code/revision to the new sales order 
invoice based on text code and revision for your user’s company and the standard text code/revision 
combinations associated part/project in the sales order line and when the following are set: 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 

Note: You don’t have to click the Autoload button nor open the subtask for the automatic loading to 
happen. 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 



Materials 

Release Notes for Version 8.0 89 

 

 The Text Active check box is selected. 

 Where-Used is set to Sales Order Invoice (I) or DD250 Invoices (D). 

 

If the text code/rev is inactive upon the creation of the requisition, then Costpoint will not copy it over to 
the requisition. 

Import Purchase Orders (AOPUTLPO) 
Costpoint now automatically loads the active standard text code/revision combination associated with the 
part/item/revision on the purchase order line and for the project(s) used for your user’s company when the 
following are set: 

 The Text Active check box is selected on the Assigned Standard Text subtask of the Manage 
Parts screen and in Manage Standard Text (PJMTEXT). 

 The Autoload check box is selected on the Assigned Standard Text subtask of the Manage Parts 
screen and in Manage Standard Text (PJMTEXT). 

 Where-Used is set to  PO-All PO Types (P), PO-Purchase Order (Standard) (P1), PO-Blanket 
Order (P2), PO-Blanket Release Order (P3), PO-GFM/GFE Order (P4), PO-Subcontract 
Retainage PO (P5), PO-Subcontractor Agreement (P6), PO-Subcontractor Agreement Blanket 
(P7), and PO-Subcontractor Agreement Release (P8). 

For existing PO lines, when you change the part/item/revision and/or inventory abbreviation for a 
particular line in the PO line record type and there are no PO line standard text line record types in the 
input file, Costpoint now automatically loads, upon save, the standard text code/revision combinations 
associated with the new part/item/revision on the PO line and for the project(s) used for your user’s 
company. 

 

Import Purchase Requisitions (AOPRQPP) 
Costpoint now automatically loads the active active standard text code/revision combination associated 
with the part/item/revision on the requisition line and for the project(s) used for your user’s company when 
the following are set: 

 The Text Active check box is selected on the Assigned Standard Text subtask of the Manage 
Parts screen and in Manage Standard Text (PJMTEXT). 

 The Autoload check box is selected on the Assigned Standard Text subtask of the Manage Parts 
screen and in Manage Standard Text (PJMTEXT). 

 Where-Used is set to  Purchase Requisition (R), PO-All PO Types (P), PO-Purchase Order 
(Standard) (P1), PO-Blanket Order (P2), PO-Blanket Release Order (P3), PO-GFM/GFE Order 
(P4), and PO-Subcontract Retainage PO (P5). 

For existing PO lines, when you change the part/item/revision and/or inventory abbreviation for a 
particular line in the PO line record type and there are no PO line standard text line record types in the 
input file, Costpoint now automatically loads, upon save, the standard text code/revision combinations 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 
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associated with the new part/item/revision on the PO line and for the project(s) used for your user’s 
company. 

 

Import Sales Orders (AOPSOPP) 
Costpoint now automatically loads the active standard text code/revision combination associated with the 
part/item/revision on the sales order line and for the project(s) used for your user’s company when the 
following are set: 

 The Text Active check box is selected on the Assigned Standard Text subtask of the Manage 
Parts screen and in Manage Standard Text (PJMTEXT). 

 The Autoload check box is selected on the Assigned Standard Text subtask of the Manage Parts 
screen and in Manage Standard Text (PJMTEXT). 

 Where-Used is set to Sales Order Acknowledgment (S). 

 

Import Bills of Material (AOPBOM) 
Costpoint now automatically loads the active standard text code/revision combination associated with the 
part/item/revision on the sales order line and for the project(s) used for your user’s company when the 
following are set on the Assigned Standard Text subtask of the Manage Parts screen: 

 The Text Active check box is selected. 

 The Autoload check box is selected. 

 Where-Used is set to Bills of Material (B). 

Create Purchase Orders (PPPGPO) 
Costpoint now automatically loads the active standard text code/revision combination associated with the 
part/item/revision on the purchase order line and for the project(s) used for your user’s company when the 
following are set: 

 The Text Active check box is selected on the Assigned Standard Text subtask of the Manage 
Parts screen and in Manage Standard Text (PJMTEXT). 

 The Autoload check box is selected on the Assigned Standard Text subtask of the Manage Parts 
screen and in Manage Standard Text (PJMTEXT). 

 Where-Used is set to PO-All PO Types (P), PO-Purchase Order (Standard) (P1), PO-Blanket 
Order (P2), PO-Blanket Release Order (P3), PO-GFM/GFE Order (P4), PO-Subcontract 
Retainage PO (P5), PO-Subcontractor Agreement (P6), PO-Subcontractor Agreement Blanket 
(P7), and PO-Subcontractor Agreement Release (P8). 

 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 
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Manage Parts (PDMPART) 
On the Assigned Standard Text subtask, the Autoload Active field name has been shortened to 
Autoload to avoid confusion with Text Active. This change also applies to the following screens: 

 Manage Services (PDMSERV) 

 Manage Goods (PDMGOODS) 

 

Manage Standard Text (PJMTEXT) 
The Autoload Active field name has been shortened to Autoload to avoid confusion with Text Active. 

Manage Manufacturing Orders (PCMMOMNT) 
On the Line Text subtask, Costpoint now automatically loads the active standard text code/revision 
combination associated with the part/item/revision on the build part and for the project(s) used for your 
user’s company when the following are set: 

 The Text Active check box is selected on the Assigned Standard Text subtask of the Manage 
Parts screen and in Manage Standard Text (PJMTEXT). 

 The Autoload check box is selected on the Assigned Standard Text subtask of the Manage Parts 
screen and in Manage Standard Text (PJMTEXT). 

 Where-Used is set to MO Pick List (M), MO Routing Traveler (T), or MO Assembly Sheet Header 
(A). 

 

You can use the Autoload button to load any item text or project item text that may have been added 
after the initial autoload.  

 

View Bills of Materials (BMQSMLB) 
On the Line Text subtask, the Autoload Active field on the Component Text subtask has been removed 
from the View Bills of Materials and View Where-Used Bills of Materials screens to make them consistent 
with other screens. 

View Items (PDQINQ) 
On the Std Text subtask, the Autoload Active field name has been shortened to Autoload to avoid 
confusion with Text Active. 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 

Note: You don’t have to click the Autoload button nor open the subtask for the automatic loading to 
happen. 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 
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Apply Engineering Change Notice (ECPINECN) 
Costpoint now automatically loads the active component standard text code/revision when the Copy Text 
When Replacing Parts In BOMs check box is not selected, and also automatically loads the active item 
standard text code/revision (from the original part to the change-to part) when Copy Original Part Info is 
not selected on the ECN row. 

 

Copy Bill of Materials (BMPCOPY) 
Costpoint now automatically loads the active component standard text code/revision when the Copy 
Component BOM Text Codes check box is not selected. If a standard text code/revision assigned to a 
component part/rev is currently inactive, and the Active check box in Manage Standard Text and the 
Autoload check box on the Assigned Standard Text subtask of Manage Parts are both not selected, the 
component standard text code/revision will not be loaded in the copied BOM. 

Apply Mass Component Changes to Bills of Material (BMPMCC) 
Costpoint now automatically loads the active component standard text code/revision when the Copy 
Existing BOM Text check box is not selected. If a standard text code/revision assigned to a component 
part/rev is currently inactive, and the Active check box in Manage Standard Text and the Autoload check 
box on the Assigned Standard Text subtask of Manage Parts are both not selected, the component 
standard text code/revision will not be loaded in the copied BOM. 

Initiate PO and PR from Manage Subcontracts 
Costpoint now allows you to initiate a purchase order/purchase requisition (PO/PR) from the Manage 
Subcontracts screen and have Subcontract data default in when you enter a subcontract ID.  

You can do this by initiating the Purchase Order or Purchase Requisition from Manage Subcontracts and 
linking the PO/PR records to a subcontract record using the Subcontract ID field of the new Subcontract 
Information tab on the Manage Purchase Requisitions and Manage Purchase Orders screens. Upon 
linking, Costpoint then updates the subcontract record in Manage Subcontracts with the details entered in 
the PO/PR screens. 

 

The following screens have been updated for this feature. 

Manage Purchase Requisitions (PPMNTRQ1) 
You can now link a requisition record to a subcontract record in Manage Subcontracts using the new 
Subcontract Information tab on this screen. For new requisitions, you can link the requisition record to an 
existing subcontract record that can be accessed using the Subcontract Name field. When you enter (or 
modify, in the case of an existing requisition) a subcontract ID, the Subcontractor Agreement check box 
on the Header tab is automatically selected, while the following information are loaded by default and 
cannot be modified: US citizenship required, vendor, and preferred vendor. 

Note: For items and projects with similar standard text code/revision, the standard text code/revision 
will be displayed once. 

Note: For more information about this enhancement, see Initiate Purchase Orders and Purchase 
Requisitions from Manage Subcontracts. 
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In the requisition line, when you enter or modify the subcontract ID, the following values are loaded by 
default: US Citizenship Required, Preferred Vendor, and Period of Performance Start/End Dates. 

Apply PO Info to Purchase Requisitions (PPMNTRQ2) 
You can now link a requisition record to a subcontract record in Manage Subcontracts using the new 
Subcontract Information tab on this screen. For new requisitions, you can link the requisition record to an 
existing subcontract record that can be accessed using the Subcontract Name field. When you enter (or 
modify, in the case of an existing requisition) a subcontract ID, the Subcontractor Agreement check box 
on the Header tab is automatically selected, while the following information are loaded by default and 
cannot be modified: US citizenship required, vendor, and preferred vendor.  

 

In the requisition line, when you enter or modify the subcontract ID, the following values are loaded by 
default: US Citizenship Required, Preferred Vendor, and Period of Performance Start/End Dates. 

On the Assign PO and Assign PO-Combined subtasks, when you enter the subcontract ID, the following 
values are loaded by default from the subcontract record: Vendor, US Citizenship Required, and 
subcontractor agreement PO type. Costpoint also validates the requisition's subcontract ID against the 
PO's subcontract ID. 

Apply PO Info to Purchase Requisitions by Line (PPMRQLN) 
When you do a PO/Release lookup for a requisition associated to a subcontract record, Costpoint will 
display records that match the vendor of the subcontract record. For new lines, as well as autoloaded 
lines, US citizenship required, vendor, and subcontractor agreement PO type values are loaded by 
default. Costpoint also validates the requisition's subcontract ID against the PO's subcontract ID. If you 
need to modify the vendor, you can do this on the Manage Subcontracts or Manage Vendors screens.  

For requisition lines linked to different subcontract records, Costpoint splits these into several POs based 
on the subcontract ID, even if these records have the same vendor. 

Approve Purchase Requisitions (PPMRQAPX) 
You can now access the subcontract record associated with a requisition by clicking the subcontract ID in 
the Subcontract field. The link takes you to the subcontract record on the Manage Subcontracts screen. 

This change also applies to the following screens: 

 Approve Purchase Requisition Lines (PPMRQAPL) 

 Assign Purchase Requisitions to Buyers (PPMBUYAS) 

 Assign Purchase Requisition Lines to Buyers (PPMBUYAL) 

 

Note: If you need to edit the vendor value, you can do so on the Manage Subcontracts or Manage 
Vendors screens. 

Note: If you need to edit the vendor value, you can do so on the Manage Subcontracts screen. 

Note: This field is available only if you are licensed for Contract Management. 
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Manage Purchase Order Header Information (PPMPOHDR) 
You can now access the subcontract record associated with a purchase order by entering the subcontract 
ID in the new Subcontract ID field. When you enter the subcontract ID, it automatically populates the 
new Subcontract Name field, which links to the subcontract record. You can click the link in the 
Subcontract Name field to access the subcontract record in Manage Subcontracts. 

When you enter a subcontract ID, Costpoint automatically loads the default values for the vendor, NAICS 
code, and period of performance starting/ending date. 

Upon save, Costpoint validates the default vendor to ensure that it’s not a payroll vendor, is active, and 
has an approved status. 

Create Purchase Orders (PPPGPO) 
When you create a new purchase order using previously planned PO header information, Costpoint now 
copies the subcontract ID from the requisition or PO header to the PO. 

View Purchase Requisition Status (PPQRQSTS) 
You can now access the subcontract record associated with a requisition by clicking the subcontract ID in 
the Subcontract field. The link takes you to the subcontract record on the Manage Subcontracts screen. 

Manage Request for Quotes by Item (PPMRFQI) 
On the header and the child table window (CTW), a new Subcontract field has been added to display the 
subcontract ID linked to the requisition. Click the new Subcontract field to access the subcontract record 
in Manage Subcontracts.  

When you enter a new item associated with a subcontract, Costpoint loads the vendor and vendor 
information and makes the Vendor field unavailable. Upon save, Costpoint validates the default vendor to 
ensure that it’s not a payroll vendor, is active, and has an approved status. 

If the requisition corresponding to the subcontract has the Subcontractor Agreement check box 
selected, the RFQ’s Subcontractor Agreement check box follows suit and will be disabled; otherwise, 
the RFQ's Subcontractor Agreement check box is cleared and can be edited. 

When you do a lookup, Costpoint displays RFQs with vendors matching that of the subcontract (if 
loaded). The lookup also includes RFQs without any subcontract reference. When you enter an RFQ 
vendor and it does not match the subcontract vendor and US citizenship requirement, Costpoint will 
display an error. 

Manage Request for Quotes by Vendor (PPMRFQV) 
On the header and the child table window (CTW), a new Subcontract field has been added to display the 
subcontract ID linked to the requisition. Click the new Subcontract field to access the subcontract record 
in Manage Subcontracts. 

When you enter a new record for a requisition with a subcontract, Costpoint loads the associated vendor 
and other vendor-related information, and makes the Vendor and US Citizenship fields unavailable. 
Upon save, Costpoint validates the default vendor to ensure that it’s not a payroll vendor, is active, and 
has an approved status. 

For existing records, you can change the previously saved requisition as long as the request for quote 
vendor and US citizenship requirement of the requisition matches the new subcontract. 

The requisition record corresponding to the subcontract follows after the Subcontractor Agreement 
check box of the record, whether it is selected (unavailable) or cleared (editable). 
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Manage Vendor Quotes by Item (PPMQTI) 
On the header and the child table window (CTW), a new Subcontract field has been added to display the 
subcontract ID linked to the requisition. Click the new Subcontract field to access the subcontract record 
in Manage Subcontracts. 

When you enter a new record for a requisition with a subcontract, Costpoint loads the associated vendor 
and other vendor-related information and makes the Vendor and US Citizenship fields unavailable. 
Upon save, Costpoint validates the default vendor to ensure that it’s not a payroll vendor, is active, and 
has an approved status. 

The Subcontractor Agreement check box is selected and editable if there is no RFQ reference. If an 
RFQ exists in the header, the subcontractor agreement option loads the default value to the 
subcontractor agreement selection for the RFQ. For existing records, you can change the previously 
saved requisition as long as the request for quote vendor and US citizenship requirement of the 
requisition matches the new subcontract. 

Manage Vendor Quotes by Vendor (PPMQTV) 
On the header and the child table window (CTW), a new Subcontract field has been added to display the 
subcontract ID linked to the requisition. Click the new Subcontract field to access the subcontract record 
in Manage Subcontracts. 

When you enter a new record for a requisition with a subcontract, Costpoint loads the associated vendor 
and other vendor-related information and makes the Vendor and US Citizenship fields unavailable. 
Upon save, Costpoint validates the default vendor to ensure that it’s not a payroll vendor, is active, and 
has an approved status. 

The Subcontractor Agreement check box is selected and editable if there is no RFQ reference. If an 
RFQ exists in the header, the subcontractor agreement option defaults to the subcontractor agreement 
selection for the RFQ. For existing records, you can change the previously saved requisition as long as 
the request for quote vendor and US citizenship requirement of the requisition matches the new 
subcontract. 

Manage Purchase Orders (POMMAIN) 
You can now link a purchase order (PO) record to a subcontract record in Manage Subcontracts using 
the new Subcontract Information tab on this screen. For new purchase orders (PO), you can link the PO 
to an existing subcontract record that can be accessed using the Subcontract Name field. When you 
enter (or modify, in the case of an existing requisition) a subcontract ID, the Subcontractor Agreement 
check box on the Header tab is automatically selected, while the following information are loaded by 
default and cannot be modified: US citizenship required, vendor, and preferred vendor. 

 

In addition, this screen has been updated so that when you enter/modify the subcontract ID, the default 
values for the US Citizenship Required, Vendor, and Period of Performance Start/End fields are 
loaded and become unavailable (PO header and PO line). The default PO type (subcontractor 
agreement) is also loaded but remains editable. 

For POs generated from a requisition with subcontract reference, the Subcontract ID field cannot be 
edited. Upon save, Costpoint validates the vendor to ensure that the vendor is not a payroll vendor, is 
active, and has an approved status. 

Note: If you need to edit the vendor value, you can do so on the Manage Subcontracts screen. 
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Manage Buyer Actions (POMBACT) 
A new Subcontract field has been added to display the subcontract ID linked to the PO/Rlse. Click the 
Subcontract field to access the subcontract record in Manage Subcontracts. 

Import Purchase Orders (AOPUTLPO) 
The following are the changes to the Import Purchase Orders screen, with the condition that a 
subcontract ID exists on the PO header: 

 For a new PO, if a Subcontract ID is in the input file: 

 Load the vendor associated with the subcontract on the PO vendor, overriding the input file 
vendor. 

 Load the US Citizenship Required flag (Y/N) associated with the subcontract in the similar 
field in PO header and PO lines. 

 Load the Period of Performance Start/End Dates associated with the subcontract into similar 
fields in PO header and PO lines. 

 Load PO Type = Subcontractor Agreement (“A”), but only if no value is provided in the input 
file. 

 For an existing PO with no action done (no receipts, vouchers, or blanket releases), if a 
Subcontract ID is in the input file, it will replace any existing Subcontract ID, along with associated 
vendor, US Citizenship Required flags, Period of Performance Start/End dates, and PO type (if 
no value is provided in the input file). 

 For an existing PO with some action done (receipts, vouchers, or blanket releases exist), PO 
vendor and other flags cannot be changed, so if a Subcontract ID is in the input, it will be ignored. 

Import Purchase Requisitions (AOPRQPP) 
A new Subcontract ID column has been added in the input file to load requisition subcontract 
information. For new requisitions with a subcontractor ID in the input file, Costpoint loads the following, 
overriding any input file values: 

 The vendor associated with the subcontract in the preferred Vendor field on the requisition line 

 US Citizenship Required (Y/N) into similar flags at the Requisition header and line 

 Period of Performance Start/End dates into similar fields on the Requisition line (ignoring any 
input file values) 

In addition, Costpoint uses the subcontractor agreement flag value in the input file. However, if the input 
file does not have a subcontractor agreement flag value, but the header has subcontractor ID, the 
subcontractor agreement is set to Y by default. 

Import Vendor Quotes (AOPQTV) 
The Import Vendor Quotes screen has been updated so that when an input file has an RFQ with a 
requisition reference that is associated with a subcontract ID (RQ_HDR.SUBCNTR_ID), the Vendor 
column name becomes optional because the process will automatically use the vendor associated with 
the subcontract instead of the input file value. 

Create Journal Entries from Standard Costing Updates 
This enhancement allows you to create cost adjustment transactions, see the impact of the cost 
adjustments made to standard costing, and post them to the general ledger (GL). 
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The following screens have been updated for this feature. 

Set Up Company (SYPCOMP) 
This screen now copies the values of the new Standard Cost Updates group box on the Configure 
Product Definition Settings screen from the original company when you create a new company and copy 
the settings from an existing company. 

Configure Product Definition Settings (PDMITMRU) 
You can now indicate updates to standard costing using the new Standard Cost Updates group box.  

This new group box has the following check boxes: 

 Create Cost Adjustment Transactions: Use this check box to create cost adjustment 
transactions for the inventory quantities. This option defaults in the applications where standard 
cost adjustments can be made (manually or by a process).  If selected, cost adjustments will be 
automatically created for the updates made to standard costs for projects that use standard 
costing and on screens where this option is available. 

 Do Not Post to General Ledger: Use this check box to prevent the created cost adjustment 
transactions from posting to the general ledger. This option is available if you opted to create cost 
adjustment transactions. This option defaults in the applications where standard cost adjustments 
can be made (manually or by a process). 

Update Buy Part Standard Cost (PDPBSCST) 
This screen has the following new check boxes: 

 Create Cost Adjustment Transactions: Use this check box to create cost adjustment 
transactions for the inventory quantities of standard cost projects. This check box defaults to the 
option selected in Configure Product Definition Settings. 

 Do Not Post to General Ledger: Use this check box to prevent the created cost adjustment 
transactions from posting to the general ledger. This option is available if you opted to create cost 
adjustment transactions. 

This application now creates a cost adjustment inventory transaction to reflect the inventory value. In 
addition, you can now generate a supplement report to the Update report to see the impact of the 
standard cost change on inventory balances.  

 

Update Make Part Standard Cost (PDPMSCST) 
This screen has the following new check boxes: 

 Create Cost Adjustment Transactions: Use this check box to create cost adjustment 
transactions for the inventory quantities of standard cost projects. This check box defaults to the 
option selected in Configure Product Definition Settings. 

Note: You will encounter an error if the following occur: 

 If you select the Print/Update Buy Part Standard Cost option and adjustment account/orgs for 
common and allocated inventory is not specified in Configure Inventory Accounts for the 
logged-in company. 

 If an employee ID is not associated with the user who is creating the cost adjustment 
transactions for the cost updates. 
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 Do Not Post to General Ledger: Use this check box to prevent the created cost adjustment 
transactions from posting to the general ledger. This option is available if you opted to create cost 
adjustment transactions. 

This application now creates a cost adjustment inventory transaction to reflect the inventory value. In 
addition, you can now generate a supplement report to the Update report to see the impact of the 
standard cost change on inventory balances.  

Manage Parts (PDMPART) 
These new check boxes have been added on the Project Item Costs and Item Costs subtasks: 

 Create Cost Adjustment Transactions: This check box defaults to the option selected in 
Configure Product Definition Settings. If this is selected, Costpoint automatically creates cost 
adjustment transactions for each affected part/revision/inventory abbreviation when standard cost 
updates are processed and saved. 

 Do Not Post to General Ledger: This option is available if you opted to create cost adjustment 
transactions. If this check box is selected, the created cost adjustment transactions will not be 
posted to the general ledger. 

When you select Standard on these subtask, the Std Cost Inventory Impact subtask becomes available. 
The Std Inventory Impact subtask displays the total value of inventory that will be affected by the manual 
change to the standard cost for a particular project and follows the following conditions: 

 This only applies to standard cost rows.  

 If multiple rows exist for a particular project, apply this logic only to the currently effective row. 

 It will not include in the calculation the impact for rows that are currently ineffective. 

 It will display the impact to inventory before saving the change. 

 It will only include an inventory row if the calculated impacted quantity is not equal to zero. 

 It will display information if the cost is changed. 

 After saving a modified cost and querying back the record, the subtask will not display any 
information until another cost change is made. 

These changes also apply to the following screens: 

 Manage Item Costs (PDMCOST) 

 Manage Project Item Costs (PDMPRJCS) 

Costpoint Business Intelligence for Manufacturing & Procurement 
This Costpoint Business Intelligence (CBI) enhancement implements the Materials Organizational and 
Part security within the data models. This will allow you to suppress organization-specific data based on 
the Organization Security setup in Costpoint, as well as disallow visibility into reports or data that contain 
unauthorized parts based on the Part Security setup in Product Definition. This enhancement will also 
include two standard dashboards with insights into procurement and manufacturing data to help you 
make business decisions. 

 

The Procurement dashboard in CBI has three tabs: Purchasing, Requisitions, and Requisition to PO 
Conversion. 

Note: For more information about this enhancement, see Costpoint Business Intelligence 8.0. 
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The Purchasing tab displays the following charts: 

 Total value spent on procurement: Use this chart to see all the total purchases by purchase order 
(PO) types. 

 Number of active vendors: Use this chart to see the count or total number of vendors with Active 
status per Company ID. 

 Spend by commodity: Use this chart to see all the total purchases of the vendor by commodity. 
Lines without commodity will be included in a separate Null bucket, and you can choose to 
remove this filter. 

 Purchase orders (PO) status by supplier: Use this chart to see POs that are not yet fulfilled by the 
vendor.  

The Requisitions tab displays the following charts: 

 Requisitions awaiting approval by approver: Use this chart to see requisitions that are In-Approval 
by current approver and allow for action to be taken to move the requisitions through the pipeline. 

 Requisition status by requisitioner: Use this chart to see a count of requisition status by 
requisitioner. 

The Requisition to PO Conversion tab displays the following chart: 

 Approved requisitions awaiting PO conversion by buyer: Use this chart to see the number of 
requisitions that have been approved but are awaiting conversion to a PO.  

The Manufacturing dashboard in CBI displays the following charts: 

 Manufacturing Order (MO) production status: Use this chart to see the count or total number of 
MOs per status. 

 MO cycle time: Use this KPI to see the average number of days it takes in a phase for MOs.  

 MO planned date vs. actual date: Use these KPIs to see the planner performance by comparing 
planned dates vs. actual dates for both Release and In-Shop. 

 ECN Status: Use this chart to see ECNs in each open status and utilize the detailed drill through 
report to see Manufacturing Orders that may be impacted by an ECN for any build part or 
component part. 

Exclusion List Warning 
This new feature alerts you if a vendor is on the government exclusion list when creating a purchase 
order, request for quote, quote, or return for that vendor. 

GovWin IQ captures vendor information such as government exclusion list data from SAM.gov, and this 
information is updated weekly in Costpoint.  

During the creation of the purchase order, request for quote, quote, or return, a warning displays if the 
selected vendor is on the exclusion list. You can then decide whether or not to continue with that vendor 
for that transaction. 

Apply PO Info to Purchase Requisitions (PPMNTRQ2) 
When you enter/select a vendor that is included in the Denied Party List, Costpoint displays this warning 
message:  

This Vendor XXX is on the Exclusion List in SAM.gov. 

Type: VEND_EXCLS.EXCLS_TYPE description Active  
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Date: VEND_EXCLS.EXCLS_ACTIVE_DT Termination  

Date: VEND_EXCLS.EXCLS_TERM_DT Last Updated  

Date: VEND. LAST_GWIQ_SYNCH   

This change also applies to the following screens: 

 Apply PO Info to Purchase Requisitions by Line (PPMRQLN) 

 Manage Purchase Order Header Information (PPMPOHDR) 

 Manage Purchase Orders (POMMAIN) 

 Create Purchase Order Change Orders (POMCHNG) 

 Manage Vendor Quotes by Vendor (PPMQTV) 

 Manage Vendor Quotes by Item (PPMQTI) 

 Manage Request for Quotes by Vendor (PPMRFQV) 

 Manage Request for Quotes by Item (PPMRFQI) 

 Approve Pending Purchase Orders (POMSTAT) 

 Manage Vendor Returns (RCMRTRN) 

Create Blanket Purchase Order Releases (POMRELS) 
When the vendor associated to the blanket purchase order (PO) that you entered/selected is included in 
the Denied Party List, Costpoint displays this warning message:  

This Vendor XXX is on the Exclusion List in SAM.gov. 

Type: VEND_EXCLS.EXCLS_TYPE description Active  

Date: VEND_EXCLS.EXCLS_ACTIVE_DT Termination  

Date: VEND_EXCLS.EXCLS_TERM_DT Last Updated  

Date: VEND. LAST_GWIQ_SYNCH This Vendor XXX is on the Exclusion List in SAM.gov. 

 

Option to Default Estimate to Complete Percent 
This enhancement provides you with the option to use a default Estimate to Complete Percent value 
other than zero when creating manufacturing order (MO) partial reliefs. Not entering a value can cause an 
MO Costing error. When you set a default Estimate to Complete Percent, Costpoint will use that value as 
a default in the MO relief. This value can be edited on the Enter Manufacturing Order Reliefs screen. 

Configure Manufacturing Order Costing Options (PCMCSTOP)  
You now have an option to default estimate-to-complete percent value when creating manufacturing order 
partial reliefs. You can do this by entering the default ETC percentage in the new Default ETC % field. 

Note: For more information about this enhancement, see the GovWin IQ to Costpoint Vendor 
Integration feature. 
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Enter Manufacturing Order Reliefs (PCMRELMO) 
This screen now retrieves the default value from Default ETC % of the Configure Manufacturing Order 
Costing Options screen. 

Set Up Company (SYPCOMP) 
When you create a new company, the application will now include the new Default ETC % field from the 
Configure Manufacturing Order Costing Options screen. 

Add Revenue Recognition Field to the SO Approval Process 
This enhancement allows you to see the Revenue Recognition Method in the sales order (SO) details of 
the Approve Sales Orders screen without having to navigate to other screens at the time of approval. 

Approve Sales Orders (OEMAPPSO) 
You can now view the revenue recognition method on the SO details section. 

Add New Input File Fields to PO Preprocessor in Import Purchase 
Orders (AOPUTLPO) 
This enhancement allows you to import the purchase order (PO) header order date, PO line manufacturer 
ID, and the PO line NSN (National Stock Number) on the Import Purchase Orders screen. 

Reconcile Inventory Serial Lot Qty to Location Detail Qty  
This enhancement allows you to reconcile inventory serial/lot quantity to location detail quantity on the 
Reconcile Inventory Balances screen when the inventory table is out of sync with the serial/lot table. 

Reconcile Inventory Balances (INPRECON) 
You can now reconcile inventory serial/lot quantity to location detail quantity on the Reconcile Inventory 
Balances screen by selecting the new Reconcile Serial/Lot Qty check box. This check box is enabled 
when you select the Reconcile Inv Summary and Detail Qty to Transaction History option and Enable 
Inventory Serial/Lot Tracking is selected on the Configure Serial/Lot Settings screen 

This update is based on the current serial/lot tracking requirements at the part/project level (based on 
setup) or just the part level. Transactions with mismatched tracking requirements will be included in the 
exclusion report and will not be included in the calculations. 

There are multiple reports which show discrepancies between various tables. These reports are: 

 Report 1: This report displays the quantity mismatch between INVT_TRN_LN compared to 
INVT_TRN_LN_SR_LT. It can be viewed as sorted by Project or by Part/Rev. 

 Report 2: This report displays the quantity mismatch between INVT_TRN_LN_SR_LT compared 
to INVT_WHS_LOC_SR_LT. It can be viewed as sorted by Project or by Part/Rev. 

 Report 3: This report displays the quantity mismatch between INVT_TRN_LN_SR_LT compared 
to INVT_WHS_LOC_SR_LT. It can be viewed as sorted by Project or by Part/Rev. 

 Exclusion Report: This includes transaction lines that are excluded from the reconciliation 
process due to mismatch of serial/lot tracking requirements. It also includes transactions with the 
same combination of part/rev/inv abbrev as mismatched tracking transactions. 
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 Unreconciled Transactions Report: This includes transactions that are included in the 
reconciliation process but which could not be reconciled by the system due to various reasons, as 
noted in the report. 

Full Requirements Subtask and Order Reference Field to 
Requirements Subtask 
You can now use the new Full Reqmts subtask to view all requirements identified by the Materials 
Requirement Planning (MRP) process. In addition, order reference fields have been added to the 
Requirements subtask to enable you to view the same information from the Order Reference field of the 
MOs subtask. 

View Part Inventory 
You can now use the new Full Reqmts subtask added to the following screens to view all requirements 
identified by the Materials Requirement Planning (MRP) process:  

 View Part Inventory (INQPINV) 

 View Part Inventory (MRQPINV) 

 View Part Inventory (MSQPINV) 

 View Part Inventory (PCQPINV) 

In addition, order reference fields have been added to the Requirements subtask to enable you to view 
the same information from the Order Reference field of the MOs subtask. 
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Time & Expense 
This section describes version 8.0 enhancements for Costpoint Time and Expense. 

Improved Integration of Co-Deployed Installations 
Integration between Costpoint and Time & Expense has been improved for co-deployed installations so 
that you are no longer required to export/import the following links: 

 Link 12: UDT01/UDT02 (Account/Project or Account/MO)  

 Link 19: UDT01/UDT09 (Account/Org)  

 Link 27: UDT02/UDT07 (Project/PLC or MO/Routing) 

 Link 29: UDT02/UDT09 (Project/Org) 

The links are named for the UDTs being linked. For example, Link 12 is UDT01 linked with UDT02. 

 

No changes are required to use this enhancement if your systems are co-deployed, and if direct linking of 
UDTs is already enabled. However, to populate the new Link tables the first time, you must run the export 
from the People » Labor » Timesheet Interface » Export Data to Deltek Time and Expense screen. 

 

Because linked UDTs now display directly from Costpoint, subtasks related to direct linking on the Time & 
Expense » Configuration » Master Data screens are no longer editable.  

For example, if Link UDT01/UDT02 is configured as Direct, then in Configuration » Master Data » 
UDT02, the New and Delete buttons were removed from the UDT01 Links subtask, and edits need to be 
applied directly to the appropriate area within Costpoint instead. 

 

Subtask Usability Improvements 
Other changes associated with this enhancement include the conditional display of subtasks on the 
Configuration » Master Data screens based on the Link option selected on the UDT Options tab of 
Configuration » General Controls » General Settings.  

For example, if Link UDT01/UDT02 is configured as Direct, then in Configuration » Master Data » 
UDT02, the subtasks related to wildcards (UDT01 Wild Card Links, for instance), do not display. 
Conversely, if the link is configured as Wildcard, then subtasks related to direct links (UDT01 Links, for 
instance) do not display. Neither type of subtask displays if the link is configured as None. 

Note: The terms shown above in parentheses (Account/Project, for instance) represent the standard 
labels frequently applied to UDTs throughout Costpoint and Time & Expense, but these terms can 
vary by company because the labels are customizable. Therefore, for documentation purposes, the 
UDT numbers are used instead of the standard terms throughout these release notes. 

Note: Direct linking can be confirmed from the Links section of the UDT Options tab in Time & 
Expense » Configuration » General Controls » General Settings. Each of the above listed links 
will be configured as either Direct, Wildcard, or None. The link is direct, if Direct is already selected. 

Note: If your version of Time & Expense is not co-deployed with Costpoint and you want to create an 
export file, you must select Create CSV Export Files for Link Tables on the Export Information tab 
of the People » Labor » Timesheet Interface » Export Data to Deltek Time and Expense screen. 



Time & Expense 

Release Notes for Version 8.0 104 

 

Prior to this usability improvement, all of the subtasks displayed regardless of configuration, even if the 
subtasks were not editable. 

New Mastercard Import and Related Updates 
The Batch Expenses area was enhanced to include a new MasterCard batch type that automates the 
process of importing MasterCard expense transactions. 

The import is based on the Common Data Format 3 (CDF3) file, and all imported account numbers are 
tokenized to protect privacy. The MasterCard transaction codes are automatically mapped to the various 
expense wizards, and once imported, the expenses are available to employees in My Outstanding 
Expenses and Expense Report. 

Although the Mastercard import is new, the process for configuring the batch type and importing the 
transactions is accomplished from existing Batch Expense applications.  

If you are not already familiar with setting up and maintaining batch types and importing expenses, see 
online help for applications under Time & Expense » Expense » Batch Expenses. 

The following sections describe differences specific to the Mastercard import as well as new functionality 
that has been applied to both MasterCard and Visa.   

Updates to Expense Batch Types 
The Expense » Batch Expenses » Expense Batch Types application now provides an option for 
configuring a batch import for Mastercard expense transactions.  

To create a MasterCard batch type, select Mastercard from the Source drop-down list on the Basic 
Information tab.  

Miscellaneous interface updates to this application include: 

 The source type (Mastercard or Visa) is dynamically added as a prefix to some field and subtask 
names. 

 Subtasks that do not apply to the selected source type are now hidden. For example, when 
Mastercard is selected as the source, the Wizard Type Identification subtask is hidden, because it 
applies only to Visa.  

Updates to the Transaction Type Filter Subtask 

The Transaction Type Filter subtask was updated so that all the available transaction codes now load 
automatically if the table is empty when you save the record.  

If you want only a select number of transaction codes, you can add a new record to the table and select 
the code using lookup, or if the record has been saved and all the codes are preloaded, you can delete 
the codes instead. 

 

Note also that on this and other screen subtasks, the Close button was changed to Apply, which 
functions to save any changes you have made on the subtask. The Copy button was also removed from 
any subtask where the function is not applicable. 

Note: This change applies to Visa as well. Note also that due to the change in the underlying 
functionality, the Load All button was removed from the subtask. 
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Updates to Batch Expenses  
When you import Mastercard transactions in Expense » Batch Expenses » Batch Expenses, the file is 
validated to ensure that it only includes tokenized account numbers. If the file includes account numbers 
beginning with the number 5, you receive a processing error.  

The Batch Expenses table was updated with following field changes: 

 Ghost Card: This check box was added to make it easier to designate a Transaction ID as 
belonging to either a ghost card or to an employee. See below for details. 

 Employee and Pay Method: These check boxes were removed because the functionality was 
changed. See below for details.  

 Cardholder Name: This is a new read-only field that displays the cardholder name information 
available from the Mastercard file.  

 

Identify Transactions as Ghost Cards 

A Ghost Card check box was added to the Batch Expense table (in Form View, the check box displays 
on the General tab). For any transaction, select this setting to designate the card number associated with 
the transaction as a ghost card. In future imports, the check box is selected by default. 

 

If the transaction is associated with an employee name and Ghost Card is not selected, the tokenized 
card number and pay method are now automatically added to the Pay Method subtask in Configuration 
» Resources » Resource Information for that employee after you save. If the account number already 
exists on the resource record, the record is not updated.  

Because the update to the resource record is automatic based on the status of Ghost Card, the Pay 
Method and Employee check boxes were removed from the screen.   

 

Related Updates to Other Applications 
After the import is complete, certain field values are copied to other applications as described below. 

Expense Report and My Outstanding Expenses 

The value in the Merchant field of the Batch Expense table will populate the new Merchant Name field in 
the following applications: 

 Expense » Expense Reports » Expense Report: The merchant information from the import 
displays in Outstanding Expenses. The value, however, does not populate in the expense itself.  

 Expense » Expense Reports » My Outstanding Expenses: The merchant information displays 
in the table along with other imported expense details. 

Note: System Administrators: See also “Check for Duplicate Expenses during Import” to learn more 
about a configuration setting added to this screen.  

Note: After you save the import file, the tokenized card number is also added to the list of ghost cards 
maintained in the Ghost Card Identification Values subtask in Expense » Batch Expenses » 
Expense Batch Types.  

Note: The new Ghost Card check box and functionality is also valid for Visa, but for Amex the check 
box is dimmed, and it is hidden for Manual and Generic batch types. 
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It also populates the Merchant Name field in the Mobile version of Expense Report.  

This change applies to import types (Mastercard, Visa, and AMEX, as well as generic).  

Manage Resource Info - Import Mastercard Credit Card Transactions 

If applicable, the Pay Methods subtask in Configuration » Resources » Resource Information is 
updated to include the following information: 

 Mastercard Employee ID 

 Mastercard Account ID 

 Mastercard Effective Date 

 

Approval Role Enhancement 
To improve the user experience associated with managing and approving expense authorizations and 
expense reports, various interface updates were made to the following applications: 

 Expense » Expense Authorizations » Manage/Approve Expense Authorizations 

 Expense » Expense Reports » Manage/Approve Expense Reports 

These updates include:  

 The contents of the Workflow subtask automatically display when the application is opened. 

 Two buttons were renamed: 

Old Button Name New Button Name 

Perform Selected Task  Approve 

Reject Selected Task  Reject 

 For approval tasks, only the Approve and Reject buttons are enabled. 

 For record attachment tasks, only the Attach, Missing, View, and Unrecord Attachment 
buttons are enabled. 

New Application for Managing Attachments  
An Attachment Download application was created that enables users with an assigned functional role (for 
example, Primary Supervisor) to view and download attachments that members of their assigned groups 
have uploaded to expense reports and expense authorizations, eliminating the need to open individual 
expense reports or expense authorizations to view them. 

This application was created for users whose functional role includes access to the expense reports and 
authorizations of other individuals.   

 

Note: This functionality is also described in the “Identify Transactions as Ghost Cards” section above. 

Attention System Administrators: In addition to application rights, users also require access to the 
Alternate File Location, where attachments are currently stored, as well as locations where 
attachments have been previously stored.  
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Following assignment of application rights, click Expense » Expense Reports/Inquiries » Attachment 
Download to display the report. 

 

To run the report, complete the following fields and actions: 

Field Description 

Function This field defaults to your functional role. If more than one role is available to 

you, the roles are listed in alphabetical order. Click  to choose a different 
role.  

This field value is the primary filter for the report and determines the values 
that populate the Group and Employee lists. 

Group This drop-down list displays the resource groups available to the functional 
role you selected. The default value is All.  

When you run the report based on All, the results include all the attachments 
for every member of every group assigned to the functional role you selected. 

If you have access to only a single group, All remains the default value and is 
the only option listed.  

If more than one group is available to you, click  to filter the results by that 
group.  

Employee Use this optional field to return attachment results for a specific employee.  

The list of employees is based on the values selected in the Function and 

Group fields. Click  to select the employee. 

Execute 
Click  on the toolbar to run the report. 

This field is disabled if you have Browse rights only.  
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Field Description 

Download File This button enables after you select an attachment in the table. Click it to 
download the selected file. 

This field is disabled if you have Browse rights only.  

Results Table Values 

After you click , the results of the query display in the report table, which includes the following 
information about each attachment: 

Column Name Description 

File Name This field displays the file name given to the attachment. The attachment 
could be an overall attachment, an item that was manually attached to a 
claimed expense, or an item added from the My Outstanding attachments 
application.    

The filename includes the following information: 

 Expense report or authorization ID, or if it was uploaded from 
Outstanding attachments, “outstandingatt” displays instead 

 Expense ID if the attachment was for a claimed or planned expense 

 Date/Time stamp (YYYYMMDDHHMMSS) 

 File extension 

For example, the filename for a receipt attached to a claimed expense might 
display as follows: ER00000654_1_20190102153551.pdf 

ID This field displays the ID of the expense report or authorization.  

Expense ID This field displays the line number for the individual attachment on the 
expense report or authorization. If the field is blank, then the item was 
uploaded as an overall attachment to the report or authorization.  

Attachment Type This field describes the attachment type, for example, “Overall” or “Expense 
Receipt,” as defined in the Attachments subtask in Expense Report » 
Configuration » General Settings » General Controls.  

Last Modified This is the date the attachment was added or last saved.  

New My Outstanding Expenses Application 
The Expense module includes a new My Outstanding Expenses application that enables you to manage 
your outstanding expenses from a single location. This includes expenses imported from a credit card 
batch feed, ones added in Costpoint Mobile T&E, or those you manually add from the application itself.  

From My Outstanding Expenses, you can: 

 Add new expenses and upload receipts or other attachments to them.  
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If your System Administrator enables Intelligent Character Recognition (ICR) processing, the first 
receipt you upload to a new record is scanned for expense information that can be extracted to 
prepopulate certain fields on the form, such as the amount or date of the expense. See “Fields 
Mapped for ICR Processing” below for more information.   

 Upload multiple attachments to an expense.  

The ability to attach multiple items to an expense record is also new for this release. See the 
“Enhanced File Attachment” release notes for additional information about this enhancement. 

 Edit and/or delete manually added expenses. 

 View expenses imported from a credit card batch feed and if needed, upload attachments.  

 

 Manage uploaded attachments. See “My Outstanding Attachments Subtask” below. 

 Resolve duplicate expenses if they occur. See “Duplicate Expenses” below. 

The expenses you add in My Outstanding Expenses become available in the Expense Report application. 
When you select the expense, all the existing details and attachments are automatically loaded to the 
expense report. See “Claim Manual Expenses” below for more information.  

 

Process Overview 
To open the application, do one of the following: 

 Click Time & Expense » Expense » Expense Reports » My Outstanding Expenses. 

 Select an existing outstanding expense in the Outstanding Expenses section of either the 
Costpoint Home Dashboard or My Desktop in Time & Expense. 

For the purpose of the following examples, assume that the ICR capability is enabled, and that the 
application was opened from the menu, not by opening an existing outstanding expense.  

In the following example, no outstanding expenses yet exist. In this case, click Upload Receipts to add 
expense details the existing, blank record. 

 

Note: Attachments uploaded to expenses imported from a credit card feed are not processed 
by ICR. 

Attention System Administrators: Manage Outstanding Expenses is available to any user who is 
assigned rights to the Expense Report application. However, before first use, you must add a new 
manual batch type. See “System Administrator Configuration Tasks” below.  
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In the File Upload dialog box, click Choose File to navigate to the drive where the file is located. In the 
example image below, an image file for a meal expense was selected. 

 

After processing, certain details are extracted from the image and added to the expense. For example: 

 

The next image below is the same as above but is in Form view to better show all the expense details 
that were extracted after ICR processing.  

 

Note: If expense records already exist in the table, you must click New to upload a receipt to a new 
expense. If you click Upload Receipts on an existing record, the attachment is applied to that record.  
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For a list of fields that are currently mapped for extraction, see “Fields Mapped for ICR Processing” below. 

In addition to correcting and completing fields, you can also upload additional attachments, if needed. 
Click Upload Receipts for each attachment you want to add. Note, however, that only the first 
attachment is scanned by the ICR process. Attachments display in the subtask table. For example, 

 

 

When you have finished, click . The saved file now displays the time and date stamp in the Last 
Modified field of the My Outstanding Attachments subtask. 

 

To add another expense, click New.  

 

After the new record is added to the table, click Upload Receipt to repeat the same process described 
above for the first expense. 

Note: See “My Outstanding Attachments Subtask” below for additional information.  



Time & Expense 

Release Notes for Version 8.0 112 

 

 

Continue the same process as described above for the new expense. 

Fields Mapped for ICR Processing 
When ICR processing is enabled, uploaded receipts are scanned for data that can populate mapped 
fields in My Outstanding Expenses. However, not all fields are presently mapped, and those that are, may 
not always populate or may populate incorrectly.  

Therefore, it is important that you always review the results of each receipt scan. Refer to the table below 
to learn which fields are mapped or unmapped and other related information.  

 

Field Mapping Status Other Notes 

Pay Method Not mapped This field is required.  

Transaction 
Currency 

Not mapped This field defaults to your pay currency. 

Amount Mapped This field is editable if it populates incorrectly. 

Taxes Mapped This field may or may not populate. 

Expense Report 
Type 

Unmapped The record can be saved without completing this field. 

Expense Type Unmapped The record can be saved without completing this field. 

Wizard Type Mapped This field may require manual entry or correction.  

Expense Date Mapped This field defaults to the date on the receipt. If that information 
is not clear after processing, it defaults to the current date 
instead.  

Provider Mapped This field may need to be manually updated.  

Departure Date Mapped If the scan is unsuccessful, the field defaults to the current 
date. 

Return Date Mapped If the scan is unsuccessful, the field defaults to the current 
date. 

Note: The information below does not apply to expenses imported from a credit card batch feed. 
Fields that display on the form vary by expense report type. If ICR is not enabled, none populate.  
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Field Mapping Status Other Notes 

Ticket Number Mapped This field is editable if necessary. 

Itinerary Unmapped. This field requires manual entry.  

Agreement 
Number 

Mapped This field may require editing. 

Start Date Mapped Possibly extracted, but if not, it defaults to the current date after 
you save.  

End Date Mapped Possibly extracted and will default to today's date after you 
save. 

Pickup Location Mapped This field may require editing. 

Return Location Unmapped. This field requires manual entry.  

Check In Date Mapped Possibly extracted and will default to today's date after you 
save. 

Check Out Date Mapped Possibly extracted and will default to today's date after you 
save. 

Location Mapped This field may need editing.  

Room Per Night Unmapped Requires manual entry. It defaults to 0.0000. 

Tax Per Night Unmapped Requires manual entry. It defaults to 0.0000. 

Comments Unmapped This field will be empty in this application, but it does extract in 
Mobile Expense.  

Currency Unmapped This field will default to your pay currency. 

My Outstanding Attachments Subtask 
Use the Outstanding Attachments subtask to view, replace, or delete attachments that you uploaded to 
an expense.  

To view an attachment, select the row that contains the attachment and click View, and depending on the 
browser, the attachment may download for viewing or it may open directly in the viewer.  

The replace option allows you to remove an attachment and replace it with a different one. After you 
select the attachment in the subtask table and click Replace, the Upload File dialog box opens where you 
can browse for the attachment you want add. The replacement process does not overwrite expense 
information.   

 

Note: To add a new attachment to an expense without replacing an existing one, click Upload 
Receipts on the main table. As stated earlier, any attachments added after the first one are not 
scanned by ICR. 
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The table below describes the fields that display in the subtask table. 

Field Description 

File Name When attachments are uploaded, the application modifies the file 
name with the following attributes: 

 Outstandingatt: This prefix identifies the attachment as one that 
was manually attached from this application. If the attachment 
was uploaded from a mobile device, that is indicated by a prefix 
of “Mobile.”  

 The original file name: This is the filename you have assigned to 
the attachment originally. 

 Date/Time stamp: The date and time (including minutes and 
seconds) is presented using this format: YYYYMMDDHHMMSS.  

 File extension: This identifies the type of attachment, such as .jpg 
or .pdf.  

Last Modified This field displays the time/date of the last update, as well as the 
identity of the user who made the modification. 

Duplicate Expenses 
My Outstanding Expenses contains all of your current outstanding expenses, including those you 
manually create as well as ones imported from a credit card feed. Because the potential for duplicates 
exists, the expense date and amount of new expenses are compared to existing expenses.  

Manual Expenses 

When ICR processing is enabled, the check for duplicates occurs when you upload a receipt to a new 
record. If the expense date and amount on the receipt match an existing record, the duplicates display. 
You can choose to either upload the receipt to the new record or attach it to an existing one instead. 

In the image below, for example, the expense date and amount on the new row match the row above it.  

 

The duplicate record opens in a pop-up dialog box. When this happens, you can: 
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 Click  to dismiss the dialog box and finish attaching the receipt to the new record.  

 Click Apply to dismiss the new record and attach the receipt to the existing record.   

 

After you click Apply, the receipt is added to the My Outstanding Attachments subtask of the selected 
record. For example: 

 

You can leave both receipts attached or select one to remove and click Delete. For example: 

 

Alternatively, if you choose to attach the receipt to the new expense instead of the existing one, a new 
record is created, and the duplicates are highlighted in yellow after you save. For example: 

Note: If multiple duplicates display, select the record to which you want to attach the receipt and click 
Apply. If one of the duplicates is an imported expense, that record is selected by default and cannot 
be changed.  
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In this case, options for managing the duplicates include: 

 Take no action and leave the duplicates intact.   

 Delete a duplicate(s) if at least one of the records includes all the required attachments. To do 
this, select the row or rows you want to remove and click Delete. 

 Combine the duplicates to retain all attachments. When records are combined, the attachments 
from each are added to the one you designate as the primary.  

To perform this action, select the records you want to combine, right-click in the first column, and 
click Combine Duplicates on the shortcut menu. For example: 

 

In the dialog box that opens, select one of the expenses as the primary record and click Apply.  

 

The duplicate records are removed, and the primary record retains all the attachments: 
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Imported Expenses 

Credit card expenses imported from a batch feed may also be checked for duplicates. Your System 
Administrator will configure the import to either allow duplicate expenses or to resolve them.  

After transactions are posted, My Outstanding Expenses reflects the following changes: 

 If duplicates are allowed, the duplicate expenses display in yellow highlighting.  

You can manually combine them in favor of the imported expense, or you can leave both and 
choose one of them when you claim the expense in Expense Report. 

 If duplicates are resolved, the duplicate expenses are automatically combined so that only the 
imported expense remains.  

When a manual expense is combined with an imported one, the following changes occur: 

 Files attached to the manual expense are copied to the imported expense. 

 Empty fields on the imported expense populate with data that may exist on the manual expense.  

 The manual expense is removed. 

These changes happen whether the expenses are manually combined by the user in My Outstanding 
Expenses or automatically combined during import. Note also that existing values on an imported 
expense are read-only and are never overwritten.  

Claim Manual Expenses  
Expenses you add in My Outstanding Expenses are available to select on expense reports in the 
Expenses section of Expense » Expense Reports » Expense Report. 

In Wizard mode, for example, click Add Claimed Expense: 

 

Select the expense type. In this example, Meals is selected: 

 

After you click Continue, all outstanding expenses for the selected expense type display, including any 
imported from a credit card batch feed or ones added from Mobile Expense that were not yet claimed. 

In the example below, only one meal expense exists, and it was added in My Outstanding Expenses. 
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The Batch Type field indicates the source of the expense. In the image above, it indicates that it was 
manually added in My Outstanding Expenses. Select the expense and click Continue. 

To save the expense, other required fields must be completed. However, all the available expense details 
from My Outstanding Expenses load automatically.  

For example, the Expense Amount tab displays the amount scanned from the receipt.  

 

Receipts and other attachments automatically load on the Expense Attachments tab.  

 

In the image above, “2 Files” in the Attachment column is the number of attachment that exist. Because 
there is more than one, the View button is dimmed. Click the hyperlink in Attachment to view them. 

 

After you add and save an expense, it is removed from the My Outstanding Expenses application. 

System Administrator Configuration Tasks  
This section describes related configuration tasks for Time & Expense System Administrators.  



Time & Expense 

Release Notes for Version 8.0 119 

 

Configure a Batch Type for Manual Expenses 

To configure My Outstanding Expenses for first use, System Administrators must add a new manual 
batch type in Time & Expense » Expense » Batch Expenses » Expense Batch Types.  

Set the following required fields as follows: 

 Batch Type Code: Enter a value of “Manual” in this field. 

 Description: Add text that describes the batch type, such as “Manual for My Outstanding Exp.” 

 Source: Select Manual Entry. 

 Payment Method: Select Cash. 

Enable Intelligent Character Recognition (ICR) Processing of Receipts 

Receipts uploaded to expense records can be optically scanned to extract basic information about the 
expense.  

This functionality is enabled if you select Allow ICR Expense Processing under Mobile Privacy Option 
on the Miscellaneous tab of Time & Expense » Configuration » General Controls » General Settings.  

This same configuration applies to Expense Capture in Mobile Time & Expense. If for any reason, your 
company chooses not to enable Mobile Expense but does choose to enable ICR processing in My 
Outstanding Expenses, the Allow ICR Expense Processing must still be selected.  

 

Configure the Import Process to Handle Duplicates 

As noted in the “Duplicate Expenses” section above, System Administrators can configure the batch 
expense process to either allow or remove duplicate expenses during import.  

For more information on this new configuration option, see the “Check for Duplicates Expenses during 
Import.” 

Enhanced File Attachment  
Expense Authorization and Expense Report now include the ability to attach multiple files at the overall 
level of the authorization or report or at the expense line level.  

At either level, the Attachments tab includes a new Attachment column that displays the total number of 
files attached as hyperlinked value.  

In this example from Expense Report, two attachments exist. 

 

In Original File Name, the name of each file is listed and separated by a comma.  

Additional files can be added by clicking Attach. For example, 

Note: For more information, see “Mobile Expense-Related Updates.” 
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After you click Upload, the screen refreshes and the number of attachments is updated. In this example, 
the Attachment column now displays “3 files” and the new file name was added to Original File Name.  

 

Because there is more than one attachment, the View button is dimmed. To view or remove the 
attachments, click the hyperlinked value in Attachment. (3 files in the image above) to view or replace 
the attachments. For example: 

 

After a report or authorization is submitted, you have the same option to attach additional files when you 
click the hyperlink in the Status field: 

 

After you click Submit, the Workflow dialog box displays: 

 

In the above example, if one attachment is added, the hyperlinked value in Attachment is updated to 
reflect the new total number of attachments: 
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Note also that the new My Outstanding Expenses application enables users to create expenses and 
attach multiple receipts or files to the expense. These manually added expenses can be selected when 
the employee adds an expense, and all the associated attachments are automatically attached. See “New 
My Outstanding Expenses Application” for more information. 

Expense Entry by Proxy Enhancement 
The process for creating expense reports and expense authorizations on behalf of others (by proxy) can 
now be accomplished in the same manner as personal expense entry using the following applications: 

 Expense » Expense Reports » Expense Report 

 Expense » Expense Authorizations » Expense Authorization 

 

When entering expense forms on behalf of others, proxies previously had to use the Manage/Approve 
applications (Manage/Approve Expense Reports, for example), which are the same applications used to 
manage other supervisory and workflow tasks, such as approving expense reports.  

Now, through the addition of an Employee lookup field to the Details tab (Wizard mode only), both types 
of expense form entry, personal or proxy, are completed from the same application. For example: 

 

 

The Employee lookup displays all employees for whom the proxy has designated rights. As a proxy user, 
for example, you choose the employee on whose behalf you are acting, and then click Select. 

Note: A “proxy” is any user whose functional role includes the right to create expense reports or 
expense authorizations for another employee. For example, the Supervisor role typically includes 
“create” rights, but this same right could exist for any role as defined by your company. 

Note: This field displays conditionally, based on whether or not the logged in user has been 
designated as a “proxy,” that is, he or she has the right to create expense forms on behalf of other 
employees.  
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After the Wizard refreshes, all related information for that individual, such outstanding credit card 
expenses, or other access rights, such as charge types and expense report types, is available to you. 
You can otherwise complete the form as you normally would if you were entering your personal expense 
report or expense authorization.  

Updates to Table View  
In Table view (Wizard mode only), proxy users see their own expense reports or expense authorizations, 
as well as those they have created for other employees. These instances are differentiated by the 
addition of Created By and Role fields. For example, from Expense Authorization: 

 

In the first row of the example image above, “Proxy” in Created By indicates that the authorization was 
created by the proxy on behalf of the employee. In the second row, “Self” indicates that the authorization 
was entered for one’s self.  

When the employee (“Scally, Janice” in the above example image) views expense authorizations in Table 
view, Created By also displays “Proxy” for this same authorization, indicating it was created by proxy on 
her behalf. However, because the employee in this example is not a proxy user, the Role column does 
not display. For example, 

 

Other new fields that display in Table view include: 

 Status Code: This field was added to ensure that records sort according to status, regardless of 
whether they were created by proxy or self. For example, all expense reports or authorizations 
with a Draft status are listed first. To ensure proper sorting, each status value is preceded by a 
numeric sort value (for example, 0Draft, 1Rejected, 2Submitted, and so forth). 

 Advance Paid: This field, which displays in Expense Authorization, indicates whether the 
advance, where applicable, has been paid. The value is either Yes or No.   

 Expense Report Paid: This field displays in Expense Report and indicates whether the expense 
report has been paid. The value is either Yes or No. 
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Updated Query Criteria 
The Query function was updated to include the new fields as part of the standard search, enabling proxy 
users to filter the table results by employee, Created By (either Proxy or Self), or additionally: 

 Advance Paid (Yes or No) in Expense Authorization. 

 Expense Report Paid (Yes or No) in Expense Report. 

For example, in Expense Authorization: 

 

When “Proxy” is selected in Created By, the query results display only the authorizations that the proxy 
has created on behalf of others. For example:  

 

Conversely, if “Self” is selected, the results include only personal expense authorizations. For example: 

 

Other Updates to Expense Authorization and Expense Report 

Interface Updates 
The Void button in both Expense Authorization and Expense Report (Wizard mode only) was updated to 
display a look and feel consistent with the other buttons on the form, such as Back and Exit. The new 
color scheme for this button is blue and white. For example: 
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Updates to Charge Favorites and Default Charges 
A Charge Favorites subtask was added to the Details tab of the Expense Authorization and Expense 
Report applications. The subtask is available in Expert mode only, but can be used to view or delete 
existing charge favorites.  

 

In Default Charges, the “New” button was relabeled as “Add Charge” (for example, ).  

Per Diem Meal Expense Configuration Enhancement 
Expense Types was enhanced to allow you to create separate expense types per meal (for example, 
breakfast, lunch, or dinner) for per diem with ceiling expenses.  

When a meal expense type is configured this way, it eliminates the need to designate the meal type on 
the expense report. This is especially convenient in Mobile Expense, where, depending on configuration, 
users can create an expense report from a captured receipt. 

On the Input Options tab of Expense » Expense Controls » Expense Types, the Multi-Day check box 
and options under Identify Meals were previously selected by default and read-only, if Type was 
selected as Ceiling on the Basic Information tab.  

For meal expense types, these check boxes are now editable when: 

 Per Diem is selected and Type is set to Ceiling on the Basic Information tab. 

 Multi-Day is clear on the Input Options tab.  

To configure a new per diem single meal expense type:  

1. Click Expense » Expense Controls » Expense Types. 

2. In Expense Type Code, enter a code to identify the expense type. 

3. From Wizard Type, select Meals. 

4. On the Basic Information tab, select Per Diem. 

5. From Type, select Ceiling.  

6. On the Input Options – Required Fields tab, clear the Multiday check box.  

Note: All button labels in Expense Wizard are now presented in white font. 
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7. Under Identify Meals, clear whichever two check boxes do not apply to the meal expense type 
you are creating.  

For example, if you are creating a “Breakfast” expense type, clear Lunch and Dinner. Validation 
allows only one selected check box if Multiday is clear. 

8. Clear the Incidentals check box. This step is optional. 

9. Apply other settings if desired. 

10. Click Save.  

When Expense Report users apply this expense type, note the following: 

 When entering meal expenses on a single day/single meal ceiling basis, first and last day rules 
no longer apply (by default, all are set at 100%). The per diem Adjustment Percentage also does 
not apply (the Expense Type field defaults to 100% and cannot be modified). 

 Ceilings apply on a single day/single meal basis. If a meal is over ceiling and the day total is 
under ceiling, the meal will have an over ceiling amount. 

Leave Request Enhancements 
The Work Schedule application was modified to streamline tasks related to submitting leave requests, 
while the Resource Work Schedules screen was also updated so managers can approve or reject leave 
more easily.  

Enhance Employee Leave Request 
The following leave-related changes were implemented in the Timesheets » Work Schedule screen: 

 A new button, New Leave Request , was added to the Work Schedule 
screen. This button replaces the Request Leave button that was previously located on the Edit 
Date Properties subtask (now named Edit Day). This change makes it easier for employees to 
request leave. 

 The following Employee Work Schedule subtask links were converted into buttons: 

 Leave Balances 

 Leave Requests 

 Edit Daily Schedule 

 Edit Day  
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New Leave Subtask 

This subtask opens after you click . This button replaces the Request Leave button 
that was located on the Edit Daily Schedule subtask.  

 

With this subtask, you can use the new calendar lookups  to specify either a single day or a range of 
days for your leave request, and select the type of available leave hours you want to draw upon using the 
Leave Type drop-down list. 

The New Leave subtask includes the following fields: 

 From: Click  to select the start date for your requested leave. 
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 To: Click  to select the end day for your requested leave. If your leave request spans a full 
work day or less, use the same date in both the From and To fields. 

 

You can pick hours on multiple days. 

 

 Leave Type: Use this new drop-down list to select the Leave Type. The drop-down list displays 
all Leave Types available to the employee based on the employee’s Timesheet Class and the 
quantity of available hours at the time of the request.  

 

 

 Notes: Enter any explanations related to your leave request. This field is optional.  

 Daily Hours: Enter the total hours for each day. 

 Total Hours: This non-editable field aggregates the total hours for the current leave request.  

 Apply: Click this button to create the new leave request. Your supervisor will be notified of the 
request via an email notification. 

Leave Requests Subtask 

The Leave Requests subtask table displays all requests for leave from January of the current year and 
into the future (this can include the following year, if leave has been requested for days that fall after 
January 1 of that year). The table list includes both approved leave requests and those pending approval.  

Note: With this new process for requesting leave, you specify your requested leave hours by 
total numbers, rather than designating clock hours. 

Note: This is a required field. 
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Cells containing approved hours display in green .  

Cells with leave hours pending approval display in red . 

 

The following columns were added to the Leave Requests table: 

 Approved Hours: This column displays the number of hours of an employee’s requested leave 
that have been approved by the employee’s manager.  

 Pending Hours: This column displays the number of leave hours requested by the employee that 
are awaiting the manager’s approval.  

 

Enhanced Manager Approve/Reject Leave Requests 
The Time » Timesheets » Resource Work Schedule screen has been enhanced to enable managers 
and supervisors to easily review, approve, and reject their employees’ leave requests. 

Managers receive emails notifying them of leave requests submitted by their employees. Requests for 
leave on separate days are combined in a single notification email. Click an employee’s hyperlinked 
name in the Resource Work Schedule table to view the Pending Leave Requests table for that employee.  

Previously, managers had to open the Work Schedule application in order to click the Leave Requests 
subtask button. 

Note: The list of pending and approved leave requests can be extensive if it is populated with 
numerous single day requests. 
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The Leave Requests table displays both leave that has been approved and leave awaiting approval. 

Approved leave displays in green  while leave pending approval displays in red 

. The first of the two numbers displayed in the cell represents the number of hours that 
have either been requested or approved, while the second number represents the total standard hours for 
the employee’s work day. 

Leave requests that span multiple days display with each day allotted its own row in the Pending Leave 
Requests table. You can approve or reject all days of the requested leave, or individual ones.  

Although the Request Leave button that employees formerly used to submit their leave requests was 
removed from the Employee Work Schedule’s Edit Day (formerly Edit Date Properties) subtask, it remains 
on the Edit Day subtask for the Resource Work Schedule screen. As before, managers can click the 
Request Leave button to begin the process of requesting leave for their employees.  

Application Name Updates 
To promote clarity and readability, names for many applications were shortened, simplified, or otherwise 
changed. Most application names were revised in accordance with the following guidelines: 

 Verbs like Manage, Maintain, and Print were removed from many application names. Though not 
inclusive, the following table provides a number of examples. 

Former Application Name New Application Name 

Manage Work Schedule Work Schedule 

Manage Timesheets Timesheet 

Print Interim Timesheet Reports Interim Timesheets 

Configure Time Settings Time Settings 
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Former Application Name New Application Name 

Configure General Settings General Settings 

 Application names that included the word Report were shortened. For example: 

Former Application Name New Application Name 

Outstanding Aging Report Outstanding Aging 

Print Commitment Report Print Commitments 

Print Interim Timesheet Reports Interim Timesheets 

Configure Time Settings Time Settings 

Configure General Settings General Settings 

 A number of applications names were improved, but not necessarily in ways that conform to the 
guidelines described above. For example: 

Former Application Name New Application Name 

Advance Utility Maintain Advances 

Preferences  Profile 

Dialog Box Enhancement 
To improve the user experience, pop-up windows in Time & Expense no longer display a red border. 

Timesheet Button Updates  
The Timesheets » Timesheet and Timesheets » Manage/Approve Timesheets applications were 
updated to improve the appearance and usability of the following interface buttons: 

 In the Timesheet header area, the New button was renamed New Timesheet .  

 In the Timesheet Lines table area, the New button was renamed to Add Line . 

 The Sign button displays as green with white text: . 

 The Approve button displays as green with white font:   

 The Reject button displays as red with white font: . 

 

Note: Action buttons in other Time & Expense applications will reflect similar changes, where colors 
have been standardized according to the type of action. For example, green is used for actions such 
as submitting, approving, or continuing, while red is used for actions associated with rejecting. Blue is 
used for a variety of actions, such as executing, adding, or voiding. 
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Configuration Updates  
Information in this section is intended for System Administrators.   

Allow Expense Creation from Receipts 
An Allow Expense Creation from Receipts configuration option was added to the Miscellaneous tab of 
Configuration » General Controls » General Settings.  

Costpoint Mobile T&E is integrated with an intelligent character recognition (ICR) technology when you 
use Capture Receipt. With this feature, Costpoint Mobile T&E automatically scans and analyzes the 
captured or selected image, maps the captured data to the Expense Report screens, and populates the 
matched fields. 

This setting is selected by default. Leave the setting selected to enable ICR processing, or clear the 
check box to disable ICR processing. 

This same setting applies to the My Outstanding Expenses application in the Web version of Time & 
Expense, where employees can upload receipts to create expenses. If for any reason, your company 
chooses not to enable Mobile Expense but does choose to enable ICR processing in My Outstanding 
Expenses, this setting must still be selected. 

The Miscellaneous tab includes other new settings related to Mobile Expense. For more information, see 
“Mobile Expense-Related Updates.” 

Check for Duplicate Expenses during Import  
A new Perform Duplicate Expense Check When Posting Transaction option was added to Expense » 
Batch Expenses » Batch Expenses.  

This option, which is selected by default, was added because users now have the ability to create manual 
expenses from either My Outstanding Expenses or Costpoint Mobile Time & Expense, which creates the 
potential for duplicates when credit card expenses are imported.  

Use this new setting to configure how duplicates are handled during import.  

If you leave the setting selected, the expense date and amount of each imported expense is compared to 
existing manual expenses. If a duplicate is found, the import process will: 

 Copy attachments from the manual expense to the imported one. 

 Populate empty fields on the imported expense with data that may exist on the manual one.   

 

 Remove the manual expense. 

If you clear the setting, the process does not check for duplicates, so duplicate expenses are allowed.  

The duplicates are flagged in yellow highlighting in My Outstanding Expenses, where users can either 
manually combine them, based on the same rules outlined above, or instead, they can leave both and 
decide which to claim in Expense Report.  

Update to Mobile Responsive Design Interface  
The Enable New Mobile Responsive Design Interface setting on the Miscellaneous tab of 
Configuration » General Controls » General Settings was updated so that it is now selected by 
default. 

Note: Existing values on an imported expense are read-only and are not overwritten. 
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When a user accesses the Web version of the timesheet application through a smartphone browser (as 
opposed to using the actual Mobile Time application), this setting controls whether the timesheet displays 
using the Mobile Responsive Design (MRD).  

The MRD displays on smartphone browsers using a Portrait (vertical) mode that imitates the standard 
Mobile App User Interface. 

When this check box is selected, the Manage Timesheet application displays in Portrait (vertical) mode in 
smartphone browsers when users select the Smartphone Mode check box on the sign-in screen. MRD 
imitates Mobile Time display, which is optimized for the smaller screens featured on smartphones. 

If you clear the Enable New Mobile Responsive Design Interface check box, the timesheet display 
matches the standard Web version, which is designed for optimum viewing on larger PC monitors and 
laptop screens. 

For additional details on this setting, see the online help for the Miscellaneous tab of Configuration » 
General Controls » General Settings. 

Mobile Expense-Related Updates  
Several updates related to the new native mobile version of Expense Reports have been applied, 
including the following: 

 The Expense module now includes the ability to make multiple receipt attachments per claimed 
expense line and expense report. 

 You now have the ability to view all expense images not yet attached to a report at any point 
within the entry process.  

 In Default Charges, the New button was renamed to Add Charge.  

 Configuration settings that support automatic attachment of captured images to expense lines 
have been added. 

 

 

Adding Expense Reports Using Your Mobile Device 
With the Expense feature, you can add expense reports using your mobile device in the same native 
application that you use to enter timesheets. Two new menus, Capture Receipt and Expense Reports, 
are added to the Costpoint Mobile T&E user interface to support this feature.  

Note: The official name of the application is Costpoint Mobile Time and Expense. This document only 
uses it at first mention. The succeeding instances of the application name display Costpoint Mobile 
T&E. 

Note: The following topics include additional enhancements made to the Costpoint Mobile Time and 
Expense application. 
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The Expense Reports and the Capture Receipt menus are available only if you select the Allow Mobile 
Access option, and then select the Allow Mobile Expense Application option on the Miscellaneous tab 
of the General Settings screen in Time & Expense. 
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The Capture Receipt screen allows you to either capture an image of the receipt using your device's 
camera or select an image of the receipt from the archive or camera gallery, and easily attach the 
captured or selected image of the receipt to an expense report. You can use the expense entry to create 
a new expense report or to attach it to an existing expense report using the Add Expense screen. When 
Intelligent Character Recognition (ICR) is enabled, the details from the captured receipt will be extracted 
and populate the appropriate fields on the Add Expense screen. 

 

The Add Expense screen contains the following fields: 



Time & Expense 

Release Notes for Version 8.0 135 

 

 Type: Use this field to select the expense category. Valid categories include Car Rental, 
Entertainment, Lodging, Meals, Transportation, and Other. This field is populated by ICR (if 
enabled) and can be edited, if necessary. 

 Expense Date: Use this field to enter or select the date when the expense was incurred. This 
field is populated by ICR and can be edited, if necessary. 

 Merchant: Use this field to enter or select the merchant name used for this expense. This field is 
populated by ICR and can be edited, if necessary. 

 Total Amount: Use this field to enter the amount of the expense. This field is populated by ICR 
and can be edited, if necessary. 

 Currency: Use this field to select the currency in which the expense was incurred. This field is 
populated by ICR and can be edited, if necessary. 

 Comments: Use this field to enter a brief description of the expense report. This field is 
populated by ICR if there is additional data, like tip available and can be edited, if necessary.  

 Save Receipt: Tap this field to save the receipt and add it to an expense report at a later time. 
The expense entry is added to the Outstanding Expenses tab.  

 Save to Expense Report: Tap this field to add the expense entry to an expense report 
immediately by creating a new expense report from it or by attaching it to an existing expense 
report. The expense entry is added to the Deltek Time & Expense database, assigned with an ID 
number, and added to the Expense Reports tab. 

The Expense screen contains two tabs:  

 Expense Reports: This tab displays a list of your expense reports. 

 Outstanding Expenses: This tab displays a list of expenses that were imported from a credit 
card feed or manually entered as an expense and are yet to be claimed. Each expense report 
displays general information about the expense. 
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The expense reports listed on the Expense Reports tab are sorted by date (from newest to oldest) for 
each status and are displayed in summary view with the following details: 

 Description: This is the description that was applied to the expense report when it was created. 

 Date: This is the expense report date. This can either be a single date or a date range, depending 
on the expense report type configuration. 

 Total Amount: This is the total amount of claimed expenses on the expense report. 

 Total to Me: This is the total amount that will be reimbursed for the expense report. 

 Expense Report Number: This is the expense report number assigned by Costpoint. 

 Expense Report Status: This is the status of the expense report. Expense reports statuses are 
color-coded. 

Each expense report entry has the following default sections associated with it: 

 Details: This section displays the basic information for the expense report. 
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 Default Charges: This section displays the specific charges to which the claimed expense and 
percentage estimates default. 

 

 

Using Costpoint Mobile T&E, you can manage expense reports by performing several tasks. 

 Add expense reports using the New Expense Report screen. 

 Edit expense reports with draft or submitted status. 

 Attach a receipt as overall attachment of an existing expense report or to its claimed expense 
line. 

Note: Depending on your company's expense type setup, the Expense Report may display additional 
sections. For example, Location displays if Track Locations is enabled for the expense type in 
Costpoint T&E, Outstanding Advances displays if the expense type allows advances, or Overall 
Attachments displays if there are receipts attached to the expense report. 
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 View summarized expense reports along with the ability to drill into expense report details. 

 Sign and submit expense reports for approval and processing. 

 Void expense reports 

 Attach a receipt to an expense report by: 

 Using Capture Receipt 

 Capturing or selecting an image of the receipt and associating it with the Overall Attachments 
section of an expense report or to a claimed expense line of an expense report 

Capture Receipts with Intelligent Character Recognition (ICR) 
Through the Capture Receipt feature, Costpoint Mobile T&E enables you to use your mobile device to 
capture and upload expense information and receipts to the Costpoint Time & Expense database. 
Capture Receipt is available if you select the Allow Mobile Access option, and then select the Allow 
Mobile Expense Application option on the Miscellaneous tab of the General Settings screen in Time & 
Expense  

Capture Receipt allows you to either take an image of the receipt using your device's camera or select an 
image of the receipt from the archive or camera gallery, and easily attach the captured or selected image 
of the receipt to an expense report. You can capture and upload a single image of the receipt or combine 
multiple images of the receipts into a single image using the Stitch functionality. 

You can use Capture Receipt in 2 ways: 

 Capture Receipt with ICR integration enabled 

 Capture Receipt with ICR integration disabled 

To enable Capture Receipt with intelligent character recognition (ICR) integration, you must: 

 Select the Allow ICR Expense Processing option on the Miscellaneous tab of the General 
Settings screen in Time & Expense. 

 

 Set the Use ICR for expenses option on the Settings screen in Costpoint Mobile T&E to On. 
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With ICR integration enabled, Costpoint Mobile T&E automatically scans and analyzes the captured or 
selected image, maps the captured data to the outstanding expense created, and populates the matched 
fields on the Expense screens. Costpoint Mobile T&E sends the image to Deltek’s trusted partner for 
processing and data extraction. Upon the return of the image and extracted data, Costpoint Mobile T&E 
immediately deletes the image and extracted data from the partner’s system, so it is only stored in your 
Costpoint instance. 

 

With ICR integration disabled, you can still use the Capture Receipt feature to capture or select an image 
of a receipt. However, you need to manually enter or select values in the necessary fields when you 
create an outstanding expense. 

Capture Outstanding Expenses Using Your Mobile Device 
Using the Expense feature, you can capture expenses using your mobile device. Outstanding expenses 
are expenses imported from a credit card feed, created through Capture Receipt, or manually entered as 
an expense, and are not yet claimed on an expense report.  

Outstanding expenses are displayed on the Outstanding Expenses tab of the Expense Reports screen. 
You can hide outstanding expenses displayed on the Outstanding Expenses tab if you will not ever claim 
it; for example, a personal expense is imported from a credit card feed. You can modify the details of an 
existing outstanding expense and even attach a new receipt to it. You can also delete a previously 
captured expense if it is used as an outstanding expense in a claimed expense line. When you delete a 

Note: The ICR integration feature works only with Capture Receipt. It does not work with the overall 
attachments and claimed expense attachments even if the feature is enabled.  
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claimed expense line that is used an as outstanding expense, the claimed outstanding expense becomes 
an outstanding expense again and is displayed back to the Outstanding Expenses tab. 

There are two ways to add an outstanding expense to an existing expense report. 

Using Capture Receipt 

Use Capture Receipt to capture or select an image of the receipt. After completing the Add Expense 
screen details, immediately add the receipt to an expense report by tapping Choose Existing Report on 
Expense Report Options screen. Tap an existing expense report to which you want to attach the expense 
entry. On the Expense Details screen, Costpoint Mobile T&E populates the matched fields from the 
expense entry, or you can enter or modify the values in the fields. When you save your changes, the 
expense entry is added to the expense report. 

Using the Outstanding Expense Section of the Expense Details Screen 

You can add an outstanding expense to an existing expense report using the Outstanding Expense field 
of the Expense Details screen if you select an expense type with outstanding expenses. 

Managing Expense Tasks 
The Tasks screen of the Costpoint Mobile T&E user interface now displays Expense related tasks, which 
include: 

 Submit Expense Reports 

 Approve Expense Reports 

 Approve Expense Charges 

 Approve Attachments 

 

The following table describes each Expense task category and to which role the category is available. 
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Task Category Description Resource 
Manager 

Resource 

Submit Expense 
Reports 

This task category is displayed and available for 
resources and resource managers. Tap Submit 
Expense Reports to display the expense 
reports that you created or someone has 
created for you, and you need to submit for 
approval. 

  

Approve Expense 
Reports 

Tap Approve Expense Reports to display the 
Approve Reports screen, where you can 
approve or reject expense reports submitted for 
approval. 

  

Approve Expense 
Charges 

This task category is displayed and available 
only for resource managers. Tap Approve 
Expense Charges to display the Approve 
Charges screen, where you can approve or 
reject expense report charges submitted for 
approval. 

  

Approve Expense 
Attachments 

This task category is displayed and available 
only for resource managers. Tap Approve 
Expense Attachments to display the Approve 
Attachments screen, where you can approve or 
reject expense report attachments submitted for 
approval. 

  

Configure Usage Tracking through Google Analytics 
Google Analytics is a tool that Deltek uses to anonymously gather mobile application usage, such as user 
interface clicks and selections and application crashes. Users opt in for usage tracking when they install 
and launch the Costpoint Mobile Time & Expense application.  

While usage tracking is completely anonymous, Deltek understands the some companies do not want to 
allow their users to opt in to this usage tracking tool. With this, Deltek adds an option that you can 
configure to not allow users to opt in.  

To manage your company's usage tracking through Google Analytics, the Allow users to send 
information to Google Analytics option is added is added to the Miscellaneous tab of the General 
Settings screen in Time & Expense. If cleared, this option takes precedence over the Usage Tracking 
option in the Costpoint Mobile T&E application. 

If the Allow users to send information to Google Analytics option is selected, Costpoint Mobile T&E 
follows its current behavior: 

 The Usage Statistics Tracking screen is available and displays during login. 

 The Usage Tracking field on the Settings screen is displayed and available. 

If the Allow users to send information to Google Analytics option is cleared, Costpoint Mobile T&E 
follows the following behavior: 

 The Usage Tracking field on the Settings screen is not displayed. 
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 Even if you set the Usage Tracking screen toggle to On when you first launched the application, 
Costpoint Mobile T&E will not send information to Google Analytics. 

Help System in HTML Format 
The Costpoint Mobile Time and Expense User Guide, previously in PDF format, is now delivered in HTML 
format. 

Back Arrow Button Added to the PIN Screen  
The back arrow button is added to the PIN screen to allow you to navigate back to the Settings screen 
without closing out the application in case you decide not to change your PIN. 

Support for PHP 7.4.8 
The Costpoint Mobile T&E Server has been upgraded to support PHP 7.4.8. 
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Reports & Analytics 
This section describes Costpoint 8.0 enhancements for the Reports & Analytics domain. 

Role-Based Dashboard Enhancements 
Several upgrades have been made to the dashboards to improve usability. You will find new icons and 
dialog boxes that will help you better navigate the dashboards, easily set up dashpart settings, and get 
additional information about the dashpart in an instant.  

A new dashpart is created to give you the ability to view and manage your workflow approval tasks. Other 
improvements made to the dashboards are listed in detail below. 

 

 

Manage Dashparts and Edit Icon Replacing the Parameters Tab 
You no longer need to toggle between the Parameters and Reports tabs as these have been removed 
from the dashboards. When you access any of the four dashboards, Costpoint displays just the 
graphical/tabular presentation of the dashparts (Report view in previous functionality). 

Previous Look 

 

Current Look 

You now use the new Manage Dashparts dialog box to specify what dashparts you want to view and how 
you want them organized on the dashboard. To open this, click the Manage Dashparts link on the upper-
right part of the screen. 

Note: The changes apply to all dashboards unless otherwise specified. 

Attention: View the What’s New for Dashboards in Costpoint 8.0 video for a demonstration of new 
dashboard features introduced in this release. 
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On the Manage Dashparts dialog box, you can specify which dashparts you want to display on the 
dashboard by using the Add and Remove buttons. You can also arrange them using the Order up and 
down arrows. A search box is provided on the left side so you can search for available dashparts that you 
want to add to the dashboard. 

If you want to modify the settings for a specific dashpart, click the Edit icon  beside it and make your 
changes.  

When you are done with your updates, be sure to click Save for your changes to take effect. Costpoint 
refreshes the dashboard and closes the Manage Dashparts dialog box after you click Save. 

 

New Edit Icon 

The Edit icon  is also available on the individual dashparts. Note, however, that if there are no 
dashpart settings, the Edit icon will still display on the dashpart and on the Manage Dashparts dialog box, 
but will be disabled (grayed out). When you click this icon here or on the Manage Dashparts dialog box, 
the Options dialog box displays and you can modify the settings used for that particular dashpart.  
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The following example contains the fields/options that you can modify for the Projects Over x% Funding 
dashpart when you click the Edit icon. The current field names may differ from the parameter names 
used in the previous Costpoint version, but the functionality remains the same: only the settings you 
specified here will be used on the dashpart. 

 

When you are done with your updates, be sure to click Save for your changes to take effect. Costpoint 
refreshes the dashpart and closes the Options dialog box after you click Save. 

 

Global Settings 
A Global Settings link is now available on the Organization Manager Dashboard and Finance Manager 
Dashboard.  

 

When you click this link, the Select Dashboard Options dialog box displays. Here, you can enter a value 
in the Limit Data to Organizations that Start With field and specify the organization for which you want 
to view data. After you have saved your change on the dialog box, all the dashparts on the dashboard 
display data for the selected organization and all levels below it.  

This functionality was previously included on the Parameters tab.  

Attention: For more details on the default settings for each dashpart and how you can modify them, 
see the dashboard’s online help. 
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Home Dashboard Updates 
The following enhancements are applicable only to the dashparts available on Home Dashboard. 

New My Workflow Approvals Dashpart 

The My Workflow Approvals dashpart is now available on the Home Dashboard. This is a table containing 
a list of the workflow approval tasks assigned to you. Only those steps that you have not yet completed 
are displayed on this dashpart.  

Information that displays on the dashpart includes the approval workflow name assigned to the screen 
where you need to accomplish the approval step, the step name, the time elapsed and remaining, and the 
status of the approval task. You can click a workflow name link to open the specific screen in Costpoint 
where you need to accomplish the outstanding workflow approval task or view additional details related to 
the task. 

Updated Drill-Through on the My Tasks Dashpart 

The drill-through links on the My Tasks dashpart now let you directly launch the screen where a specific 
task should be completed. Previously, the links were directed only to the Manage MyDesktop screen. 
Manage MyDesktop is no longer available in Costpoint 8.0. 

You can now access the following applications from My Tasks if you have pending tasks that you need to 
accomplish on these screens: 

 Expense Authorization 

 Expense Report 

 Manage/Approve Expense Authorizations 

 Manage/Approve Expense Reports 

 Manage/Approve Timesheets 

 Resource Work Schedules 

 Timesheet 

Note, however, that you will be able to open the drill-through application only if you have the appropriate 
rights to that application.  

New Record and Multi-Select Function 

The following dashparts have been enabled with the new record and multi-select function: 

 My Timesheets 

 My Expense Reports 

 My Expense Authorizations 

When you click the New Timesheet, New Report, or New Authorization link on the respective dashpart, 
the system opens the Timesheet, Expense Report, or Expense Authorization screen in Time & Expense 
with a blank record, and you can create a new timesheet, expense report, or expense authorization.  

These dashparts also have the new Launch and Launch Selected links. If you have not selected any 
check box on these dashparts, Launch is displayed. If you selected one or multiple check boxes 
corresponding to the records you want to view, Launch Selected is displayed. When you click Launch 
Selected, the drill-through application opens with data for the records you selected. You can choose all 
records by selecting the Select All check box at the top of the first column. 
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Other Updates 
The following updates apply to all dashboards: 

 A Help icon  is now available on each dashpart. When you click this icon, Costpoint displays a 
pop-up window that will give you more information about the data on the dashpart and on the drill-
through application that you can access from the dashpart. 

 

 With the removal of the Parameters tab, the close button is now visible on the dashboard view.  

 The Next Page  and Previous Page  icons are available on the Global Toolbar when you 
open each dashboard. Depending on your screen resolution, the selected dashparts might not be 
visible on the screen. Use these icons to navigate to the next/previous page of the dashboard. 

If your screen resolution is 1680x1050 and the scale is 100%, you should see 8 dashparts clearly 
without scrolling. This is the recommended display setting. If you use any other display settings, 
you may see more or fewer dashparts on the screen at one time. 

This change applies to the Project Manager Dashboard, Organization Manager Dashboard, and Finance 
Manager Dashboard: 

 The My Links dashpart has been renamed to My Menu. 

These changes apply to the Finance Manager Dashboard: 

 The JE’s Over Approval Limit dashpart has been renamed to Journal Entries Over Approval Limit. 

 The Voucher Over Limit dashpart has been renamed to Vouchers Over Approval Limit. 
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 The following dashparts now use the current period from the Manage Current Reporting Period 
screen:  

 Cash Balances 

 Journal Entries Over Approval Limit 

 Posted Invoices 

 Vouchers Over Approval Limit 

The Manage Current Reporting Period screen is used to configure the reporting period that the 
Costpoint Business Intelligence application will use. This screen is available in Costpoint through 
Reports & Analytics » BI Configuration » Configuration » Manage Current Reporting 
Period. 

Costpoint Business Intelligence 8.0 
Costpoint Enterprise Reporting (CER) has been renamed to Costpoint Business Intelligence or Costpoint 
BI. While it now has a different name, it still utilizes project data with speed, agility, and accuracy. 

Costpoint BI 8.0 leverages Cognos Analytics 11.1.5 features.  

Procurement Content 
A new data model is available for Procurement. This new model supports Organizational and Part 
security for standard and ad hoc reports as well as the new Procurement dashboard. These security 
enhancements suppress org specific data from users based on their Org security settings and limit 
visibility into reports or data that contain unauthorized parts based on part security setup. The following 
reports are included in the Procurement folder on the Costpoint Business Intelligence screen: 

 Buyer Requisition Worksheet 

 PO Commitments Detail 

 Purchase Order 

 Requisitions 

 Requisitions Pending 

 PO Header and Line Detail – Drill Thru from PO Commitments Detail 

 Requisition Detail – Drill Thru from Requisitions Pending 

The Procurement dashboard displays analytics for both purchasing and procurement planning with 
requisitions, helping you make better business decisions with data such as: 

 Total value spent on procurement: Understanding overall procurement spend lets you see 
where you stand for the year and if you are above or below budget and if you need to start 
making adjustments. 

 Number of active vendors: Having diversity and variety in vendor selection is key to a healthy 
supply chain. This KPI adjusts as you interact with other areas on the dashboard to always have 
visibility into your vendor count for multiple different procurement scenarios. 

 Spend by commodity: Understand your spend on different commodities and see which vendors 
you are utilizing the most with the ability to drill thru to see each commodity spend by vendor 

 Purchase Orders (PO) by status: See which suppliers are not fulfilling their orders on time, with 
a count of POs in each status and drill thru chart to narrow down by vendor to see their individual 
statistics.  
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 Requisitions awaiting approval by approver: Know where your approval process is being held 
up with this view into requisitions that are in approval by the current approver. The drill thru detail 
report shows how long the requisition has been awaiting approval in that phase of the process so 
you know where to take action to move those requisitions through the pipeline. 

 Requisition status by requisitioner: Have better visibility into the performance of your 
requisitioners by seeing a count of their requisitions in each status. 

 Approved requisitions awaiting PO conversion: Understand Buyer performance with visibility 
into the number of requisitions that have been approved but are awaiting conversion to a PO. The 
drill thru detail report shows the date the requisition was approved, the number of days since 
approval, the target date that a PO should be created, and the number of days until or past the 
target place date. 

Manufacturing Content 
A new data model is available for Manufacturing. This new model supports Organizational and Part 
security for standard and ad hoc reports as well as the new Manufacturing dashboard. These security 
enhancements suppress org specific data from users based on their Org security settings and limit 
visibility into reports or data that contain unauthorized parts based on part security setup. The following 
reports are included in the Manufacturing folder on the Costpoint Business Intelligence screen: 

 Indented Bill of Materials (BOM) Report 

 MO Build-To Inv Abbrev 

 MO Component Shortage Report 

 MO Pick List Report 

 MO Production Status Report 

 MRP Message Report 

 Summarized Bill of Material (BOM) Report 

The Manufacturing dashboard displays information such as: 

 Manufacturing Order (MO) production status: Understand where your in-process MOs are in 
the production with a count of each status and utilize the drill thru detail report to see a 
breakdown of each status by planner and build part and see the number of days it has been in 
that status, the planned due date, need date, and MO completion %. 

 MO cycle time: See the average number of days it takes a manufacturing order to be completed 
with this summary value that shows an overall average of MO Cycle Time. This KPI adjusts as 
you interact with other areas on the dashboard, including filters by part, planner, and project. 

 On Time and Late: Get insight into planner performance by comparing MOs that are on time vs. 
those that are late for both release and in-shop for each MO. The drill-through reports show you 
MO details grouped by planner to reveal the on time and late percentage values. 

 ECN Status: Be proactive with a view into the number of ECNs in each open status. Utilizing the 
detailed drill-through report allows you to see Manufacturing Orders that may be impacted by an 
ECN for any build part or component parts on the MO. This report guides you to see when the 
change is planned to be implemented and how that could affect your MO status and due date. 

Materials Content 
A new data model is available for Materials, which supports Organizational and Part security for standard 
and ad hoc reports for Sales Orders, Product Definition, and Inventory. These security enhancements 
suppress org specific data from users based on their Org security settings and limit visibility into reports or 
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data that contain unauthorized parts based on part security setup. The following reports will be included in 
the Materials folder on the Costpoint Business Intelligence screen: 

 Audit Log Report 

 Stock Status Report 

 Parts List 

 Goods List 

 Services List 

 Item Vendors 

 Sales Order Status Report 

 Shipped Revenue Report 

Time Content 
A new secure Time model is now available. There are two new reports in Time, namely: 

 Charge Activity 

 Resource Activity 

A new user group for Costpoint Business Intelligence was created for this new Time model, which is the 
CER Time Secure (CER__TE_SECURE). 

Artificial Intelligence (AI)-Assisted Business Intelligence 
Costpoint BI takes advantage of the new Artificial Intelligence features in Cognos Analytics v11.1.5, 
making it easier for all types of users to create reports and dashboards. The AI also automatically 
provides key insights hidden in your data. Some of the key features of AI-assisted BI are: 

 Recommended and Related Visualizations: Based on the data selected, the AI capabilities 
recommend visualization that best suit the data. 

 AI Assistant: This is an embedded assistant that supports text-based input to help you gain 
quick insights into your data and simplify your analytics. By simply typing questions into the 
assistant, you can access key data sources, create visualizations, and drag them onto your 
Exploration or Dashboard canvas. 

 Explorations: Explorations are where you can discover and analyze your data. You can also 
explore an existing visualization from a dashboard or story. Uncover hidden relationships and 
identify patterns that turn your data into insights. Correlated insights are represented by a green 
icon with a number on the x-axis, y-axis, or the title of a chart. 

 Relationship Diagrams: The central visualization in an exploration shows all the fields in 
your data and the strength of the relationship between them. The thickness of the line 
indicates the strength of the relationship. 

 Driver Analysis: Specific visualizations understand which data fields have an impact on 
other fields, in other words, the degree that one data element drives another field. 

 Comparison Cards: Quickly take your exploration charts into an analytical comparison mode 
to quickly compare different time periods, organizations, and others. 

 Insights: Automatically generate statistical insights into the data in chart. 

 Natural Language Generation: The system automatically creates written analysis about the 
data in a visualization, pointing out anomalies in the data that may not be obvious to the user. 
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 Predictive Analytics: Automatically create forecasts based on historical time-phased data like 
hours, costs, or revenues 

Use your own data from the Costpoint data models and uploaded MS Excel files to utilize the new AI 
functionality. The flexibility of this new feature provides you with more options in analyzing data for your 
unique business needs. 

Leveraging these new AI capabilities, Costpoint BI releases our first Smart AI package, which is focused 
on Resource Management. Applying AI to the resource management process in Costpoint Planning helps 
you to: 

 Understand future resource needs including generic staff and vendors. 

 Analyze historical utilization vs. budgets and EACs. 

 Optimize future utilization. 

 Incorporate future plans for New Business projects into decision making. 

Included in the Smart AI package are: 

 A data module and data set for fast performance to create dashboards and explorations 

 A pre-built dashboard that will show the capabilities for the Smart AI subject area 

 Sample questions for the AI assistant that will automatically create visualization with your data 

Sample Dashboards with Data Sets 
Some of the existing dashboards in Costpoint BI have been modified and now leverage data sets. Data 
sets help achieve better performance in generating results in dashboards. These dashboards are located 
in Team content » Samples – Costpoint BI » Dashboards with Data Sets. These dashboards are in 
the areas or modules of: 

 Manufacturing 

 Planning 

 Projects 

 Executive 

Data sets are now available for the following areas or modules: 

 Accounts Receivable 

 AR Project Dimension 

 Employee Change Notices (ECN) 

 General Ledger (GL) 

 Labor History 

 Manufacturing Orders (MO) 

 Planning 

 Project Status Report (PSR) 

These data sets are in Team content » Samples – Costpoint BI » Dashboards with Data Sets » Data 
Sets. 
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Accounts Payable Content 
The Accounts Payable model, which you can use as basis for creating reports and dashboards that show 
accounts payable content, is now in Costpoint BI 8.0. 

Accounts Payable Aging Report 

The new Accounts Payable Aging Report uses data from the new secure Accounts Payable model. 

Unlike the reports in the legacy version, certain improvements are included in this report version: 

 Tabs on the prompt page were removed so you can enable the interactive viewer feature for this 
report. 

 The description of the report is in the Properties section. 

 For easier navigation, the main report page displays first, and tabs are located on the pages of 
the report. 

 There is a revision history that has a log of all changes made in the report. 

New Contracts Reports 
The following new reports have been added to the Contracts module: 

 Contract Brief Report: A contract brief is a summary of key information of a contract. As a 
government contractor, it helps you to fully understand the terms and conditions of the contract. 

 Contract FAR/Supplemental Report: This report displays the FAR and Supplemental clauses 
and provisions related to specific contract or subcontract records. This report is useful when you 
want to see what contract/subcontract records are related to a specific FAR or Supplemental 
record. This report can also be used to identify contracts that have high risk clauses/provisions 
associated with them. 

Opportunity Dashboard 
The new Pipeline Revenue Forecast tab is now available on the Opportunity Dashboard that includes: 

 Opportunity Value Forecast Spread: This displays the estimated start date and estimated dates 
of the opportunities and evenly spreads out the opportunity value over the months. 

 Weighted Revenue Forecast Spread: This displays the estimated start date and estimated 
completion dates of the opportunities and evenly spreads the weighted revenue over the months. 
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Project Planning Models 
Some legacy reports have been improved and relocated to the secured Projects area. User-defined fields 
were also added to the Project Planning model. 

New Security Groups 
New security groups that allow authorized users to access secured packages and to provide more 
granular security with the new Materials, Materials Manufacturing, and Procurement areas in Costpoint BI 
are now available. These new security groups are: 

 CER Materials Manufacturing All Secure (CER__MM_ALL_SECURE): This is a Deltek group 
used to set permissions on all secured Materials Manufacturing content. 

 CER Procure Secure (CER__PROCURE_SECURE): This is a Deltek group used to set 
permissions on secured Procurement content. 

 CER Materials Secure (CER__MATERIAL_SECURE): This is a Deltek group used to set 
permissions on secured Materials content. 

 CER Manufacturing Secure (CER__MFG_SECURE): This is a Deltek group used to set 
permissions on secured Manufacturing content. 

 CER Time Secure (CER__TIME_SECURE): This is a Deltek group used to set permissions on 
secured Time content. 

 CER Expense Secure (CER__EXPENSE_SECURE): This is a Deltek group used to set 
permissions on secured Expense content. It is added in preparation for an enhancement in a future 
Costpoint BI release. 
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Costpoint Authentication Provider 8.0 
The Costpoint Authentication Provider 8.0 or CAP was modified to support the new security groups in 
Costpoint BI 8.0. 

Manage BI Settings 
The Manage CER Settings (BIMCERSETTINGS) application has been renamed as Manage BI Settings. 
The menu path is Reports & Analytics » BI Configuration » Configuration. 

 

Other major changes were also applied to this screen: 

 The Budget Source column has been removed. 

 The Enable Model Security column has been renamed as Enable CP & Planning Model 
Security. You can select either Yes or No to enable or disable model security for the Costpoint 
and Costpoint Planning models. Model security is enabled by default. 

 The Use CP Organization Security By Module option has been added, which you can use to 
either enable or disable organization security in the following new secure models: 

 Accounts Receivable 

 Accounts Payable 

 General Ledger 

 Manufacturing 

 Materials 

 Procurement 

 Projects 

The Enable T&E Model Security is a new column that lets you enable or disable model security for the 
Time model. Expense will soon be available in a future release. 

Framework Model Changes  
Five new framework models were added in this release:  

 Accounts Payable: This model is used by the new Accounts Payable Aging Report.  

 Procurement: This model is used by the reports in the new Procurement folder in Team content.  

 Manufacturing: This model is used by the reports and dashboard in the Manufacturing folder in 
Team content.  

 Materials (Seller): This model is used by the reports in the Materials folder in Team content.  

 Time: This model is used by the reports in the Time folder in Team content.  

The following framework models have been updated to account for module level security: 

 Projects 
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 Accounts Receivable 

 General Ledger 
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Admin 
This section describes Costpoint 8.0 enhancements for the Admin domain. 

Costpoint Login Banner 
To meet the requirements of some organizations, administrators can configure a message that displays 
during login. Users will be prompted to acknowledge the message to log in to Costpoint,  

Navigation Banners 
To help eliminate the need to remember complex processes and to make it easier to navigate a workflow, 
Costpoint provides the option to use a navigation fly-out banner as a guide. The navigation banner, which 
displays at the top of an application screen, is made of application links displayed in the order of a 
process flow. It enables you to open applications within a process without using Browse Applications or 
returning to My Menu. 

For example, you can make a banner to reflect the steps in the AP Voucher process with the following 
applications: 

 Manage Accounts Payable Vouchers 

 Print Accounts Payable Voucher Status Report 

 Approve Vouchers 

 Post Vouchers 

 Print Open Accounts Payable Report 

Configure User Preferences for Navigation Banner 
In Configure User Preferences (UPMUSRPR), you can select the new Create Nav Banner? check box to 
enable a navigation banner to display for a group heading in My Menu. When you select the group 
header in My Menu, the application grouping displays in a banner across the top of your Costpoint 
screen.    

You must have security access to applications to see the application names and links in My Menu and the 
navigation banner. 

User Security for Navigation Banners  
Limit the ability for users to create navigation banners using the new Allow to Enter Navigation column 
in the Manage Users (SYMUSR) application. In the My Menu window in Configure User Preferences, 
select the Create Nav Banner? check box to give a user the access to select group headers for the 
navigation banners.  

Create Company-wide Navigation Banners  
Companies can set up navigation banners and assign them to user profiles in the Manage User Interface 
Profiles (SYMPROF) application. To do so, select the check box in the new Create Nav Banner? column 
for a My Menu group in the My Menu subtask to create a navigation banner for the group. Users with the 
UI profile will have the security access needed to use the banner. 

If a user has the access rights to create navigation banners, their banners will overwrite what was 
assigned in their UI profile. 
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Preprocessor to Populate Active Directory or Certificate ID Field 
A Costpoint Admin now has the ability to run a preprocessor to update the Active Directory or 
Certificate ID field on the Manage Users (SYMUSR) screen. They can create an import file that includes 
the users’ Costpoint ID and Active Directory ID. This enhancement reduces the time needed to update 
the Active Directory ID for a large number of employees. The Deltek Costpoint 8.0 Import Active Directory 
ID Preprocessor documentation is available on DSM. 

Support for Dynamic Columns 
The Costpoint Web service is updated to support the population of dynamic columns in New Business 
budget applications in the Planning module. 

Display New UI Interface Only 
The Classic View and New UI toggle has been removed from the Costpoint login page. All of Costpoint 
will display in the new user interface. 

Content Management Integration (CMI) Updates 
Enhancements include Costpoint CMI compatibility with SharePoint 2019. 

New Default Email for Costpoint Cloud Email Notifications 
To comply with company security policies, all email notifications initiated from Costpoint now have a 
default sender email address of Noreply@Deltek.com. This email address is not customizable.   

Business Intelligence and Reporting Tools (BIRT) Upgrade 
Costpoint is updated to include the latest version of BIRT. 

Digital Signature Admin Updates 
The Costpoint Admin domain is updated to support the new Supplier Portal-Digital Signature for Invoices 
feature. Updates include a new Digital Documents application group (Admin » System Administration » 
Digital Documents) and new system settings.  

Manage Digital Document Types (SYMDDOCTYP) 
The Manage Digital Document Types application in the Digital Documents application group enables you 
to:  

 Define document types and their data fields that will support approvals via digital signatures. 

 Select Active to enable or disable the use of digital signatures for a document types in all 
applications where the document type is available. 

 Select the Enforce Signature Attestation via User Certificate check box to only allow users 
who were issued a digital certificate from a trusted company the ability to digitally sign documents  

 Configure a message that displays when a user digitally signs a document type. 

 Select a check box to acknowledge and agree to the use of digital signatures for legal purposes. 
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Manage Digital Document Links (SYMDDOCLNK) 
After defining a document type, use the Manage Digital Document Links application in the Digital 
Documents application group to: 

 Specify which document types will link to a specific Costpoint application and result set.  

 Map the Costpoint application and result set to a specific digital document object to define a 
linking rule in the new Digital Document Object Links subtask. 

 Define the fields that will update when a record is digitally signed or unsigned in an application in 
the new Digital Document Field Updates subtask. 

Configure System Settings (SYMSETNG) 
The following updates are applied to Configure System Settings:  

 The Security Settings tab has been updated with a FIDO Settings section that enables 
administrators to restrict the use of certain FIDO devices for login and digital signing. Set device 
requirements with the new Enforce User Verification and Enforce Device Attestation check 
boxes. 

 The Security Settings tab also includes the new Trusted Root Certificates subtask that enables 
administrators to add or upload company root certificates that are used to establish a trust or 
digital link between the company and the user who will digitally sign documents on behalf of the 
company.  

FIDO Biometric Enforcement 
Administrators can now require the use of FIDO devices with a biometric component (fingerprints, face 
recognition, etc.) for authentication and digital signing purposes. Costpoint applications that are updated 
to further support this feature include Manage Users and Configure User Preferences. 

Manage Users (SYMUSR) 
On the Manage Users screen, more user-level control is available for administrators in support of the 
feature: 

 Administrators can select the new Can Add New FIDO Device check box for a user, so that they 
can self-register or activate their own FIDO device(s). 

 A new FIDO/Biometric Devices subtask lets administrators view, delete, and change the 
description or purpose of FIDO devices currently registered for a user (but not add them). A user 
has the capability to add new a FIDO device in this subtask in User Preferences.  

In addition, the following actions in the Action menu on the Global Toolbar has changed: 

 Generate new FIDO Device self-registration link is renamed to Generate FIDO Device self-
registration link. 

 Remove FIDO Devices and self-registration links is renamed to Remove FIDO Devices self-
registration links. 

Configure User Preferences (UPMUSRPR) 
Previously, the FIDO/Biometric Devices subtask only displayed if a user utilized FIDO authentication. For 
8.0, this subtask is always visible in Configure User Preferences. Also, users can now use this subtask to 
send a certificate signing request for a digital certificate to their company and upload the certificate to 
Costpoint.  
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To enable users to add their own FIDO devices, the new Can Add New FIDO Device check box must be 
selected for the user in Manage Users. 

FIDO Logo on Costpoint Login Screen 
A FIDO logo displays on the Costpoint Login screen to indicate that FIDO is a supported authentication 
option for Costpoint desktop and mobile applications.  
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Platform Changes 
This section describes platform changes for Costpoint 8.0. 

Web Browser Support 
The latest versions of Google Chrome, Microsoft Edge, Apple Safari, and Firefox are compatible with 
Costpoint 8.0. Microsoft Internet Explorer 11 is not officially supported as Microsoft is no longer 
enhancing IE as it approaches end-of-life in place of Edge. 

Message Board Retired 
The Message Board feature that allowed you to link Microsoft Exchange email threads with specific 
Costpoint documents is no longer supported in Costpoint 8.0. As an alternative, you can use the 
Costpoint Workflow Engine capability to send email notifications for your approval workflows. You can 
find more information on the Workflow Engine in the online help.   
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Known Issues 
This section includes summaries of the issues that exist in this Costpoint release. 

Reference Links in the Costpoint Documentation 
If you click a hyperlink to a Deltek documentation or learning aid, you may be directed to a Deltek 
Costpoint 7.1.x documentation instead of version 8.0. Deltek is actively working to resolve this issue. 

Costpoint Business Intelligence 

Tabs on BI Reports 
You may encounter an error when you run reports that have tabs. This may happen when you generate 
the report after the initial run. As a workaround, close the report and run in MS Excel. 

This Cognos Analytics issue has been reported to IBM.  

Tenant Setting Properties in BI 
You could not set the Tenant Settings to None on the report or dashboard properties page. This is a 
Cognos Analytics issue and a case has been submitted to IBM. As a workaround, you can click the Clear 
button to achieve the same result. 

Unauthenticated User in Costpoint 
When you log on to Costpoint and open the Business Intelligence application, you may get an error 
message that says that your user account is not authenticated in Costpoint. This happens when the 
Costpoint Authentication Provider (CAP) is still processing your authentication. 

To display the Business Intelligence application: 

1. Click Close (x) on the upper right-hand side of the Business Intelligence application. 

2. Reopen the Business Intelligence application. Click Reports & Analytics » Business 
Intelligence » Business Intelligence » Business Intelligence. 

Costpoint Timeout Limit 
When you log on to Costpoint BI through Costpoint, you may experience a Costpoint session timeout 
even if you are actively using Costpoint BI. When you are about to reach the timeout limit, a message 
displays that gives you the option to continue your session. If the system does not receive any response, 
you may potentially lose work and will have to log in back to the system. 

As a workaround, increase the session timeout limit in Costpoint. 

Deltek is actively working to resolve this issue. 

Custom Group Permissions 
If you have custom user group permissions, they might not have been applied to objects via the Cognos 
user group that is mapped to the Costpoint Authentication Provider (CAP) group. 

As a workaround, use the CAP group directly when applying user group permissions. 
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Drill-Throughs on a Dashboard Object with Two Measures 
An error occurs when you link a drill-through report to an object on a dashboard that has two measures. 
This issue has been reported to IBM. For more details, please see the IBM support issue. 

Item/Part Filters Do Not Display All Parts Set to Companies 
If the Separate Items by Company check box on the Configure Product Definition Settings (PDMITMRU) 
screen is clear, not all parts may display regardless of Company in some reports. 

As a workaround, you need to disable the company filter in their corresponding query. The affected 
reports for this issue are listed in the following table along with the query. 

Area Report Query 

Manufacturing Indented Bill of Materials (BOM) 
Report 

qPrompt_AssemblyID 

Manufacturing MRP Message Report qAssembly 

Manufacturing Summarized Bill of Material 
(BOM) Report 

qPrompt_AssemblyID2 

Materials Stock Status Report qPrimaryGrpFilter; 
qSecondaryGrpFilter 

Materials Parts List Report qPartRev 

Materials Goods List Report qPartRev 

Materials Services List Report qPartRev 

Materials Item Vendors - Drill Thru Report qPartRev 

Manufacturing MO Component Shortage qPartRev 

To disable a company filter: 

1. In Costpoint BI, go to the report, click the adjacent ellipsis (…), and select Edit Report (for 
example, Indented Bill of Materials). 

2. Go to the breadcrumb trail at the top of the report and click Report to display the Queries. Select 
the query to modify (for example, qPrompt_AssembleID). 
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3. Select the Company ID in Detail Filters and select Disabled in the Usage field under 
Properties on the pane on the right. If the Properties pane does not display, click the Properties 
icon. Click Save. 

 

 

4. Optional but recommended: Add a line to the Revision History page to document this update. On 
the breadrumb at the top, click Report and select Revision History. 
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5. Optional: Add a row on the Revision History table and enter details of the change. 
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Appendix: For Additional Information 

Deltek Support Center 
The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support 
Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 

 Search for product documentation, such as release notes, install guides, technical information, 
online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 
Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Initiate a Chat to submit a question to a Customer Care analyst online 

 

Access Deltek Support Center 

To access the Deltek Support Center:  

1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

 

 

 

Attention: For more information regarding Deltek Support Center, refer to the online help available 
from the Web site. 

Note: If you forget your username or password, you can click the Need Help? button on the login 
screen for help. 



 

 

About Deltek 
Better software means better projects. Deltek delivers software and information solutions that enable 
superior levels of project intelligence, management and collaboration. Our industry-focused expertise 
makes your projects successful and helps you achieve performance that maximizes productivity and 
revenue. www.deltek.com 


